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Chapter 1: Getting Started

This section provides information for getting started with the Automated Patch Clamp
System. It is intended for new users. Before using the instrument for the first time, make
sure you read the Safety Guide on page 193.

Daily Operation Overview on page 7

Software Overview on page 13

Instrument Overview on page 23

Starting Up and Shutting Down on page 11

Resetting the Instrument after an Emergency Stop on page 12

Daily Operation Overview
This daily operation overview provides a summary of the basic steps required to use the
IonWorks Barracuda® instrument for a set of experiments. For specific instructions on
performing each of these steps, see the relevant topic and follow instructions carefully.
Daily operation tasks include:

Preparing the Instrument for an Experiment Run on page 101

Loading Compound Plates on page 110 and Preparing Cell Suspension on page 111

Selecting Protocols on page 118

Running an Experiment on page 117

Analyzing Data on page 133

Exporting Data on page 143

Completing Instrument Cleanup on page 149

This section briefly describes each task.

Prepare the Instrument

Prepare the instrument by filling source bottles and emptying the waste carboys:

1. Turn the system on and start the IonWorks Barracuda® System Software. For
instructions, see Starting Up the IonWorks Barracuda System on page 11.

2. Prepare the system fluids.

1
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Empty waste carboys in the system cabinet below the process deck.

Fill source bottles.
Each experiment run uses approximately 30 mL of external buffer, 50 mL of internal
buffer, and 20 mL of cell perforation agent. Adjust the final volume based on the total
number of intended experiment runs. Remember to add the dead-volume for each
bottle: 15 mL for 250 mL bottles, 30 mL for 500 mL bottles, and 60 mL for 1000 mL
bottles. Fill the alcohol (EtOH) bottle with a minimum volume of 100 mL for the Flush and
Rinse.

Fill wash station Source A and Source B carboys.

3. Using an undamaged PatchPlate and a CellPettor pipette, run Start of Day Flush and
Rinse to initializes the system, eliminate alcohol (EtOH) from the system, and primewith
saline solutions. For instructions, see Performing the Start of Day Flush and Rinse on
page 105.

4. Load the required labware onto the process deck:

Load a clean buffer boat at the external buffer station and fill it with 25 mL to 125 mL of
external buffer.

Load a new PatchPlate at the PatchPlate station.

Load a clean cell boat at the cell boat station. If you are using the CellPettor, make sure
you are using a Molecular Devices standard cell boat.

If applicable, load the tip rack station with a tray of disposable pipettor tips.

For detailed instructions, see Preparing the Instrument for an Experiment Run on page 101.

Prepare Compounds and Cells

To prepare compounds and cells:

1. Prepare a compound plate and load it at the applicable compound station.

2. Prepare the cell suspension, resuspend the cells in a 15 mL conical tube, and load the
tube into the cell tube holder. If you are not using the CellPettor, manually pipette the
cell suspension to the cell boat.

For detailed instructions, see Loading Compound Plates on page 110 and Preparing Cell
Suspension on page 111.
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Select Protocols

There are three types of protocols for each experiment, and a saved protocol option needs
to be selected for each type in order to run an experiment.

Setup Protocol: Performs cell preparation steps including plate setup, vacuum checks,
electrical checks, plenum filling, hole test, seal test, and perforation of the cell
membrane. The purpose of this protocol is to prepare a new PatchPlate with cells before
the Channel Protocol.

Channel Protocol: Performs the compound addition, voltage application, and data
acquisition steps in the experiment. The purpose of this protocol is to measure ionic
currents from the cells in the PatchPlate.

Cleanup Protocol: Performs wash and drain operations after an experiment completes.
The purpose of this protocol is to ensure that all instrument components are clean and
ready for the next experiment.

Run the Experiment

You can run experiments in the following modes:

Assay Development Mode: During Assay Development Mode, the selected Channel
Protocol runs and pauses. At the pause, you can adjust parameters to modify the
Channel Protocol. The assay continues to pause after each iteration of the Channel
Protocol until you have optimized for your desired result. You can then save the
optimized Channel Protocol as a new protocol, which can be run later in Multiple
Protocol mode or Single Protocol mode. SeeModifying a Channel Protocol in Assay
Development Mode on page 47. If you are running in Assay Development Mode, follow
the prompts at the pause to run through iterations of the Channel Protocol, or complete
the experiment by proceeding to the Cleanup Protocol.

Multiple Protocol Mode: In Multiple Protocol mode, you can select multiple Channel
Protocols to run without interruption, except for specified pauses in operations to add
or change compound plates or to add cells. Experiments are conducted using one Setup
Protocol, any number of Channel Protocols, and one Cleanup Protocol.

Single Protocol Mode: In Single ProtocolMode, the selected protocols run without
interruption. One Setup Protocol, one Channel Protocol, and one Cleanup Protocol run
through to completion, except for specified pauses in operations to add or change
compound plates or to add cells.

For detailed instructions, see Running an Experiment on page 117.

Analyze the Data

After the experiment runs, the acquired data can be analyzed.
To analyze experiment data:

1. Select the Data Analysis workspace.

2. Select the scan to review from the list of experiment steps.
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Zoom the well view to inspect results more closely.

Apply metrics to reduce data for metric export.

Apply filters to remove the less useful data from the results.

Apply summary criteria to refine hit data.

For detailed instructions, see Analyzing Data on page 133.

Export Data

To export data:

1. Open the Export Metrics dialog.

2. Select the scans and User Metrics to export.

3. Specify theMetric File Name.

4. Select the File Format.

5. Click Export.

For detailed instructions, see Analyzing Data on page 133.

Clean up the Instrument

At the end of the day, clean up the instrument.
Themost important step in cleaning up for the day is to run the End of Day Flush and
Rinsebecause it pumps out saline solutions and sterilizes the equipment and source bottles
with a 50% Ethyl Alcohol (EtOH) rinse and backfill.
To clean up the instrument:

1. After the experiment is completed, discard unused solutions and rinse the cell boat, and
buffer boat with a 50% Ethyl Alcohol (EtOH) solution followed by DI water.

Note: Leave the last PatchPlate in place to use for the next Start of Day Flush and
Rinse run.

2. Unload the pipettor tips. You can do this manually using instrument utilities, or you can
include this step in the Cleanup Protocol using theDiscard Tips option. Skip this step if
you are planning to re-use the tips.

Note: Tips can be unloaded from the pipettor head and reloaded approximately
nine times before you must replace the tip rack with new tips.

3. Empty all of the fluid bottles under the process deck, except the Ethyl Alcohol bottle. See
The Fluid Handling Components on page 40.

4. Run Utilities > End of Day Flush and Rinse. See Performing the End of Day Flush and
Rinse on page 149.

5. Unload the CellPettor pipette.
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6. Empty the waste carboys. The waste carboys must be emptied daily, either at the end of
the day or before the next day's operations. See Emptying Waste Carboys on page 102.

7. Check the overflow reservoir (sink) in the lower section of the instrument cabinet to the
right of the source carboys. The overflow reservoir is a catch for any spills that might
occur at the PatchPlate station or on the process deck. The capacity of the reservoir is
limited, so if any fluid is present, sponge the liquid out to prevent overflow of the
reservoir. If liquid is present, but you do not recall any spills, contact Molecular Devices
Technical Support.

For more details, see Completing Instrument Cleanup on page 149.

Starting Up and Shutting Down
The IonWorks Barracuda® instrument starts up in combination with the IonWorks
Barracuda® System Software. The instrument can be shut down independently so that you
can continue to use the software offline to access data or edit protocol specifications.
Multiple instances of the Analysis only software can run simultaneously, because it does not
control the instrument, while one instance of the Barracuda data acquisition software runs
controlling the instrument.For more information, seeWorking Offline in Analysis Only Mode
on page 21.
The instrument might require initializing. During initialization, the software confirms that
instrument components are properly calibrated and positioned, used fluids are pumped out,
and new fluids are available for the next experiment.

Starting Up the IonWorks Barracuda System

The IonWorks Barracuda® System Software runs in two modes:

Barracuda: Software controls the instrument for data acquisition, as described in this
topic.

Analysis only: Software does not control the instrument. For more information, see
Working Offline in Analysis Only Mode on page 21.

Note: One instance of the online data acquisition software can run simultaneously
with multiple instances of the Analysis only software running offline.

To start the IonWorks Barracuda System:

1. On the right-side power supply panel, turn on power. This primary power-switch turns
on the instrument, the computer, and themonitor.

2. Log into the computer operating system.

3. Start the IonWorks Barracuda® System Software by double-clicking the IonWorks
Barracuda icon.
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Before running experiments:

1. Run Calibrate CellPettor from theUtilities dialog using a dry CellPettor Pipette. See
Using Manual Instrument Controls on page 151.

2. Run Start of Day Flush and Rinse to pump out residual alcohol from the tubes and
reservoirs, and prime the system with assay solutions. For instructions, see Performing
the Start of Day Flush and Rinse on page 105.

Shutting Down the IonWorks Barracuda System

Before shutting down the instrument, run the End of Day Flush and Rinse procedure so that
the instrument is in a sterilized state. For instructions, see Performing the End of Day Flush
and Rinse on page 149.
To shut down the IonWorks Barracuda System after normal operations:

1. Click Instrument > Disconnect from Instrument.

2. Exit the IonWorks Barracuda® System Software by clicking File > Exit.

3. Turn off the computer by clicking Start > Shut Down.

4. On the right-side power supply panel, turn off power. This primary power-switch turns
off the instrument, the computer, and themonitor.

Resetting the Instrument after an Emergency Stop

A red emergency-stop button is built into the front of the instrument cabinet. If an
emergency occurs while the instrument is running, press the emergency-stop button to
immediately cease all instrument functions.

To reset the instrument after an emergency stop:

1. Pull the red emergency-stop knob and twist it clockwise until it stops.

2. Click , and then click Initialize. During initialization, the previous operation cancels
and the instrument resets to the Ready state.

3. Click Close.

If errors occur preventing the instrument from initializing, shut down and restart the
instrument. See Shutting Down the IonWorks Barracuda System on page 12, and then
Starting Up the IonWorks Barracuda System on page 11.
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Chapter 2: Software Overview

IonWorks Barracuda® System Software controls the functions of the instrument, displays
acquired data, and provides data analysis and export functions after an assay completes.
The software comes pre-installed on the system computer.
To install the software on additional computers in Analysis only mode, see Installing
IonWorks Barracuda™ Software on page 22.
Two desktop icons are available to start the software:

Icon Function

Starts the software controlling the instrument.

Starts the software in Analysis only mode (offline, not controlling the instrument).
See Working Offline in Analysis Only Mode on page 21 for more information.

IonWorks Barracuda® System Software consists of threemain workspaces:

Data Acquisition and ReviewWorkspace on page 15

Data Analysis Workspace on page 16

Protocol Editors on page 17

2
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OptionalMonitor Software:
IonWorks Barracuda Monitor Software is available for free to remotely view completed
experiment data acquired on the IonWorks Barracuda System through an Internet
connection. You can use it with a Web browser or an iPad. IonWorks Barracuda Monitor
Software enables you to:

Select data folders

Select completed experiments

See experiment status

Read experiment notes

View PatchPlate scans and summaries

Read protocol names

Review quality control data

To get the IonWorks Barracuda Monitor Software:

For iPad monitoring, download from the Apple App Store.

For web-browser monitoring, contact Molecular Devices Technical Support for the
installer.

The Shortcut Bar
The shortcut bar is the name for the group of large buttons on the left side of the screen. The
following shortcuts are available from any workspace:

Shortcut Button Description

Access the Data Acquisition and Review workspace.

Access the Data Analysis workspace.

View the Associated Protocols summaries.
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Shortcut Button Description

Open the Metrics Export dialog.

Open the Instrument Utilities dialog.

View the Application Help.

Data Acquisition and Review Workspace
When you start the IonWorks Barracuda® System Software, the Data Acquisition and Review
workspace appears. The PatchPlate wells show data after an experiment begins, or a
completed experiment is selected.
In the Data Acquisition and Reviewworkspace you can:

Define experiment names

Define protocols

Run experiments in various modes

Review acquired data at an individual plate well level
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Figure 2-1: Data Acquisition and Review Workspace

Position Component

1 Shortcut Bar: Open workspaces, view protocols associated with the data you are
viewing, export data, or open online Help.

2 Experiment: Set the format for new experiment names, load a completed experiment,
or rename a completed experiment.

3 Protocol: Select protocols or open protocol editors.

4 Experiment Mode: Select assay development mode, multiple protocol mode, or single
protocol mode, and then start or stop an experiment run.

5 Plate View: Select trace view or extracted values view, select a scan to view, turn leak-
correction on or off, or view experiment notes.

6 Fixed Well View: Select wells to zoom, view voltage waveform, or rescale trace graphs.

7 Progress Bar and Instrument Status: View the status of the selected experiment or view
the status of the instrument.

Data Analysis Workspace
After data is acquired, you can refine your results in the Data Analysis workspace. To open
the Data Analysis workspace, click Data Analysis from the shortcut bar on the left.
In the Data Analysis workspace you can:

Define an unlimited number of single or combined metrics.

Define filters to block out less useful data.

Define summaries with threshold criteria to further refine hit data.
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The Data Analysis workspace provides views that summarize responses and statistics based
on the experiment type. In this workspace, you can perform basic analysis of acquired data
using metrics, filters, and summaries.

Figure 2-2: Data Analysis Workspace

Position Component

1 Shortcut Bar: Open workspaces, view protocols associated with the data you are viewing,
export data, open Help.

2 Experiment: Select a completed experiment, set an experiment name.

3 Plate Details: View the results in a color-coded plate display based on filters and
summaries.

4 Color-key and Statistics: View the color key and statistics for the plate display; statistics
are based on defined summaries.

5 Fixed Well View: Select a well to zoom, view voltage waveform, rescale trace graphs.

6 Filters and Summaries: Edit native filters, create user-defined filters and summaries to
refine hit results, access the Metric Editor, save current settings, and turn leak correction
on or off.

7 Well Statistics: View metrics for individual wells.

Protocol Editors
Every assay consists of a Setup Protocol, a Channel Protocol, and a Cleanup Protocol. Access
the Protocol Editors by first selecting a protocol from the list of protocols in the Data
Acquisition and Reviewworkspace, and then clicking Edit.
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When the editor appears, step through the tabs to modify each of the parameters for the
protocol. Protocols can be saved with a new name and description, or saved as Read-Only.
Channel Protocols include saved metrics settings that can bemodified or imported for use
with other Channel Protocols.
Using the protocol editors, you can:

Create or Edit a Setup Protocol

Create or Edit a Channel Protocol

Create or Edit a Cleanup Protocol

Use the Protocol Editors to make changes to the parameters of any protocol. If the protocol
has been marked read-only, give themodified protocol a new name and save it. Mark the
new protocol as read-only if you plan to use it often or if you plan to run the experiment
without interruption.

To open the Protocol Editors:

1. Select the name of an existing Setup, Channel, or Cleanup Protocol to start from by
selecting the name of the protocol in the Protocol field.

2. Click the Edit button next to the protocol you want to edit. The Protocol Editor appears.

Setting Preferences
The Preferences dialog allows you to customize some general settings and some instrument
settings. The general options involve the appearance of the software exit message, the plate
diagnostic scans, and screenshots captured for use by the optional IonWorks Barracuda
Monitor Software. The instrument options involve customizing parameters for the plenum
vacuum, compound addition, and mixing.
To set preferences:

1. In the softwaremenu, click Edit > Preferences.
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The Preferences dialog appears and displays theGeneral Options pane by default.

2. Clear or select a check box to hide, show, or disable available options. General Options
include:

Option Description

Show warning
message on
application exit

The message that appears by default before the software exits is hidden or
shown.

Auto Refresh on
Sweep Selection

The same sweep in the Plate view and the Fixed Well View displays
automatically.

Enable IonWorks
Barracuda
Monitor
screenshots

The scan data screenshots collected with the experiement data are
captured or skipped. Impacts what can and cannot be reviewed in the Web-
based, and iPad-based IonWorks BarracudaMonitor Software.

Display Plate
Diagnostic Scan
Types

The diagnostic scan types that appear in the plate view scans list is hidden or
shown. Diagnostic scan types include: Electrode Offset, Crosstalk, and
Amplifier Offset.

Protocol Editors The Enable Charge Calculator check box enables the CoulombMeter and
Estimated Seal Resistance field in the Edit Setup Protocol dialog and the
Edit Channel Protocol dialog.

Note: Showing and hiding options does not impact the acquisition of the data.

3. To view Instrument Options, click Instrument in the left pane, or from the software
menu, click Edit > Preferences > Instrument.
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4. Change the value of any of the available options. Instrument Options include:

Option Setting Value Range

Plenum Vacuum Vacuum before add cells (mm hg) Minimum: -40
Maximum: -8

Vacuum after add cells (mm hg) Minimum: -40
Maximum: -8

Compound Dispense Heights Low (mm) Minimum: 0.2
Maximum: 1.2

Medium (mm) Minimum: 0.5
Maximum: 2.5

High (mm) Minimum: 1.2
Maximum: 4.0

Mixing Parameters PatchPlate Mixing Height (mm) Minimum: 0.5
Maximum: 3.5

Buffer volume (μL) Minimum: 10
Maximum: 18

5. Click Save.
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Working Offline in Analysis Only Mode
IonWorks Barracuda® System Software runs in two modes:

Analysis only: Software does not control the instrument, for data analysis only, as
described in this topic.

Barracuda: Software controls the instrument, for data acquisition. For more information,
see Starting Up the IonWorks Barracuda System on page 11.

Note: Multiple instances of the Analysis only software can run simultaneously,
because it does not control the instrument, while one instance of the Barracuda data
acquisition software runs controlling the instrument.

Two desktop icons are available to start the software:

To open the software in Analysis only mode, double-click the icon labeled IonWorks
[Analysis Only].
While using the software in Analysis only mode, you can:

Create and edit protocols (but not run them)

Define newmetrics

Analyze acquired data using metrics, filters, and summaries

Create export methods and export data files

Disconnecting Control of the Instrument

If you are finished running assays for the day and have completed instrument cleanup, you
can disconnect the control of the instrument to work in Analysis only mode.
To disconnect the software control of the instrument:

1. In the softwaremenu, click Instrument > Disconnect from Instrument.

2. Click Yes at the prompt to confirm.
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Reconnecting to the Instrument

If you disconnected the software control of the instrument to work in Analysis only mode,
you can reconnect.
To reconnect the software control of the instrument:

1. Save any files you are working on.

2. Exit the software.

3. Restart the software by double-clicking the IonWorks Barracuda icon.

Installing IonWorks Barracuda™ Software
IonWorks Barracuda® System Software can be installed on additional computers to work in
Analysis only mode. Before installing the software, make sure the computer meets the
following minimum system requirements:

OS: Windows 7 (64-bit) and Windows 10 (64-bit)

CPU: Quad core 2.4 GHz

RAM: 8 GB

Graphics card supporting a resolution of 1920 x 1200

Note: The software is designed for a 24-inch monitor with a display resolution of
1920 x 1200, and default display font setting. If you are installing on a computer with a
lower resolution or smaller screen size, or change the computer font size to larger
than the 100% setting, you might experienceminor display issues.

To install the software:

1. Insert the Automated Patch Clamp System CD into the drive. The installation process
begins automatically.
If you have disabled auto-play features, you can begin the installation by browsing the
CD to locate the installer file: BarracudaInstaller.exe. Double-click the
BarracudaInstaller.exe file to begin the installation process.

2. Follow the prompts to install the software. Make sure you choose the option for
Simulation Modewhen installing on any computer not connected to the instrument.
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Chapter 3: Instrument Overview

This section provides a functional overview of the IonWorks Barracuda®instrument
components. For information about the software, see Software Overview on page 13.
Themajor components of the IonWorks Barracuda System include:

The Instrument Cabinet on page 24

The Process Deck on page 27

The Patch Engine on page 30

The Pipettors on page 38

The Fluid Handling Components on page 40

The Cell Handling Components on page 39

The System Computer on page 43

The Barcode Reader on page 43

3
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The Instrument Cabinet
The instrument cabinet houses the components of the IonWorks Barracuda System. For
dimensions and operational specifications, see Instrument Specifications on page 191.

Figure 3-1: The IonWorks Barracuda System Instrument Cabinet

Position Component

1 Upper compartment (Process deck)

2 Glass door

3 Lower compartment (Fluidics)

4 Emergency stop button

5 Right-side compartment

6 Power supply panel

Upper Compartment

The Process Deck, Pipettors, and Cell Handling components reside in the upper, glass-front
compartment of the system cabinet. The upper compartment locks during automated
operations.
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Lower Compartment

The lower cabinet compartment encloses the fluid-handling system and the Patch Engine.
The fluid-handling system includes fluid lines, pumps, valves, and sensors, plus source and
waste carboys. The Patch Engine assembly clamps the Electrode-Plate to the plenum and
controls vacuum pressure between the PatchPlate and the plenum nest during assays. The
lower compartment locks during automated operations.

Emergency Stop Button

A red emergency-stop button is built into the front of the instrument cabinet. If an
emergency occurs while the instrument is running, press the emergency-stop button to
immediately cease all instrument functions.

Right-side Compartment

The right-side of the cabinet includes an enclosed fluid-handling area for the wash station
and CellPettor with peristaltic pumps, a syringe pump, tubing, sensors, and a temporary
waste bottle.
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Power Supply Panel

The power supply panel is on the right side of the cabinet and includes:

Voltage output (BNC) cable port

Ethernet (CAT 5) port

Covered exhaust fan outlet

Four indicator lights:

Label Indicates...

POWER 120-240 VAC (Universal Power Supply) power to the system computer

+24 VDC 24-volt DC power to components that run continuously

+24 VDC 24-volt DC power to interlocked components that switch off during access to the
process deck

+48 VDC 48-volt DC power to interlocked components that switch off during access to the
process deck

System power switch

System power cord outlet
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The Process Deck
There are seven stations on the process deck. From left to right, the process deck stations
include:

Figure 3-2: The Process Deck

Position Station

1 Tip Rack (Do not use for compound plates)

2 External Buffer Boat

3 Compound 1

4 PatchPlate/Plenum

5 Wash Station

6 Compound 2

7 Cell Boat

Each of the stations is configured with an SBS-standard, 384-well microplate footprint to
accommodate the 384-pipettor head. All assay steps take place on the process deck. The
robotic pipettor head delivers fluids from the buffer boat, cell boat, and compound stations
to the PatchPlate.

The Tip Rack Station

The tip rack station holds a Molecular Devices tray preloaded with 384 disposable
micropipettor tips. Molecular Devices black tips [PN 5011976] or clear tips [PN 5011975] are
approved for use with the Barracuda instrument. Black tips are recommended.

Note: Tips can be unloaded from the pipettors and reloaded approximately nine
times before you must replace the tip rack with new tips.

The robotic pipettor head lowers onto the pipettor tip rack to load the disposable pipettor
tips at the start of an experiment. The pipettor tips are used to aspirate and dispense
external buffer solution, compounds, and cells within the PatchPlate as required throughout
the duration of a protocol. The tips can be automatically washed for reuse as specified in

Creating a Cleanup Protocol on page 97, or manually in the dialog.
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Note: The tip rack station is engraved TIPS/COMPOUND 3. Please see specific
instructions for adding three or more compounds since this position is not currently
active for compound additions.

The External Buffer Station

The external buffer station holds an SBS-standard microplate with a 384-well footprint. Fill
the external buffer boat with a minimum volume of 25 mL up to a maximum of 125 mL with
your external buffer solution of choice prior to the start of any experiment. When filling the
reservoir, make sure you dispense adequate total volume for each of the steps in your
protocol.

CAUTION! Fill the boat or plate with adequate volume. Inadequate volume can cause
the pipettor head to aspirate an air and fluid mixture that can ruin an experiment by
dispensing air into the PatchPlate wells.

The Compound Stations

The Compound 1 and Compound 2 stations accommodate the SBS-standard footprint
microplates listed in the Compound Addition section of the software. The pipettors aspirate
compound from the Compound 1 or Compound 2 position and deliver it to the PatchPlate
based on the protocol specifications.
Make sure you calculate appropriate total compound volume depending on the volume of
each addition specified in the experiment protocol instructions.
Detailed volume specifications for allowed compound plates are available in the Compound
Addition area of the Channel Protocol Editor. Click next to the Plate Type list to display
detailed volume specifications based on your plate type selection.

CAUTION! Fill the boat or plate with adequate volume. Inadequate volume can cause
the pipettor head to aspirate an air and fluid mixture that can ruin an experiment by
dispensing air into the PatchPlate wells.

The PatchPlate Station

The PatchPlate station consists of the plenum at its base, the consumable PatchPlate which
rests in a nest in the plenum, and the Electrode-Plate which mechanically clamps to the
assembly. The instrument creates a vacuum-seal between the PatchPlate and the plenum
during assays. All experimental operations occur in the wells of the PatchPlate including fluid
pipetting, cell dispensing, compound additions, and ion-channel recording.
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The Wash Station

TheWash station is a fixed reservoir on the process deck designed to accommodate the
pipettor tips and the Electrode-Plate electrode pins for washing procedures. Solutions for
wash operations are pumped through theWash station by the fluid-handling system and
then emptied into the waste carboys below. Sensors monitor fluid levels to prevent overflow
in theWash station. An ultrasonic transducer provides an option for sonicating to
thoroughly clean the Electrode-Plate electrode pins or to remove sticky compounds from the
pipettor tips. TheWash station also serves as the home position for the Electrode-Plate.

Figure 3-3: Wash Station
Wash station options include:

The use of one or two solutions or solvents (Source A or Source B)

The number of strokes per wash cycle (1 to 20)

The total number of wash cycles (1 to 5)

The option for ultrasonic cleaning

WARNING! Do not enable ultrasonic cleaning while using any flammable liquid
such as alcohol (EtOH) in the Source A or Source B bottles. Sonication can cause
flammable liquids to evaporate into the enclosure, posing a potential risk of fire
or explosion.

CAUTION! Do not use the ultrasonic cleaning option when the wash station reservoir
is empty. Dry sonication can lead to equipment failure.
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The Cell Boat Station

The cell boat holds cells suspended in external buffer before they are aspirated by the
pipettors and delivered to the PatchPlate. The cell boat station requires the use of approved
cell boats only. Molecular Devices provides a custom-configured cell boat for use with the
CellPettor that conserves cell suspension by reducing required cell boat volumes to
approximately 5 mL [Molecular Devices PN 5005252].
Contact Molecular Devices Technical Support for information about adding an additional cell
boat type to the IonWorks Barracuda® System Software list.

WARNING! Always wear protective equipment and review all applicable
laboratory site regulations when handling cell solutions and cell waste. Always
follow the appropriate procedures for the biosafety level of the substance you are
handling.

CAUTION! The CellPettor cell-handling subsystem requires the use ofMolecular
Devices approved cell boats [Standard cell boat: Molecular Devices PN 5005252]. Using
labware other than theMolecular Devices approved cell boats could damage the
CellPettor.

The Patch Engine
The Patch Engine is the component of the IonWorks Barracuda System that digitizes data
acquired during the automated patch clamp operation. The Patch Engine resides in the lower
cabinet behind the internal buffer and cell perforation agent bottles, and beneath the
PatchPlate Station.
The core components of the Patch Engine assembly are:

The Plenum: The liquid-filled base of the Patch Engine that includes the ground
electrodes and forms a vacuum beneath the PatchPlate.

The Electrode-Plate: An array of 384 Ag/AgCl electrodes housed in a frame that fits on
top of the PatchPlate and the plenum.

The Data Acquisition Engine: The system that collects signals during assays. Each of the
384 electrodes on the Electrode-Plate connects to a single amplifier and digitizer to
simultaneously convert the 384-channel recordings into usable data. This connection is
made through the 384 pogo pins on the Electrode-Plate.

The Patch Engine assembly clamps the Electrode-Plate to the plenum maintaining a vacuum-
tight seal between the PatchPlate and the plenum nest during assays.
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Figure 3-4: The Patch Engine

Position Component

1 Amplifier touch pads

2 Amplifier boards beneath the plenum

PatchPlates

The consumable PatchPlate is a 384-well, SBS-standard footprint, planar patch microplate
with a polyimidemembrane at the bottom.
The capacity of each PatchPlate well is ~60 µL. A funnel guide in the PatchPlate wells ensures
consistent positioning of the pipettor tips. The electrodes of the Electrode-Plate remain
immersed in the PatchPlate wells for continuous recordings during assays. Fluid level is
maintained in the wells between fluid additions by removing fluid from the wells after
completing each compound addition and recording.

Note: PatchPlates are designed for a single use. Reuse PatchPlates for the Start of Day
and End of Day Flush and Rinse procedures only.
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Each well of the PatchPlate consumable features a flow-through design for rapid solution
exchange enabled by:

A funnel guide to locate the pipettor tip to a consistent position within the well.

User-defined dispense speeds and heights to control flow.

Rapid individual offset correction for each of the 384 electrodes.

WARNING! Always wear protective equipment and review all applicable
laboratory site regulations when handling cell solutions and cell waste. Always
follow the appropriate procedures for the biosafety level of the substance you are
handling.

PatchPlate Types

There are several types of PatchPlates:
Single-Hole (SH)MegaSeal plates [Molecular Devices PN 5008697] contain a single ~2 µm
hole in each well. Orange packaging labels designate SH plates.
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Population Patch Clamp (PPC)MegaSeal plates [Molecular Devices PN 5008680] contain an
array of 64 holes (~2 µm) in each well. Blue packaging labels designate PPC plates.

PatchPlate Well Configurations

The 384wells of the PatchPlate are arranged in a grid of 16 rows by 24 columns. Each well in
the PatchPlate is identified by a unique address. Only the A1well is physically labeled on the
PatchPlate:

The 16 rows are identified in the software as A–P.

The 24 columns are identified in the software as 1–24.

Individual wells are identified by a row letter and a column number. When the PatchPlate is
loaded onto the process deck, the well closest to the left-front of the system cabinet is A1.
The right-rear well in this position is P24, the 384th well. All stations except the wash station
are engraved with A1 in the front-left position as a guide to properly loading plates.

PatchPlate Packaging, Storage, and Handling

TheMolecular Devices consumable PatchPlate packaging, storage, and handling
specifications include the following:

MegaSeal PatchPlates

Each box contains 48 PatchPlates (12 packages of 4 plates each).

Must be stored in a cool, dry place.

SH packages labels are orange.

PPC package labels are blue.

Performance is assured for six months from the date of receipt.
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Plenum

The fixed foundation of the PatchPlate station is called the plenum. The plenum enables
delivery, from below, of internal buffer solution and cell perforation agent solution. The top
surface of the plenum contains four ground electrodes.

CAUTION! Do not touch the round, ground electrodes on the surface of the plenum.
Doing so could result in a build-up of oils on the electrodes. Oil buildup on the
electrodes impedes their functionality.

Figure 3-5: The Standard Plenum Figure 3-6: The Replaceable Ground Electrodes
(REGEs) Plenum

Position Component

1 Ground electrodes.

2 Amplifier touch pads.

3 Plenum O-ring (rubber gasket). The color of the O-ring can vary.

The PatchPlate and the Electrode-Plate are clamped onto the plenum to seal fluids during an
assay. Source solutions are pumped into, and waste fluids are pumped out of, the plenum
throughout an experiment. An O-ring surrounding the perimeter of the plenum permits the
creation of a seal with the PatchPlate. A small negative pressure is used to pull the cells into
the holes of the PatchPlate.

CAUTION! Always keep the plenum dry. Before loading a new PatchPlate, avoid the
cable on the left side of the plenum and gently blot the plenum with a lint-free cloth.

A pressure sensor on the fluidics system monitors the PatchPlate-plenum seal and reports
the vacuum pressure.
To check the plenum vacuum pressure:

In the software, click Instrument > View Plenum Vacuum Pressure.

There are two styles of plenum, the standard plenum incorporating fixed ground electrodes,
and the replaceable ground electrodes (REGEs) version. Your instrument will have one or the
other style installed. To upgrade from a standard plenum to a REGE plenum, contact your
Molecular Devices representative.
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In addition to including four removable ground electrodes, the REGE plenum includes
multiple protective features:

Double O-rings in each plenum socket guard against internal buffer entering the plenum
socket.

Hermetically sealed plenum sockets assure that if the double O-ring fails, liquid stays in
the plenum.

Silver plated plenum socket metals prevent adverse junction potentials.

Replaceable Ground Electrodes (REGEs)

IonWorks Barracuda instruments are in the process of having a plenum upgrade installed
with four replaceable ground electrodes (REGEs). See Plenum on page 34.
IonWorks Barracuda instruments using the REGE Plenum, comewith a second set of four
REGEs, four spare large plenum socket O-rings, four spare socket springs, and a service tool.
A REGE Kit is also available if you want to purchase additional REGE sets. See Accessories on
page 189.
Each REGE is encased in a serialized plastic housing that incorporates screw threads for
installation and removal, and two small holes in the housing on opposite sides of each other
to accommodate the custom service tool.

Figure 3-7: Side and Top View of a Replaceable Ground Electrode
Each REGE set is serialized. On the bottom of each housing in a set is a serial number and a
letter. Each set should have the same serial number along with the letter A, B, C, or D to track
each REGE location within the plenum slots, as needed. Molecular Devices recommends
using the REGEs as complete sets. Avoid mixing multiple sets.

Figure 3-8: Serialized Set of Replaceable Ground Electrodes
For instrument maintenance purposes, Molecular Devices recommends removing and
conditioning each installed REGE set nightly. See Conditioning Replaceable Ground
Electrodes (REGEs) on page 153.
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Electrode-Plate

The Electrode-Plate consists of an array of 384 silver chloride-coated electrodes housed in a
framewhich fits on top of the PatchPlate and the plenum. When the Electrode-Plate is
clamped to the plenum, two banks of spring-loaded pogo-pins outside of the electrode array
connect with the 384 amplifiers residing beneath the process deck. Holes in the
Electrode-Plate provide access for the pipettor tips so that ion-current recordings are
possible during the simultaneous addition of compounds to the PatchPlate wells.
Two types of Electrode-Plate are provided with your instrument, one Standard
Electrode-Plate with green printed circuit boards, and one RA1 Electrode-Plate with black
printed circuit boards. The RA1 Electrode-Plate uses pins that have a reduced silver chloride
surface area compared to the pins in the Standard Electrode-Plate.
Stable recording of ion channel currents is crucial for pharmacological analysis of drug
candidates. With other conditions being the same, the RA1 Electrode-Plate provides a
significantly prolonged assay window for Nav1.5 channels. Improvements can also be seen
on other channel types as well. Molecular Devices recommends that you try both
Electrode-Plate to determine which one is best for your specific assay. Track which
Electrode-Plate is used in your protocol in the Experiment Notes dialog.

Figure 3-9: The Standard Electrode-Plate and the RA1 Electrode-Plate

Position Component

1 Electrodes (measure current in the wells)

2 Pogo pins (connect to amplifiers)
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After a PatchPlate has been loaded and the assay begins, the pipettor transports the
Electrode-Plate from its resting position at the wash station to the PatchPlate station.

Figure 3-10: RA1 Electrode-Plate Clamped Onto the Plenum
The Electrode-Plate can deliver voltages in a range from -200 mV to +200 mV depending on
the voltages specified in the software protocols.

CAUTION! To avoid damage to the Electrode-Plate:

Do not touch the electrode pins or the pogo pins on the underside of the Electrode-
Plate.

Keep the pogo pins dry.

Never immerse the Electrode-Plate in liquid of any kind. The electrode pins, however,
can be immersed in a bleach solution for rechloriding.

Always lift the Electrode-Plate using the handles on the top.

Always set the Electrode-Plate on a flat surface resting on its four stand-offs or on the
Bleach Boat.
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The Pipettors
The head of the pipettor robot holds 384 distinct micropipettors that operate
simultaneously to transport fluids from the cell boat, the buffer boat, and the compound
plates to the PatchPlate wells. The pipettors aspirate and dispense fluids in precise amounts
according to instructions specified in the software protocols. If the protocol set up in the
software specifies it, the pipettors can circulate solutions within the wells by aspirating and
dispensing small amounts.

Figure 3-11: The Pipettors

Position Component

1 Pipettor head (pipettors)

2 Electrode-Plate transport clips

Pipettor Tips

At the start of an experiment run, the system loads disposable tips onto the pipettor head
from the tip rack. The disposable pipettor tips can be washed between runs for reuse as
specified in the Cleanup Protocol. For details, see Creating a Cleanup Protocol on page 97.
Molecular Devices black tips [PN 5011976] or clear tips [PN 5011975] are approved for use
with the Barracuda instrument. Black tips are recommended.

Electrode-Plate Transport

The pipettor head also serves as a transport mechanism for the Electrode-Plate, moving it
from its resting position at the wash station to the PatchPlate station during assays, and
then back to the wash station upon completion.
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The Cell Handling Components
The IonWorks Barracuda System includes an automated cell-handling unit called the
CellPettor, meaning "cell pipettor." The CellPettor delivers cell suspension to the cell boat
during experiments. You can also deliver cells manually to the cell boat by turning off the
CellPettor. See Adding Cells on page 59.
The cell-handling components include:

Figure 3-12: The Cell Handling Components

Position Component

1 CellPettor

2 Cell tube holder

3 Cell waste sink

The CellPettor

The CellPettor is a robotic pipetting unit positioned above the process deck and near the cell
boat station. The robot requires a standard 5 mL aspirating pipette with the cotton plug
removed from the end, and a standard cell boat [Molecular Devices PN 500525] to operate.
The dimensions for the aspirating pipette should be:

8 mm diameter x 350 mm length
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The Cell Tube

After you have prepared the cell suspension, pipette to a 15 mL conical tube for use with the
CellPettor. Fill the cell tube with a minimum of 5 mL and a maximum of 10 mL of cell
suspension. Load the conical tube of cell suspension into the cell tube holder in the frame of
the process deck. The CellPettor aspirates prepared cell suspension from the conical tube
and delivers the suspension in a serpentine pattern to the channels in the cell boat.
The dimensions for the cell tube should be:

17 mm diameter x 120 mm height

The Cell Waste Sink

Excess cell suspension is dispensed from the CellPettor to the 15 mL conical tube. The
CellPettor pipette is washed with external buffer that flows to the cell waste sink. Finally, the
sink fluids are pumped to the cell waste carboy below the process deck.

Note: Do not use the cell waste sink for any other waste.

CAUTION! The CellPettor cell-handling subsystem requires the use ofMolecular
Devices approved cell boats [Standard cell boat: Molecular Devices PN 5005252]. Using
labware other than theMolecular Devices approved cell boats could damage the
CellPettor.

The Fluid Handling Components
Using a network of tubing, pumps, valves, and sensors, the fluid-handling system delivers
source fluids and pumps out waste fluids. Source bottles and waste bottles reside on holding
racks below the process deck. Source bottles hold wash solutions and solvents, buffer
solutions, perforation agent, and alcohol (EtOH). Waste carboys hold expelled solutions and
cell waste.
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Figure 3-13: The Fluid Handling Components

Position Component

1 Alcohol (EtOH)

2 External buffer solution (behind the alcohol source bottle)

3 Cell perforation agent

4 Internal buffer solution

5 Source A (wash solution)

6 Source B (wash solution)

7 Overflow reservoir

8 Waste A

9 Waste B

10 Plenum/Cell Waste
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Source Fluid Bottles

The upper holding racks accommodate external buffer, alcohol, Amphotericin (or other cell
perforating agent), and internal buffer bottles. These fluids must be filled with a minimum
working volume of 100 mL before beginning the Start of Day Flush and Rinse procedure or a
series of experiments.

Source A and B Wash Solution Carboys

Two six-liter bottles of wash solution are housed in the lower fluidics drawer at the rear of the
system cabinet (Source A and Source B). Source bottles must be filled prior to the start of an
experiment run and placed in the correct positions in the fluidics drawers. See Preparing the
Fluid-Handling System on page 101.

Waste A and B Carboys

Two six-liter waste bottles are housed in the fluidics drawer in the front of the system cabinet
(Waste A and Waste B). Always empty them at the beginning of the day, or prior to the start
of an experiment run. Although the waste bottles include sensors to prevent overflow,
overflow damages the vacuum pump so make sure you empty waste carboys regularly. The
vacuum pump drains fluid waste from the wash station and delivers the waste fluids first to a
temporary waste bottle, and finally to theWaste A and Waste B carboys. See Emptying
Waste Carboys on page 102.

Plenum and Cell Waste Carboy

A third six-liter bottle for (Plenum/Cell Waste) holds cell-contaminated fluids collected from
the cell handling system and the plenum including cell suspension, internal buffer, and
perforation agent. The Plenum/Cell Waste bottle must also be emptied prior to the start of
an experiment run to prevent overflow. See Emptying Waste Carboys on page 102.

Overflow Reservoir

A low-capacity overflow sink, or open reservoir, is located behind the plenum/cell waste
carboy. The reservoir captures any spill or overflow that might occur on the process deck.
The overflow reservoir should be checked periodically for liquid, and should be sponged out
to prevent the reservoir from overflowing onto the floor. If the overflow reservoir has fluid in
it, and you have not spilled any liquid, contact Molecular Devices Technical Support.

WARNING! Always wear protective equipment and review all applicable
laboratory site regulations when handling cell solutions and cell waste. Always
follow the appropriate procedures for the biosafety level of the substance you are
handling.
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The System Computer
The system computer resides inside the instrument cabinet on the lower left side. The
system computer runs the pre-installed IonWorks Barracuda® System Software that controls
automated instrument operations. The system computer must be in good working
condition for the IonWorks Barracuda System to operate properly.

Figure 3-14: The System Computer

Position Component

1 System Computer

The Barcode Reader
The IonWorks Barracuda System includes a hand-held barcode reader for use with barcoded
compound plates. Data file names can be appended with the barcode number as a method
for organizing experiment results.
For detailed instructions on using the barcode reader, please see themanual included with
the device.
To use the barcode reader with the IonWorks Barracuda System:

1. Make sure the barcode reader is plugged into a USB port on themonitor.

2. Before running an experiment, click Experiment > Experiment Name > Set. The Set
Experiment Name dialog appears.

3. Select the Include Barcode check box to append the barcode number to the folder
name.
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4. For your selected Channel Protocol, in the Edit Channel Protocol > Aspirate > Barcode
Position field, make sure an option other than NONE is selected. See Specifying Aspirate
Options on page 71.
When you run an experiment, the Set Compound Plate Barcodes dialog appears
immediately.

5. Scan the barcode labels as prompted.

6. Continue with normal data acquisition to complete the experiment.

Your data saves in a folder named whatever you specified in Set Experiment Namewith your
scanned barcode number at the end. See Setting the Experiment Name on page 118.
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Chapter 4: Developing New Protocols

There are three types of protocols: Setup, Channel, and Cleanup. To run an assay, you must
select one of each type of protocol. You can develop new protocols to match your lab
standards by modifying the example protocols or by modifying any existing protocol. Select
the protocol that most closely matches the assay type you need. Then modify the protocol
using the protocol editor and save it as a new protocol. For Channel Protocols, you can run
the protocol in Assay Development Mode, and then save it as a new protocol. Each example
protocol provided by Molecular Devices also includes at least one samplemetric for data
analysis.

Note: Disabled by default, to enable the charge calculator features that are available
in the Edit Setup Protocol dialog and Edit Channel Protocol dialog, select the Enable
Charge Calculator check box in the Preferences dialog. See Estimating Experiment
Total Charge on page 54 for details.

Developing Setup Protocols
The Setup Protocol begins the experiment with parameters for single-hole or PPC-type plate,
hole test levels, amount and dispense speed for cell suspension, and seal test parameters
after cells are added. The Setup Protocol also controls the steps for obtaining cell access and
going whole cell. After the Setup Protocol completes, the Channel Protocol starts. Example
Setup Protocols are available for single-hole (SH) and population patch clamp (PPC) plates.
For information about developing Setup Protocols, see Creating a Setup Protocol on page
55.

Developing Channel Protocols
Channel Protocols control data acquisition before, during, and after compound additions for
ligand-gated or voltage-gated applications. The Channel Protocol parameters vary greatly
depending on the type of assay you are running, the cell line, or the ion-channel of interest.
Using the sample protocols, you can modify the parameters for developing an optimized
assay. In Assay Development Mode, you can run through Channel Protocol scenarios and
save the optimized assay protocol as a new protocol. After the Channel Protocol completes,
the Cleanup Protocol starts. Example channel protocols include Voltage-Gated and Ligand-
Gated protocols.
For information about developing Channel Protocols, see Creating a Channel Protocol on
page 67.

4
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Voltage-Gated Example Protocols

The following voltage-gated protocols involve one compound addition: channel blocker.

Type of Protocol Listed in the Software

hERG - Potassium Channel Example hERG Protocol Single Addition

Kv1.3 - Potassium Channel Example Kv1.3 Protocol Single Addition

Nav1.5 - Sodium Channel Example Nav1.5 Protocol Single Addition

Ligand-Gated Example Protocols

The following ligand-gated protocols involve two compound additions: channel blocker
followed by channel activator:

Type of Protocol Listed in the Software

GABA - GABA Receptor Ion Channel Example Blocked GABA Protocol

ASIC1a - Acid Sensitive Ion Channel Example Blocked ASIC1a Protocol

α7nACh - Nicotinic Acetylcholine
Receptor Ion Channel

Example Blocked Alpha7 nAChR Protocol

Developing Cleanup Protocols
The Cleanup Protocol automates necessary maintenance steps between assays such as
washing the pipettor tips, washing the CellPettor, and washing the electrodes on the
Electrode-Plate. One standard example Cleanup Protocol is available.
For information about developing Cleanup Protocols, see Creating a Cleanup Protocol on
page 97.
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Experiment Mode
You can run experiments in the following modes:

Assay Development Mode: During Assay Development Mode, the selected Channel
Protocol runs and pauses. At the pause, you can adjust parameters to modify the
Channel Protocol. The assay continues to pause after each iteration of the Channel
Protocol until you have optimized for your desired result. You can then save the
optimized Channel Protocol as a new protocol, which can be run later in Multiple
Protocol mode or Single Protocol mode. SeeModifying a Channel Protocol in Assay
Development Mode on page 47. If you are running in Assay Development Mode, follow
the prompts at the pause to run through iterations of the Channel Protocol, or complete
the experiment by proceeding to the Cleanup Protocol.

Multiple Protocol Mode: In Multiple Protocol mode, you can select multiple Channel
Protocols to run without interruption, except for specified pauses in operations to add
or change compound plates or to add cells. Experiments are conducted using one Setup
Protocol, any number of Channel Protocols, and one Cleanup Protocol.

Single Protocol Mode: In Single ProtocolMode, the selected protocols run without
interruption. One Setup Protocol, one Channel Protocol, and one Cleanup Protocol run
through to completion, except for specified pauses in operations to add or change
compound plates or to add cells.

Modifying a Channel Protocol in Assay Development Mode
When you want to optimize a new type of assay, you can open a pre-defined Channel
Protocol from Molecular Devices and then optimize the sample assay using Assay
Development Mode.
To modify a pre-defined Channel Protocol in Assay Development Mode:

1. Select a Setup Protocol from the list of saved protocols.

2. Select a Cleanup Protocol from the list of saved protocols.

3. From the list of pre-defined Channel Protocols, select the Channel Protocol that most
closely matches the assay you would like to optimize for.

4. To preview the parameters for the pre-defined protocol, or to make changes before
running the protocol, click Edit. The Channel Protocol Editor appears.

5. Review the parameters. If applicable, make any necessary changes to the parameters
listed for the Channel Protocol. Click Save. The Channel Protocol Editor closes.

6. In the Data Acquisition and Reviewworkspace, click Assay Development Mode.
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7. Click to start the assay.

8. Add Experiment Notes, and then click Continue. See Adding and Viewing Experiment
Notes on page 121. The instrument runs through the Setup Protocol and the Channel
Protocol and then pauses. The Assay Development dialog appears.

9. Click to review Channel Protocol data in the Data Acquisition and Review
workspace. The plate view, Fixed Well view and Floating Well view functions are all active
for your data review.

10. Click to return to the Assay Development dialog.
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11. Continuing depends on what you want to do next. You have the following choices:
Button Task

To edit a selected Channel Protocol:

a. Click to open the Channel Protocol Editor.

b. Make any adjustments to the parameters, and then click Save.

c. If the protocol you edited was marked Read-Only, then type a new Protocol
Name and click Save.

Run the selected Channel Protocol.

12. Click when you are finished with the assay development. The selected Cleanup
Protocol runs to end the experiment.

Using the Model Cell to Validate a Protocol
A companion component to the Electrode-Plate, theModel Cell simulates a whole cell circuit
using resistors built into the frame housing. When you are developing new protocols, you
can use theModel Cell in place of the Electrode-Plate to test the basic output and resistance
of a voltage application before testing the protocol on actual cells.
TheModel Cell is divided into two sides:

The left bank of resistors (A1:H24) mimics a population patch clamp (PPC) PatchPlate at
200 kΩ. Fifty nano-amps (50 nA) of current is expected for every 10 mV applied in the
protocol. Keep in mind that the currents for this bank easily reach the instrument limit
(110 nA) for protocols run in single-hole (SH)mode.

The right bank of resistors (I1:P24) mimics a single-hole (SH) PatchPlate at 10MΩ. One
nano-amp (1 nA) of current is expected for every 10 mV applied in the protocol.

When you review the data from aModel Cell assay, keep in mind that the two types of
resistors produce different results, some of which might not apply to your intended test.
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To use theModel Cell to validate a voltage protocol:

1. Select Setup, Channel, and Cleanup Protocols.

2. Place theModel Cell unit on the wash station in place of the Electrode-Plate.

3. Start the experiment in Assay Development Mode if you want to adjust the voltage
parameters.

4. To switch between SH and PPC testing, change the PatchPlate Type selection in the
Setup Protocol, then run the assay again. Expect current saturation in all wells served by
the PPC resistor bank when running a SH protocol and applying voltage less than –25 mV
or greater than +25 mV.

Saving Read-Only Protocols
The sample protocols aremarked as read-only, and they cannot bemodified or saved. If you
change the protocol name, however, you can save the protocol settings as a new protocol.
You can then modify the protocol parameters to suit your needs.
In addition, you can mark any protocol as read-only to prevent accidental changes.
To save a read-only protocol with a new name:

1. In the Protocols section of the Data Acquisition and ReviewWorkspace, select a read-
only protocol selection field. See Data Acquisition and ReviewWorkspace on page 15.

2. Click Edit to open the Protocol Editor.

3. If the Save Protocol as Read-Only check box is active, clear the check box.

4. If the protocol is an example protocol and the Save Protocol as Read-Only check box is
not active, type a new name in the Protocol Name field. The protocol name can include
up to 100 characters. Do not include the following characters since they are invalid: \ / :
* ? " < > |.

5. In the protocol description field, you can type any notes or information about the
protocol that you want to record. This field allows up to 250 text characters.

6. Select the Save Protocol as Read-Only check box to prevent future changes to the
protocol. Leave the box unchecked to allowmodifications to the protocol in the future.

7. Click Save. The new protocol appears in the Protocols field.
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Viewing the Protocol Summary
On the Review Protocol tab, you can view a summary of the all the parameters defined in
the steps for the protocol.
To view the protocol summary:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a protocol
from the protocol selection field. For details, see Data Acquisition and ReviewWorkspace
on page 15.

2. Click Edit to open the Protocol Editor.

3. Click in the protocol editor.

4. To change any of the defined parameters, return to the step-tab for the parameter and
make your changes.

5. To print the summary click and follow the prompts.

6. To copy the summary to the clipboard, click . The summary data is copied to the
clipboard. Paste the data into your preferred application.

Increasing Assay Window Longevity
Molecular Devices scientists have found that refreshing the recording buffers just prior to
recording ionic currents (“buffer wash”) can greatly increase the useable assay window for
stable ionic current magnitudes on the IonWorks Barracuda System. For best results, we
recommend exchanging the internal and external buffers just prior to adding cells and then
exchanging the external solution just after cell seal formation prior to recording ionic
currents. This can be done automatically by configuring these exchanges in the Setup
Protocol.
Recommended buffer wash procedures include exchanging buffers before the cell addition
and after the cell addition. Set buffer washes while creating a Setup Protocol in the Edit
Setup Protocol dialog. See Setting Buffer Wash Recommendations on page 51 for
procedures.

Setting Buffer Wash Recommendations

Molecular Devices recommends the following buffer wash setting guidelines for both Buffer
Wash Before Cell Addition and Buffer Wash After Cell Addition. Set buffer washes while
creating a Setup Protocol in the Edit Setup Protocol dialog.

Note: Different cell lines or ion channel targets may require different settings than
these recommended guidelines.
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Recommended Settings for Buffer Wash Before Cell Addition

To configure the buffer wash before cell addition settings:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Edit Setup Protocol dialog.

3. In the Add Cells section of the Step 1 tab, select theWash before cell addition check
box to run one or more external buffer and internal buffer exchanges before cells are

added. Click to open the Buffer Wash Before Cell Addition dialog to configure the
wash.

4. In the Buffer Wash Before Cell Addition dialog, enter the settings provided in the dialog
figure below.

Figure 4-1: Recommended Buffer Wash Before Cell Addition Settings

5. Click OKwhen done.
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Recommended Settings for Buffer Wash After Cell Addition

To configure the buffer wash after cell addition settings:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Edit Setup Protocol dialog.

3. In the Seal test section of the Step 1 tab, select theWash after cell addition check box
to run one or more external buffer and amphotericin exchanges after cells are added.

Click to open the Buffer Wash After Cell Addition dialog to configure the wash.

4. In the Buffer Wash After Cell Addition dialog, enter the settings provided in the dialog
figure below.

Figure 4-2: Recommended Buffer Wash After Cell Addition Settings

5. Click OKwhen done.
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Estimating Experiment Total Charge
The Coulomb Meter in the software calculates the total charge passed during a typical
experiment. The calculation value can be used to troubleshoot technical or assay issues. The
Coulomb Meter is located in the upper right corner of the Edit Setup Protocol dialog and the
Edit Channel Protocol dialog. The total charge is estimated by taking the integral of the
calculated current using the voltage protocol and the seal resistance value specified in the
Estimated Seal Resistance field, identified by the orange border.

Figure 4-3: Charge Calculator Features in the Edit Setup Protocol Dialog
The input value for Estimated Seal Resistance is for calculating the anticipated total charge,
and does not represent the actual experiment seal resistance.

Note: To enable the charge calculator features, select the Enable Charge Calculator
check box in the Preferences dialog.
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Chapter 5: Creating a Setup Protocol

The Setup Protocol begins the experiment with parameters for single-hole or PPC-type plate,
hole test levels, amount and dispense speed for cell suspension, and seal test parameters
after cells are added. The Setup Protocol also controls the steps for obtaining cell access and
going whole cell. After the Setup Protocol completes, the Channel Protocol starts.
To create a Setup Protocol:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Edit Setup Protocol dialog.

3. Review the parameters in each of the protocol editor steps:

Step 1: Specifying Plates, Tests, and Cell Access on page 56

Step 2: Editing Native Filters on page 65

Viewing the Protocol Summary on page 51

4. When you have finished setting the parameters, click Save to save your changes and to
close the protocol editor. If the protocol is marked Read-Only, type a new name for the
protocol, and then click Save.

5
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Step 1: Specifying Plates, Tests, and Cell Access
The first step in creating a setup protocol is to specify the Plates Type, Test Levels, and Cell
Access Steps to use in the protocol.

Figure 5-1: Edit Setup Protocol Step 1 Tab Dialog
To specify plate type, test levels, and cell access steps:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.
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2. On the Step 1 tab, specify the parameters to use. For details, see:

Selecting the PatchPlate Type on page 57

Setting Hole Test Voltage Levels on page 58

Adding Cells on page 59

Setting Seal Test Voltage Levels on page 62

Obtaining Cell Access on page 64

When typing values in theHole Test, Add Cells, Seal Test, and Obtain Cell Access
sections, the valid value range for the active field appears in the lower-left corner of the
section. When you type an invalid value in a field, an asterisk appears next to the field
and the value is shown in red type. An error message appears in the information area
near the top of the window.
If you enter an invalid value, the protocol cannot be saved until the invalid entry is
corrected.

Note: To enable the charge calculator features, select the Enable Charge
Calculator check box in the Preferences dialog.

3. When you have finished configuring the parameters, click Next to go to the next tab, or
click Save to close the protocol editor. If the protocol is marked Read-Only, type a new
name for the protocol, and then click Save.

Selecting the PatchPlate Type

The PatchPlate is a 384-well consumablemicroplate from Molecular Devices for partitioning
and positioning the cells. The PatchPlate type is set in the Setup Protocol.
To select the PatchPlate type:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. In the PatchPlate section of the Step 1 tab, select the type of consumable PatchPlate you
are using for this experiment, and specify if the Pipettor tips are being reused and need
priming. For details, see Priming Pipettor Tips on page 58.

PatchPlate SH (384-wells, single-hole wells, use to obtain MegaSeal planar patch-clamp
recordings)

PatchPlate PPC (384-wells, 64-holes per well, population patch clamp, use to obtain
MegaSeal planar patch-clamp recordings)
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4. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.

Priming Pipettor Tips

The Pipettor aspirates and dispenses fluids in precise amounts according to instructions
specified in the software protocols. The disposable Pipettor tips can be washed between
runs for reuse as specified in the Cleanup Protocol. However, when the Pipettor tips are
reused, air bubbles can be dispensed. To reduce the risk of dispensing air bubbles, Molecular
Devices recommends specifying Prime Pipettor Tips in your Setup Protocol. The Pipettor tip
priming operations involves a special cycle of aspirating and dispensing external buffer
several times before adding buffer to the PatchPlate during an experiment run.
To specifying the Pipettor tip priming:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. In the PatchPlate section of the Step 1 tab, check the Prime Pipettor Tips option.

Setting Hole Test Voltage Levels

During the Hole Test, the Electrode-Plate records the electrical current after the wells are
filled with external buffer, but before cells have been added. Awell is defined as Blocked
when themeasured resistance is less than 1MΩ or greater than 10MΩ. Wells that do not
pass the hole test are excluded when data is analyzed.
The Hole Test parameters are set in the Setup Protocol.
To set parameters for the Hole Test:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.



Chapter 5: Creating a Setup Protocol

5011662 M 59

2. Click Edit to open the Protocol Editor.

3. In the Hole Test section of the Step 1 tab, set these parameters:

Level 1 field, type the value in millivolts for the initial level.

Level 2 field, type the value in millivolts to step to after the Level 1 voltage is applied.

4. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.

Adding Cells

You define the way cells are added to the experiment in theObtain Cell Access section of the
Edit Setup Protocol dialog.

Figure 5-2: Add Cells section of the Step 1 Tab
To define cell additions:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.
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3. In the Add Cells section of the Step 1 tab, select theWash before cell addition check
box to run one or more external buffer and internal buffer exchanges before cells are

added. Click to open the Buffer Wash Before Cell Addition dialog to configure the
wash. See Setting Buffer Wash Before Cell Addition on page 60 for details.

4. Select the Pause after hole test to load cells check box to require the system to pause
the experiment so that you can position the prepared cell plate on the process deck.
When you are finished, click Continue to proceed with the experiment in progress.

5. To manually add cells to the cell boat and disable the cell-handling components, select
theDo not use CellPettor check box.

Select an allowed cell boat type so that the instrument can correctly position the
pipettors in the cell boat. Contact Molecular Devices Technical Support to request
additional boat types.

To view details about the selected cell boat type, such as Manufacturer's Part Number or

precise cell boat dimensions, click to open the View Plate Definition dialog which
includes details about the boat such as part numbers and precise dimensions. See
Viewing Plate Definitions on page 61 for details.
The CellPettor cell-handling subsystem requires the use ofMolecular Devices approved
cell boats [Standard cell boat: Molecular Devices PN 5005252]. Using labware other than
theMolecular Devices approved cell boats could damage the CellPettor.

6. Select the Resuspend cells in cell boat check box to enable theMix cycles field. To
resuspend the cells in the cell boat, the pipettors aspirate and dispense small amounts of
cell preparation. Each aspirate and dispense combination is onemix cycle.
If you have selected this option, then select the number ofMix cycles the instrument
should perform.

7. In the Volume of Cell Suspension per well field, type the number ofmicroliters the
pipettors should aspirate and transfer to the PatchPlate.

8. In theDispense Speed field, type the number ofmicroliters per second of cell suspension
the pipettors should dispense to the PatchPlate.

9. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.

Setting Buffer Wash Before Cell Addition

In the Add Cells section of the Step 1 tab, select theWash before cell addition check box to
run one or more external buffer and internal buffer exchanges before cells are added.
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Configure the plenum wash settings in the Buffer Wash Before Cell Addition dialog.

Figure 5-3: Buffer Wash Before Cell Addition settings dialog
The Buffer Wash Settings section allows you to:

Specify theNumber of wash cycles using external buffer, Volume dispensed, Dispense
tip height, and Dispense speed.

Choose to Exchange plenum fluid with internal buffer, and specify theNumber of
cycles the fluid is exchanged.

Viewing Plate Definitions

The information listed for plate definitions is provided for reference only and cannot be
edited. Volumes can be used to calculate aspiration and dispense parameters. The
Manufacturer's part number is listed for ordering purposes.
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Figure 5-4: Sample View Plate Definition Dialog

CAUTION! Use only approved cell and compound boats or damage to the pipettors
could occur.

CAUTION! Fill the boat or plate with adequate volume. Inadequate volume can cause
the pipettor head to aspirate an air and fluid mixture that can ruin an experiment by
dispensing air into the PatchPlate wells.

Setting Seal Test Voltage Levels

The seal test determines whether the cell is properly positioned over the hole and sealed in
the well. If the cell is not properly sealed as designated by the native filter settings, then the
values for that well are excluded from analysis.

Figure 5-5: Seal Test section of the Step 1 Tab
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To set seal test parameters:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Edit Setup Protocol dialog.

3. In the Step 1 tab in the Seal Test section, set these parameters:

Level 1: The holding level voltage for the seal test.

Level 2: The pulse voltage for the seal test.

Duration: The length in milliseconds of voltage application for the seal test. The duration
value can be in the range of 40 ms to 600 ms.

Time: The length of time in seconds to continue applying the seal test voltage
repetitions.

Wash after cell addition: Run one or more external buffer and amphotericin exchanges

after cells are added. Click to open the Buffer Wash After Cell Addition dialog to
configure the wash. See Setting Buffer Wash After Cell Addition on page 63 for details.

4. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.

Setting Buffer Wash After Cell Addition

In the Seal test section of the Step 1 tab, select theWash after cell addition check box to
run one or more external buffer and amphotericin exchanges after cells are added.
Configure the plenum wash settings in the Buffer Wash After Cell Addition dialog.

Figure 5-6: Buffer Wash After Cell Addition settings dialog
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The Buffer Wash Settings section allows you to:

Specify theNumber of wash cycles using external buffer, Volume dispensed, Dispense
tip height, and Dispense speed.

Choose to Exchange plenum fluid with amphotericin, and specify theNumber of
cycles the fluid is exchanged.

Obtaining Cell Access

You can set up to seven steps for the sequence of operations to obtain cell access.
To set cell access parameters:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Edit Setup Protocol dialog.

3. In the Step 1 tab in theObtain Cell Access section, set up to seven steps:

Figure 5-7: Seven Operation and Time(s) fields in the Obtain Cell Access Section
Each step can be configured as one of the following step types:

Check Resistance: Rerun the Seal Test and specify the duration in the range of 1 to 60
seconds.

Add Perforation Agent: Introduce the cell perforation agent into the plenum. This
operation has a fixed duration of 115 seconds.

Add Internal Buffer: Prime the plenum with internal buffer. This operation has a fixed
duration of 70 seconds.

Wait: Pause the experiment for 60 to 600 seconds.

Null Operation: Take no action. Used for undesignated steps in the series.

4. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.
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Step 2: Editing Native Filters
You can view filtering parameters for the hole test and set filtering parameters for the seal
test. Wells that do not pass native filter tests are excluded from data analysis.
To view or edit hole test and seal test parameters:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Setup
Protocol from the Setup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. Click the Step 2: Editing Native Filters tab, and then specify the following parameters:

PatchPlate Holes: The hole test filter measures for proper resistance levels between the
electrodes and the plenum for each well. Resistance that measures less than 1 MΩ or
greater than 10 MΩ indicates the well is blocked. Resistance that is too high might mean
there are air bubbles in the well. The hole test thresholds are pre-defined and cannot be
changed for PatchPlate quality control purposes. You can specify when a PatchPlate fails
by setting the percentage of wells blocked threshold. You can automatically stop the
experiment by selecting the Stop the experiment if the PatchPlate has failed check
box. When the Stop check box is clear, the experiment continues to run and a QC fail
message appears in the status bar.

PatchPlate Seals: The seal test filter measures that the cells are properly sealed on the
holes in the PatchPlate wells. When data files are acquired, the default definition for 'No
Seal' is defined as resistance that is less than 50 MΩ for SH pates or 20 MΩ for PPC
plates, or greater than 1500 MΩ for either SH plates or PPC plates. You can change these
settings for a given data file (ranging from 1 to 100,000 MΩ) to increase or decrease the
stringency of the native filters. You can specify when a PatchPlate fails by setting the
percentage of wells with no seals threshold. You can automatically stop the experiment
by selecting the Stop the experiment if the PatchPlate has failed check box. When the
Stop check box is clear, the experiment continues to run and a QC fail message appears
in the status bar.
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4. When you have finished configuring the parameters, click Next to go to the next tab, or
click Save to close the protocol editor. If the protocol is marked Read-Only, type a new
name for the protocol, and then click Save.
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Chapter 6: Creating a Channel Protocol

Channel Protocols control data acquisition before, during, and after compound additions for
ligand-gated or voltage-gated applications. The Channel Protocol parameters vary greatly
depending on the type of assay you are running, the cell line, or the ion-channel of interest.
Using the sample protocols, you can modify the parameters for developing an optimized
assay. In Assay Development Mode, you can run through Channel Protocol scenarios and
save the optimized assay protocol as a new protocol. After the Channel Protocol completes,
the Cleanup Protocol starts.
To create a Channel Protocol:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, in the Experiment
Mode section, if not already selected, select Single Protocol Mode.

2. In the Protocol section, select a Channel Protocol . See Data Acquisition and Review
Workspace on page 15 for details.

3. Click Edit to open the Edit Channel Protocol dialog.

4. Review the parameters in each of the protocol editor steps, and change parameters as
applicable for the current experiment.

5. Click Save to finish. If Save Protocol As Read-Only has been selected, change the
Protocol Name and then click Save.

Note: The single Channel Protocols are available for inclusion in a Multiple Channel
Protocol. See Creating Multiple Channel Protocols on page 93.

6
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Step 1: Specifying Scans, Fluid Transfers and Compound Additions
You define parameters for baseline scans in the Step 1: Specifying Scans and Compound
Additions tab of the Channel Protocol editor.

Specifying Scan Parameters

To set the parameters for scans:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the first tab window in the Edit Channel Protocol dialog, specify the following
parameters:

Figure 6-1: Edit Channel Protocol dialog

Number of Baseline Scans: The number of baseline scans (range 0 to 10) required for the
experiment. The baseline scan measures ion channel current before the addition of any
compound.

Delay Between Scans: The number of seconds between scans, including baseline and all
pre-compound and post-compound addition scans. Type the number of seconds
between scans required for the experiment.

Holding Level: The voltage applied before the pre-signal and after the command voltage.
Type the desired holding level voltage for the experiment.
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Liquid Junction Potential: The value you enter to correct for liquid junction potential
shifts. Calculate the value and type your result in millivolts in the Liquid Junction
Potential field. The value input in the Liquid Junction Potential Correction field will be
subtracted from the command voltage.

Note: Liquid-junction potentials (defined as the potential differences between two
solutions) occur at all boundaries between solutions of different compositions.
The IonWorks Barracuda System zeros all the voltage offsets that arise from
electrode to solution junction potentials and liquid-junction potentials during the
first portion of the experiment prior to the cell addition. However, the Liquid
Junction Potential is then at least partially removed by cell addition and occlusion
of the holes resulting in the command voltages being off by approximately the
value of the Liquid Junction Potential.

The final correction factor that is applied to compensate for these voltage-offsets
during cell recordings requires a user-defined value for the Liquid Junction
Potential Correction. The voltage-offset values (if significant) must be determined
empirically for each combination of external and internal solutions. This can be
determined by performing an experiment run with a particular solution pair with 0
mV input as the Liquid Junction Potential Correction. After the experiment run,
the value of the baseline current can bemeasured using user-defined metrics and
any voltage error can be determined using Ohms Law, the baseline current value
and the command voltage value. Generally these corrections areminor and 0 mV
can be used.

No Compound Additions: Run the baseline scan and complete the Channel Protocol
with no compound additions. When this check box is selected, the experiment concludes
after the last baseline scan completes. The compound additions, including the option to
record data simultaneously, are not available.

Record Data Simultaneously: Enable compound-triggered data acquisition for ligand-
gated assays. This option is available only if you clear the No Compound Additions check
box.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Set related parameters. For instructions, see:
Specifying Compound Additions on page 70
Specifying Aspirate Options on page 71
Specifying Advanced Aspirate Options on page 73
Specifying Dispense Options on page 74

Click Next to edit other Channel Protocol settings.
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Specifying Compound Additions

In the Compound Addition section you specify the parameters for compound additions in
the experiment. When more than one compound is added, the fluid levels in the well are
maintained with subsequent additions.
To set parameters for compound additions:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 1 tab in the protocol editor, in the compound additions section, specify the
following parameters:

Figure 6-2: Compound Addition Section of the Edit Channel Protocol Dialog

Select the Record Data Simultaneously check box to record data as the compound is
being added.

Pre-Trigger Duration: Type the time in seconds that data will be collected prior to
compound addition.

Post-Trigger Duration: Type the time in seconds that data will be collected after
compound addition.

Voltage During Addition: Type the voltage to be applied to the cell during compound-
triggered acquisition.
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Sample Period: Select the length of time for the data sampling period from the
Sampling Period field in milliseconds per sample.

Compound Incubation Time: Type the total number of seconds the system should wait
before the next scan. This value is the total time between scans and includes any time
specified for the Post-Trigger Duration. The value entered for the Compound Incubation
Timemust be greater than the Post-Trigger Duration value, plus an additional 5 seconds
for software processing time.

Number of Scans After Compound Addition: Specify the number of times data is
collected after each compound addition.

Delay Between Scans: The number of seconds between scans after each compound
addition.

Note: The Delay Between Scans is displayed here for reference only. The delay
value for all scans is set in the Scan and Fluid Transfer Parameters area.

4. (Optional) Click at far right of the section bar to add an additional compound, and
then specify parameters.

Note: Maximum number of compound additions is 10.

5. (Optional) Select an additional compound to delete, and then click at far right of
the section bar.

6. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify related parameters. For instructions, see:
Specifying Aspirate Options on page 71
Specifying Advanced Aspirate Options on page 73
Specifying Dispense Options on page 74

Click Next to edit other Channel Protocol settings.

Specifying Aspirate Options

In the Aspirate section of the Channel Protocol, specify aspiration methods for the
compound.
To set parameters for aspirating compound:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.
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2. Click Edit to open the Edit Channel Protocol dialog.

3. On the first tab window in the Aspirate section, specify the following parameters:

Figure 6-3: Aspirate Section of the Edit Channel Protocol Dialog

Select the Change Plate Before Aspirate check box if you want the system to pause the
experiment so that you can change the compound plate. When the system pauses, it is
safe to open the instrument cover and change plates. After changing the plate, click
Continue to resume the experiment.

Compound Source: Select the location on the process deck for the chosen compound:
Compound 1 or Compound 2. For three or more compound additions, replace the
compounds in the Compound 1 and Compound 2 positions on the deck and set
parameters as applicable.

Plate Type: Click the list and select themanufacturer and type of plate used for delivery
of the compound. If the plate you are using does not appear in the list, call Molecular
Devices technical support for help adding the plate to the list.

For detailed dimensions to use in calculating compound volumes, click to open the
View Plate Definition dialog.

Volume: Type the amount of fluid in microliters to be aspirated from the compound
plate well.

Barcode Position: Select the location of the barcode label on the compound plate: None,
Front, Back, Left or Right.

Note: If you selected Experiment Name > Set > Include Barcode, NONE cannot
be the selected barcode position. See Setting the Experiment Name on page 118.

Click Advanced to specify more detail for aspiration in the Advanced Aspirate dialog. See
Specifying Advanced Aspirate Options on page 73.
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4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify other related parameters. For instructions, see:
Specifying Advanced Aspirate Options on page 73
Specifying Dispense Options on page 74

Click Next to edit other Channel Protocol settings.

Specifying Advanced Aspirate Options

Set advanced parameters of the compound aspiration by clicking the Advanced button in
the Aspirate section of the Channel Protocol editor.
To set advanced parameters for aspirating compound:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 1 tab in the Aspirate section, specify the following parameters:

Figure 6-4: Advanced Aspirate Options Dialog
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Adjust the Tip Height to specify the volume in microliters to specify the level to which
the pipettor descends from the well bottom. The pre-defined value is 10 µL.

Adjust the Speed to specify the number ofmicroliters per second the pipettor aspirates.
The pre-defined value is 15 µL/s.

Select theUse Extra Aspirate check box to draw extra fluid from the compound plate
well. When this check box is selected, the Volume entry field is enabled. Type the
number of extra microliters per well to be aspirated in the Volume field.

Use the Extra Aspirate option to avoid dispensing air into the wells of the PatchPlate.
When Extra Aspirate is enabled, the pipettors dispense the initial compound volume to
the PatchPlate, then dispense the extra compound volume to the wash station.

Select theMix Fluid before Aspirate check box to configure the system to aspirate and
dispense compound in the compound plate before aspiration for delivery to the
PatchPlate. When this check box is selected, theMix Cycles andMix Speed fields are
enabled. Type the number ofmix cycles and the number ofmicroliters of fluid to be
aspirated and re-dispensed.

Select the Pre-wet Tips check box to instruct the system to pre-wet the tips of the
pipettors with compound before performing the aspirate operation. Make sure you
have adequate compound volume to cover this step.

Use the Pre-wet Tips option to reduce non-specific binding of sticky compounds in the
pipettor tips. When the Pre-wet Tips option is enabled, the pipettors aspirate an initial
volume of compound and dispense it to the wash station before aspirating the actual
volume and dispensing to the PatchPlate wells so that the binding occurs on the first
disposable aspirate cycle.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify related parameters. For instructions, see:
Specifying Aspirate Options on page 71
Specifying Dispense Options on page 74

Click Next to edit other Channel Protocol settings.

Specifying Dispense Options

Specify the details of the compound dispense operation in theDispense section of the
Channel Protocol editor. For each compound addition, the instrument maintains the fluid
levels in the wells for each new compound addition.
To specify dispense options:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.
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2. Click Edit to open the Protocol Editor.

3. On the Step 1 tab in the Dispense section, specify the following parameters:

Tip Height: Select Low, Med, or High for the height of the tip insertion into the well.

Speed: Type the number ofmicroliters per second that should be dispensed from the
pipettor.

Mix Fluids After Dispense: Select this check box to enablemixing.

Mix Cycles and Volume: Type the number ofmix cycles and the volume of fluid to be
mixed.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify related parameters. For instructions, see:
Specifying Aspirate Options on page 71
Specifying Advanced Aspirate Options on page 73

Click Next to edit other Channel Protocol settings.

Step 2: Specifying the Pre-Signal
You can adjust the pre-signal voltage for calculating leak correction before data is acquired.
The duration of the pre-signal is automatically calculated based on the selected sampling rate
and always consists of a total of 150 sample points.
To specify the pre-signal voltage:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.
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2. Click Edit to open the Protocol Editor.

3. On the Step 2 tab in the Pre-Signal Voltage Level section, specify the following
parameters:

In the Step 2: Pre-Signal Parameters tab,

Level 1: Type the initial voltage level.

Level 2: Type the voltage to step to after the Level 1 voltage. The Level 1 voltage and the
Level 2 voltagemust differ by a minimum of 5 mV and a maximum of 100 mV.

The Pre-Signal Preview Graph shows the waveform of the pre-signal voltage.

4. Do one of the following:

Click Save to save the settings and close the Protocol Editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.

Step 3: Specifying an Optional Conditioning Train
You can set up an optional voltage stimulus used to precondition the cell prior to applying
the command voltage. Conditioning trains are inserted after the pre-signal. Cell currents are
not recorded during the conditioning train, except for the last fewmilliseconds as needed to
establish a signal baseline. The voltage is held at a level set to follow the train for a specified
duration.
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Configuration of the conditioning train is similar to that of the command voltage allowing a
maximum of 10 intervals within the train, any sequence of which can be repeated. In
addition, the entire conditioning train can be repeated. You can set the conditioning train to
run before pre-compound addition scans and before post-compound addition scans, or only
before the post-addition scan.

Note: No data is recorded during the conditioning train.

The Conditional Train Preview shows the waveform of the conditioning train voltage. As
you specify the various parameters the graph updates to reflect your changes.
You can specify the following conditioning train parameters:

Interval Sequence-Conditioning Train on page 77

Conditioning Train Repetitions on page 78

Interval Settings on page 79

Interval Sequence-Conditioning Train

The conditioning train can be configured with up to 10 intervals. Intervals can be defined as
steps of constant voltage or voltage ramps.
To specify the parameters for a conditioning train:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
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Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 3 tab in the Interval Sequence - Conditioning Train section, specify the
following parameters:

Enable Conditioning Train: Select the check box to enable the conditioning train
configuration options. The conditioning train is an optional step.

Post Conditioning Train Level: Type the voltage level to apply after the conditioning
train and before the command voltage

Post Conditioning Train Duration: Type the length of time the post conditioning train
voltage level should be held before the command voltage is applied. Theminimum value
is 5 ms.

Apply Trains: Select the option to specify when to run the conditioning train.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify related parameters. For instructions, see:
Conditioning Train Repetitions on page 78
Interval Settings on page 79

Click Next to edit other Channel Protocol settings.

Conditioning Train Repetitions

You can specify the number and duration of conditioning train repetitions.
To specify conditioning train repetitions:
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1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 3 tab in the Conditioning Train Repetitions section, specify the following
parameters:

Enable Conditioning Train: Select the check box to enable the conditioning train
configuration options. The conditioning train is an optional step.

Apply Repetitions: Type the number of times the conditioning train should repeat
within the scan.

Minimum: Specify that the conditioning train repetitions should start one right after the
other with theminimum time between them. You can also choose the option to specify
the Start-to-Start Interval in milliseconds. The interval you specify must be greater in
length than theminimum interval.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Specify Interval Settings on page 79

Click Next to edit other Channel Protocol settings.

Interval Settings

You can specify the pulse for up to ten intervals in the waveform.

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit.

3. On the Step 3 tab in the Conditioning Train Repetitions section, specify the following
parameters:

Interval Duration: Type the duration of the interval, up to 5000 milliseconds.

Starting Level: Type the voltage to step to at the start of the interval. The range is –
200 mV to +200 mV.

Ending Level: Type the voltage to step to at the end of the interval. The range is –200 mV
to +200 mV. If this voltage is the same as the Starting Level voltage then the single
voltage is maintained for the duration of the interval as a voltage step. If it is different
from the Starting Level then the voltage increases or decreases regularly throughout the
interval to deliver a voltage ramp.
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4. (Optional) Click at far right of the section bar to add an interval pulse, and then
specify parameters.

5. (Optional) Select an interval pulse tab to delete, and then click at far right of the
section bar.

6. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.

Step 4: Specifying the Command Voltage
You can configure the sequence of voltage steps and ramps delivered to the PatchPlate
wells.
The Command Voltage Preview Graph, under the Step 4 tab of the Channel Protocol editor,
shows the waveform of the command voltage. As you specify the various parameters, this
graph updates to reflect your changes.
Data acquisition for voltage-gated assays occurs only during delivery of the command
voltage. You can configure a conditioning train to run prior to the command voltage. See
Step 3: Specifying an Optional Conditioning Train on page 76.
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The command voltage can each be configured with up to 10 "intervals." Intervals can be
defined as steps of constant voltage or voltage ramps. You can also configure duration steps
by stepping the interval time.
One step interval within the command voltage can have a "family" of voltages configured.
This family of voltages is defined with a shift in the specified voltage in that interval for a
given number of steps. Under these conditions, the command voltage is repeated as many
times as there are family steps configured, with the command voltage changing in that
interval as defined for each subsequent iteration of the sequence.
The entire command voltage can be configured to repeat a set number of times.
You can configure the following Command Voltage parameters:

Interval Sequence Acquisition Setup on page 81

Command Voltage Repetitions on page 82

Interval Settings Command Voltage on page 82

Interval Sequence Acquisition Setup

You can specify the acquisition setup levels, repetitions and steps in the command voltage
scan.

Figure 6-5: Sample Interval Sequence - Command Voltage Section
To set Acquisition Setup parameters:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 4 tab in the Interval Sequence Command Voltage section, in the Sample
Period field, type the length of time for the data sampling period in milliseconds per
sample.

4. Do one of the following:
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Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.

Command Voltage Repetitions

You can set the number of times the command voltage is applied during the sweep.
To set Command Voltage Repetition parameters:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 4 tab in the Command Voltage Repetitions section, specify the following
parameters:

Apply Repetitions: Type the number of times the entire command voltage should
repeat within the scan.

Minimum: Select this to specify that the command voltage repetitions should start one
right after the other with theminimum necessary time between them. You can also
choose the option to specify the Start-to-Start Interval in milliseconds. The interval you
specify must be greater in length than theminimum interval.

4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.

Interval Settings Command Voltage

You can specify up to ten pulses for one interval in wave form.
To set intervals for the command voltage:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit.

3. On the Step 5 tab in the Interval Settings section, specify the following parameters:

Interval Duration: Type the duration of the interval, up to 5000 milliseconds.

Starting Level: Type the voltage to step to at the start of the interval. The range is –
200 mV to +200 mV.
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Ending Level: Type the voltage to step to at the end of the interval. If this voltage is the
same as the Starting Level voltage then the single voltage is maintained for the duration
of the interval as a voltage step. If it is different from the Starting Level then the voltage
increases or decreases regularly throughout the interval to deliver a voltage ramp.

Enable Command Voltage Family: Select this check box to enable a command voltage
family for one of the step intervals. This family of voltages is defined with a regular
positive or negative shift in the specified voltage in that interval, for a given number of
steps. Under these conditions, the command voltage is repeated as many times as there
are family steps configured, with the command voltage changing in that interval as
defined for each subsequent iteration of the sequence.

Step Level by (mV): Type the number ofmillivolts to change the interval with each
repetition of the command voltage. To increase the interval, type a positive value in the
Step Level by (mV) field. To decrease the interval, type a negative value in the Step Level
by (mV) field.

Step Duration by (ms): Type the number ofmilliseconds to change the duration of each
repetition of the command voltage.

4. (Optional) Click at far right of the section bar to add an interval pulse, and then
specify parameters.

5. (Optional) Select an interval pulse tab to delete, and then click at far right of the
section bar.

6. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.
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Step 5: Specifying Sweep Repetitions
In the Step 5: Specify Sweep Repetitions tab, the sweep repetitions preview graph shows
the complete waveform specified in the previous steps including pre-signal, conditioning
train, and command voltages. The entire configuration can be repeated for the number of
times you specify with the Start-to-Start interval you define. In the Sweep Repetitions
section, specify the number repetitions for the complete sweep including pre-signal,
conditioning train, and command voltage.

To specify parameters for sweep repetitions, and to update the preview graph:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. On the Step 5 tab specify the following parameters:

Apply Repetitions: Type the number of times to apply the entire sweep.

Click theMinimum option to specify that the sweep repetitions should start one right
after the other with theminimum necessary time between them. You can also choose
the option to specify the Start-to-Start Interval in milliseconds. The interval you specify
must be greater in length than theminimum interval.

4. Change the preview graph by selecting one of the following options:

Sweep Display shows all the elements of a single sweep.

Continuous Display shows all repetitions of the sweep in the entire scan. The preview
graph changes in Continuous Display only if more than one repetition is specified.

5. Do one of the following:
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Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to edit other Channel Protocol settings.

Step 6: Specifying Metrics Parameters
In the Step 6: Specify Metrics Parameters tab, you define themathematical method for
reducing the data acquired from each well. IonWorks Barracuda® System Software comes
with pre-defined metrics for Offset and Resistance. In addition, you can define custom
metrics as part of the Channel Protocol.
Using theMetrics Editor in the Channel Protocol Editor, or theMetrics Editor in the Data
Analysis workspace, you can define simple or combined metrics. After they are defined,
thesemetrics can be named, saved, and imported into other Channel Protocols.

Setting Options for the Metric Preview Graph

To set options for theMetric PreviewGraph:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Channel Protocol Editor.

3. Go to the Step 6 tab and specify the following parameters:

Select the type of graph to display in the preview area.

Select Command Voltage for voltage-gated assays.

Click in the graph to insert a labeled vertical marker as a time reference.
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4. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to view Channel Protocol settings.

Creating a New Metric

User-defined metrics are named and saved with the Channel Protocol. If you define a new
metric, it is named and saved with the Channel Protocol you are currently editing.
To view the parameters defined for any metric in the User Defined Metrics list, click the name
of themetric. The fields in theMetric Editor display the selected metric settings.
Select a Graph as a reference for establishing the region of interest in each scan. Click in the
graph to display the time value for the selected point.
To define a newmetric:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Channel Protocol Editor.

3. Go to the Step 6 tab in theMetric Editor section.

4. Name themetric settings by typing identifying text in theName field. If you are
importing a metric at a later time, this is the name you select to import the settings to
your Channel Protocol.

5. Select a Scan Type:

Command Voltage for voltage-gated assays.

Compound Addition for ligand-gated assays.

6. In the Region Reduction field, click to define themethod used to aggregate data. Define
one or two reductions depending on themetric type, simple or combined. Select the 1st
Reduction or 2nd Reduction option to view or edit each reduction. Reductions are
applied to the selected region only.

7. In the Reduction field, define the selected time range for the calculated metric.

Click Entire Signal for the entire duration of the sweep.

ClickWindow to set a time range selected from the available data by typing values in the
From and To fields.
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8. In the Combine Reduction field, click a method to combine the values from the two
reductions resulting in one output value. If defining two reductions, select a method to
combine the values from the two reductions, resulting in one output value. Formulas
used to calculate combined reductions are displayed when themethod is selected.

Note: Reverse the selections in the Reduction 1 and Reduction 2 fields to invert
the values in the formula.

9. Click the option to Apply Metrics to Sweep.

Last Sweep: Applies themetric to themost recently acquired sweep data.

Sweep: Sweeps are listed by sequence number. Select the number that corresponds to
the sweep of interest.

All Sweeps-For Export Only: Because a metric can be applied to only a single set of data,
you cannot reviewmultiple sweeps in the Data Analysis workspace. This option is
available for exported data only.

10. Select the Automatically Export Metric check box to generatemetric data files
automatically upon completion of the Channel Protocol. For information on configuring
automatically exported metrics, see Automatically Exporting Metrics Data on page 88.

11. Click Save to save the named metric settings with the Channel Protocol.

12. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to view Channel Protocol settings.

Importing a Metric

Saved metrics from Channel Protocols can be imported into new Channel Protocols for
reuse.
To import a saved metric setting file:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Channel
Protocol from the Channel Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit.

3. On the Step 6 tab in the User Defined Metrics section click Import.
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4. In the User Defined Metrics section of theMetrics Editor, click Import.

5. Browse to the folder that contains the Channel Protocol with themetric you want to
import.

6. Select themetric setting name from the file name list.

7. Click Open. Themetric shows in the list of User Defined Metrics available.

8. Select themetric name in the list to display themetric settings in theMetric Editor fields.

9. If applicable, change the settings for themetric, and type a new name in theName field.

10. Click Save to retain thesemetric settings with the current protocol.

11. Do one of the following:

Click Save to save the settings and exit the protocol editor. If the protocol is marked
Read-Only, type a new name for the protocol, and then click Save.

Click Next to view other Channel Protocol settings.

Automatically Exporting Metrics Data

Every Channel Protocol includes the option to automatically export data upon completion.
Export methods set up to execute automatically at the completion of a Channel Protocol are
not available for manual export. Manual export methods must be set up separately. For
information on manually exporting data, see Exporting Metrics Data on page 143.
User-defined metrics set up to export automatically can be imported to other Channel
Protocols, or used for manually exporting from a saved set of experiment data.
To automatically export metrics when the Channel Protocol completes:

1. Edit, import, or create your metric in the Channel Protocol Editor. For instructions, see
Step 6: Specifying Metrics Parameters on page 85.
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2. Check the box labeled Automatic Export Metrics at the conclusion of the Channel
Protocol.

3. Click Configure Metric Export to open the Export Metric dialog.

4. Select the data set to include in themetric export: Channel Protocol scans only or Hole
Tests, and seal test and channel protocol scans.

5. Select the Results Format:

Plate format inserts results in a spreadsheet with a separate data set for each scan in a
format that duplicates the well layout: rows A-P, and columns 1-24.

Column Sorted by Row format lays out the results for each well in a descending order by
row, A1, A2, A3... descending to P24, with scan results arranged in the columns from left
to right across the spreadsheet.
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Column Sorted by Column format lays out the results for each well in a descending
order by column, A1, B1, C1... descending to P24, with scan results arranged in columns
from left to right across the spreadsheet.

6. Select themetric you named and defined from the list ofAvailable User Metrics.

7. Click to move the selected metric to the Selected User Metrics field.

8. Check the boxes to include or exclude footer data. Footer data includes:
A key to the column names for included scans, sweeps, and metrics.
A key to non-numeric results: HB-hole blocked, NS-no seal, FO-filtered out, MR-manually
rejected.
Definitions for metric setting values and conditions.
Protocol information including:

Setup Data File Name

Channel Data File Name

Date/Time (local)

Date/Time UTC

Setup Protocol Name

Channel Protocol Name

9. Check the box to include or exclude predefined metrics including basic voltage offset
values and resistance values.

10. Select theMetrics Order Dataset by Scan-then-Metric values (S1_M1, S1_M2, S1_M3...)
or Metric-then-Scan values (M1_S1, M2_S1, M3_S1...).

11. If needed, browse to specify the path to the folder for your exported metrics data in the
Export Metric field. The default path setting is
C:\Users\AdminUser\Documents\Molecular Devices\IonWorks Barracuda\Export.
Note: If you have an invalid Export Metric path entered, such as to a USB flash drive that
has been removed, the software automatically exports the data to the default location
C:\Users\AdminUser\Documents\Molecular Devices\IonWorks Barracuda\Export.

12. Type a name for the exported metric data file in theMetric File Name field. IonWorks
Barracuda® System Software automatically creates a file for the exported metric data
named with the experiment-name appended with themetric file name you type.

13. Select a file format from the File Format field: CSV for comma-delimited data, or TXT for
tab-delimited data.

14. Click OK. The data exports immediately to your selected folder.

15. To view the exported data, click File > Open Exported Data Folder and select from the
list of exported data files.
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Deleting a User-Defined Metric

To delete a user-defined metric from a Channel Protocol:

1. Select the Channel Protocol that includes the saved metric from the Channel Protocols
field.

2. Click Edit to open the Channel Protocol Editor.

3. Select the tab for Step 6: Specify Metrics Parameters.

4. Click the name to select themetric you want to delete.

5. Click Delete. Themetric settings are removed from the Channel Protocol you are editing.

Modifying a Channel Protocol in Assay Development Mode
When you want to optimize a new type of assay, you can open a pre-defined Channel
Protocol from Molecular Devices, and then optimize the sample assay using Assay
Development Mode.
To modify a pre-defined Channel Protocol in Assay Development Mode:

1. Select a Setup Protocol from the list of saved protocols.

2. Select a Cleanup Protocol from the list of saved protocols.

3. From the list of pre-defined Channel Protocols, select the Channel Protocol that most
closely matches the assay for which you would like to optimize.

4. To preview the parameters for the pre-defined protocol, click View.

5. To make changes before running the Channel Protocol, click Edit. The Edit Channel
Protocol dialog appears.

6. Make any necessary changes to the parameters listed for the Channel Protocol.

7. If the Save Protocol As Read Only check box is selected, change the Protocol Name,
then click Save. If the Save Protocol As Read Only check box is not selected, click Save.
The Edit Channel Protocol dialog closes.

8. In the Data Acquisition and Reviewworkspace, in the Experiment Mode section, select
Assay Development Mode.
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9. Click to start the assay.
The Add Experiment Notes dialog appears.

10. Type your experiment notes and then click Continue. See Adding and Viewing
Experiment Notes on page 121.
The instrument runs through the Setup Protocol and the Channel Protocol and then
pauses. The Assay Development dialog appears.

11. Click to review Channel Protocol data in the Data Acquisition and Review
workspace. The plate view, Fixed Well View, and Floating Well View functions are all
active for your data review.

12. Click to return to the Assay Development dialog.

13. Choose how to continue. Choices include: Edit selected Channel protocol, Run
protocol, or Run cleanup protocol, which finishes the Assay Development process.

To edit a Channel Protocol, select the protocol name from the list, and click to
open the Edit Channel Protocol dialog. Continue with step 16.
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To run a Channel Protocol, select the protocol name from the list, and click to run
it. When the Assay Development dialog returns, repeat steps 13 to 15.

To finish Assay Development, click . The selected Cleanup Protocol runs to end the
experiment.

14. Make any adjustments to the parameters, and then click Save.

15. If the protocol you edited was marked Read-Only, then type a new Protocol Name and
click Save to return to the Assay Development dialog.

16. Click to run the edited Channel Protocol. When the Assay Development dialog
returns, repeat steps 14 to 16.

Creating Multiple Channel Protocols
Before creating a Multiple Channel Protocol, you must have several single Channel
Protocols. You can use the example protocols provided by Molecular Devices or create your
own. See Creating a Channel Protocol on page 67.
In the Data Acquisition and Reviewworkspace, in the Protocol section, when selected in the
Experiment Mode, the Channel Protocol field changes to theMultiple Channel Protocol
field. TheMultiple Channel Protocol field lists saved routines composed of a series of
Channel Protocols set to run consecutively.
The Selected Channel Protocols routine that you create in the Edit Multiple Channel
Protocol dialog can be saved for selection in theMultiple Channel Protocol field for
repeated future usage. When you run an experiment inMultiple Protocol Mode, you select
a savedMultiple Channel Protocol, along with a Setup Protocol and a Cleanup Protocol.
To create a Multiple Channel Protocol:

1. Start an experiment inMultiple Protocol Mode. For instructions, see Running an
Experiment on page 117.

2. Enter a name for theMultiple Channel Protocol you are creating in the Protocol Name
field.

3. Enter a description of this Multiple Channel Protocol in the Protocol Description field.

4. Check Read Only if you want to write-protect this Multiple Channel Protocol after it is
saved.

5. Specify the number of seconds to pause before continuing with the next Channel
Protocol in theDelay Between Protocols field.

6. (Optional) Edit a Channel Protocol from the Available Channel Protocols list. See Editing
a Channel Protocol in theMultiple Channel Protocol Editor on page 95.
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7. Select a Channel Protocols to run in the experiment from the Available Channel
Protocols list, and use the right arrow button to move the selected Available Channel
Protocol to the Selected Channel Protocols list. Themoved protocol appears last in the
list.

8. Repeat steps 6 and 7 as needed.

Figure 6-6: Edit Multiple Channel Protocol dialog

9. Use the up and down arrow buttons to reorder the Selected Channel Protocols list.

10. When you are finished creating your Multiple Channel Protocol, click Save. The Edit
Multiple Channel Protocol dialog closes.
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Editing a Channel Protocol in the Multiple Channel Protocol Editor

As you develop a Multiple Channel Protocol, if needed, you can edit an existing Channel
Protocol from within the Edit Multiple Channel Protocol dialog. The Channel Protocols in
the Selected Channel Protocols list are copies of the protocols from the Available Channel
Protocols list at the time they were added to the Selected Channel Protocols list. You can
only edit a Channel Protocol in the Available Channel Protocols list. Edits to a protocol in
the Available Channel Protocols list are independent of the copy in the Selected Channel
Protocols list.

Note: If you edit a protocol in the Available Channel Protocols list without changing
the protocol name, and move the edited protocol to the Selected Channel Protocols
list, the edits will automatically apply to all of the Selected Channel Protocols with the
same name.

To edit a Channel protocol in theMultiple Channel Protocol editor:

1. Select a Channel Protocol in the Available Channel Protocols list, and click Edit.

2. When the Edit Channel Protocol dialog appears, review the parameters in each of the
protocol editor tab steps, and change parameters as applicable for the current
experiment.

3. Click Save to finish. If Save Protocol As Read-Only has been selected, change the
Protocol Name and then click Save.

4. When the Edit Multiple Channel Protocol dialog appears, you can select the edited
protocol, and move it, using the right arrow button, from the Available Channel
Protocols list to the Selected Channel Protocols list. Themoved protocol appears last in
the list.

Note: When moving the edited protocol, if the protocol name is the same as a
protocol already in the Selected Channel Protocols list, you will be prompted
about whether you want the edited protocol to overwrite the existing protocol
with the same name.

5. Continue with step 7 in Creating Multiple Channel Protocols on page 93.

Deleting a Channel Protocol in the Multiple Channel Protocol Editor

As you develop a Multiple Channel Protocol from within the Edit Multiple Channel Protocol
dialog, if needed, you can delete a Channel Protocol that was moved to the Selected
Channel Protocols list.

Note: Channel Protocols in the Available Channel Protocols list cannot be deleted.
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To delete a Channel Protocol in theMultiple Channel Protocol editor:

1. Select a Channel Protocol in the Selected Channel Protocols list, and click Delete.

2. Continue with Creating Multiple Channel Protocols on page 93.
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Chapter 7: Creating a Cleanup Protocol

The Cleanup Protocol automates necessary maintenance steps between assays such as
washing the pipettor tips, washing the CellPettor, and washing the electrodes on the
Electrode-Plate.
For wash solution options, see the List of Approved Fluids on page 187.
To create a Cleanup Protocol:

1. In the Protocol section of the Data Acquisition and Reviewworkspace, select a Cleanup
Protocol from the Cleanup Protocol selection field. See Data Acquisition and Review
Workspace on page 15 for details.

2. Click Edit to open the Protocol Editor.

3. Review the parameters in the protocol editor. See Step 1: Specify Instrument Cleanup on
page 97.

4. When you have finished setting the parameters, click Save to save your changes and
close the protocol editor. If the protocol is marked Read-Only, type a new name for the
protocol, and then click Save.

Step 1: Specify Instrument Cleanup
In the Step 1: Specify Instrument Cleanup tab, set values for the type of solution and the
number of repetitions in the wash function.

The CellPettor is always washed after use.

The Plenum is always drained at the appropriate time.

To specify instrument cleanup parameters:

1. Select theWash plenum check box, and specify settings.

In the Soak Duration field, type the soak time in minutes (maximum 1440minutes/24
hours).

In theNumber of cycles field, type the number of times the soak cycle repeats
(maximum 5).

2. Select from the twoWash Tip Options.

7
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ClickWash Tips and Electrode-Plate to keep the tips on the pipettors, and wash both
the Electrode-Plate, and the tips.

Click Discard Tips to eject the tips from the pipettors after the Cleanup Protocol finishes.
Tips can be unloaded from the pipettor head and reloaded approximately nine times
before you must replace the tip rack with new tips.

3. Specify Tips Washing parameters.

Click theWash Source list and select the fluid source (A or B) for the first wash cycle.

Select the Enable Ultrasound Cleaning check box to sonicate during the cleaning
operation.

WARNING! Do not enable ultrasonic cleaning while using any flammable
liquid such as alcohol (EtOH) in the Source A or Source B bottles. Sonication
can cause flammable liquids to evaporate into the enclosure, posing a
potential risk of fire or explosion.

ClickWash Fluid 2 to specify a second wash operation.

Click theWash Source list and select the fluid source (A or B) for this wash cycle.

In theNumber of Strokes per Wash Cycle field, type the number of times the tip will be
dipped into the wash fluid in one wash cycle (range 1 to 20).

In theNumber of Wash Cycles field, type the number of times the entire wash cycle is
repeated. The wash station is filled and drained for each separate wash cycle.
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4. Specify Electrode-Plate parameters.Wash Fluid 1 cannot be disabled.

Click theWash Source list and select the fluid source (A or B) for the first wash cycle.

Click Enable Ultrasound Cleaning to sonicate during the cleaning operation.
Do not enable ultrasonic cleaning while using any flammable liquid such as alcohol
(EtOH) in the Source A or Source B bottles. Sonication can cause flammable liquids to
evaporate into the enclosure, posing a potential risk of fire or explosion.

ClickWash Fluid 2 to specify a second wash operation.

Click theWash Source list and select the fluid source (A or B) for this wash cycle.

In theDwell Time Per Wash Cycle field, type the number ofminutes to suspend the
Electrode-Plate in the wash fluid.

In theNumber of Wash Cycles field, type the number of times the entire wash cycle is
repeated. The wash station is filled and drained for each separate wash cycle.

5. Review the parameters in each of the protocol editor steps, changing them as applicable
for the current experiment.

6. Click Save. If the protocol is marked Read-Only, type a new name for the protocol, and
then click Save.
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Chapter 8: Preparing the Instrument for an Experiment
Run

After you have turned on the system computer and turned on the instrument, a number of
maintenance procedures must be followed to prepare the instrument for use.
To prepare the instrument for an experiment:

1. Empty all waste carboys.

2. Prepare the system fluids.

Fill the Source A and Source B carboys with wash solution.

Fill the internal buffer, external buffer, alcohol, and cell perforation agent bottles.

3. Run the Start of Day Flush and Rinse procedure to pump out alcohol from the system
and primewith assay solutions.

4. Load the required labware including a filled external buffer boat, PatchPlate, pipettor tips
(if not already loaded),

5. Prepare compound plates, if applicable, and load them at the compound stations.

6. Load a pipette into the CellPettor.

7. Prepare cell suspension, remove the cells to a conical tube, and load the tube into the
cell tube holder on the process deck.

Preparing the Fluid-Handling System
The fluid-handling system delivers source fluids to the process deck and pumps out waste
fluids.
Themost important steps in maintaining the fluid-handling system are:

Performing the End of Day Flush and Rinse on page 149 to sterilize the system by
flushing out saline solutions and replacing them with alcohol (50% EtOH).

Performing the Start of Day Flush and Rinse on page 105 to flush out the alcohol (50%
EtOH) and primes the system with saline solutions for the day's experiments

To prepare the instrument for use, you must empty the waste carboys, and fill each of the
source fluid bottles with theminimum working volume.
Fluids include:

External buffer (extracellular) is pipetted into the PatchPlate wells before the hole test is
conducted in the Setup Protocol. External buffer is also used as a rinse solution for the
CellPettor and is generally used in preparing compounds.

Internal buffer (intracellular) fills the plenum below the PatchPlate. Internal buffer is also
generally used in preparing the cell perforation agent solution.

8
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Cell perforation agent is most commonly a diluted solution of Amphotericin B and
internal buffer.

Wash solutions or solvents are used during protocols to rinse the pipettor tips and the
electrodes between experiments.

Alcohol (50% EtOH) is used for the End of Day Flush and Rinse procedure to sterilize the
equipment.

CAUTION! Do not use bleach on the surfaces of the instrument, or in the fluid bottles
or lines unless specified by a Molecular Devices procedure. Bleach can cause
discoloration of bottles, lines, and surfaces, and can cause damage that leads to
equipment failure.

Emptying Waste Carboys

Emptying the waste carboys is a simple, but critical task in preparing the instrument for daily
use. Two types of lines run from the carboy caps to the cabinet frame: fluid tubes and
overflow sensor wires. The lines must be disconnected from the cabinet frame using the
quick-connectors before you lift out the carboys.
Three waste carboys below the process deck must be emptied daily to prevent overflow:

Waste A

Waste B

Plenum/Cell Waste

WARNING! Always wear protective equipment and review all applicable
laboratory site regulations when handling cell solutions and cell waste. Always
follow the appropriate procedures for the biosafety level of the substance you are
handling.

To empty the carboys:

1. Locate the waste carboys in the fluidics drawer in the lower compartment of the
instrument cabinet. (For a diagram, see The Fluid Handling Components on page 40.)

2. Disconnect the fluid lines by pushing the connector down to activate the quick-release
mechanism.

3. For the sensor line, push themetal tab on the connector to activate the quick-release
mechanism.

4. Remove the carboys and unscrew the caps.

5. Dispose of the solutions as applicable. When disposing of cell waste, follow your
company procedures for handling biohazardous material.

6. Rinse the bottles as applicable.
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7. Replace the caps, and then return the carboys to their correct positions in the holding
drawer.

8. Reconnect the sensor and fluid lines by pushing each connector into its corresponding
connection joint until it clicks firmly into place. Make sure the fluid lines are properly
connected. If the fluid connections are not properly engaged, fluid lines cannot function
and the instrument enters a fault state.

Note: Two temporary waste bottles are used to capture small volumes prior to
pumping to the larger waste carboys. These temporary waste bottles do not require
maintenance and do not need to be hand-emptied.

Filling Buffer, Alcohol, and Cell Perforation Agent Bottles

Calculate theminimum fill volume for each source bottle by multiplying the number of
intended experiments by the volume used per experiment. Remember to add the dead
volume for each bottle:

Source Fluid Volume Used Per Experiment Dead Volume

Internal buffer 50 mL 30 mL for 500 mL bottle

External buffer 30 mL 60 mL for 1000 mL bottle

Cell perforation agent 38 mL 15 mL for 250 mL bottle

When preparing for an experiment run, make sure you also empty the waste carboys and fill
source bottles with wash solution.
To fill the internal and external buffer bottles, cell perforation agent bottle, and the alcohol
bottle:

1. Open the lower cabinet to locate the external buffer bottle and the alcohol bottle on the
upper rack. Locate the internal buffer bottle and the cell perforation agent bottle on the
rack beneath the PatchPlate station.

2. To disconnect each of the lines from the caps, push on themetal connector-joint tab to
activate the quick-releasemechanism.

3. Lift the bottles from their racks and remove the caps.

4. Rinse source bottles thoroughly with de-ionized water.

5. Fill the internal buffer source bottle with internal buffer. Adjust the final volume based
on the total number of intended experiment runs. Use the internal buffer solution
appropriate to the cell line or ion-channel you are recording.

6. Fill the cell perforation agent bottle with 100 µg/mL Amphotericin B in internal buffer.
(See Preparing Cell Perforation Agent on page 105.) Adjust the final volume based on the
total number of intended experiment runs.

7. Fill the external buffer bottle with the external buffer of choice. Adjust the final volume
based on the total number of intended experiment runs.
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The recommended external buffer is a balanced salts solution such as Dulbecco's
Phosphate Buffered Saline solution 1X with calcium and magnesium filtered with a
0.1 µm or 0.2 µm filter. External solutions used in conventional patch clamp
electrophysiology can also be used on the IonWorks Barracuda System, such as HEPES-
buffered balanced salts solution.

8. Fill the alcohol bottle with at least 100 mL of Ethyl Alcohol. Use reagent-grade Sigma-
Aldrich (Cat. R8382) diluted to a maximum 50% concentration.

9. Replace the caps and return the bottles to their correct positions on the holding rack.

10. Reconnect the fluid lines on each of the bottles by pushing the connector into the cap
until themetal tab clicks firmly into place.

11. Close the lower cabinet.

Filling Source Bottles with Wash Solutions

Source A and Source B carboys reside in the fluidics drawer behind theWaste A and Waste B
carboys. The caps face toward the rear of the instrument. These six-liter carboys hold wash
solutions or solvents used to wash pipette tips and the Electrode-Plate electrodes. You can
use two different wash solutions or solvents in each carboy, or you can fill them both with
the same fluid. See the List of Approved Fluids on page 187 to determine whether your wash
solution is acceptable.

CAUTION! Do not use bleach on the surfaces of the instrument, or in the fluid bottles
or lines unless specified by a Molecular Devices procedure. Bleach can cause
discoloration of bottles, lines, and surfaces, and can cause damage that leads to
equipment failure.

To fill the source bottles:

1. Locate the source bottles in the lower compartment of the Barracuda cabinet. Pull out
the holding rack to access the source bottles located in the rear of the drawer.

2. Disconnect the fluid lines by pushing on themetal connector-joint tab to activate the
quick-releasemechanism. Remove the bottles from the rack and remove the caps.

3. If applicable, rinse source bottles thoroughly with clean, de-ionized water.

4. Fill Source A and Source B bottles with your preferred wash solution.
The recommended wash solution is Ca/Mg-free external buffer of choice or Ca/Mg-Free
Dulbecco's Phosphate Buffered Saline 1X solution filtered using a 0.1 µm or 0.2 µm filter.

5. Replace the caps and return the source bottles to their correct positions in the holding
rack.

6. Reconnect each fluid line by pushing in the connector until it clicks firmly into place.
Make sure fluid lines are properly connected.
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Preparing Cell Perforation Agent

Cell perforation solution fills the plenum reservoir below the PatchPlate when Add
Perforation Agent is specified as a step in the Obtain Cell Access section of the Setup
Protocol Editor.
Amphotericin B (Sigma-Aldrich P/N A4888) is the recommended cell perforation agent for use
in the IonWorks Barracuda System. General guidelines are 100 µg of cell perforation agent for
each milliliter of internal buffer solution. Prepare the cell perforation solution according to
your lab guidelines, or follow these instructions.
To prepare Amphotericin B solution:

1. Dissolve 10 mg Amphotericin B in 360 µL DMSO.

2. Sonicate for fiveminutes. The solution must be uniformly clear without any precipitates.

3. Add the dissolved Amphotericin solution to 100 mL of internal buffer and vortex for one
minute. Do not filter.

Note: Amphotericin is light sensitive and degrades over time. Prepare fresh
Amphotericin for each series of runs to avoid degradation.

Performing the Start of Day Flush and Rinse
The Start of Day Flush and Rinse is a mandatory daily maintenance procedure that must be
run before any experiments are performed.
The Start of Day Flush and Rinse, initializes the system, flushes out the alcohol (EtOH) from
the End of Day Flush and Rinse and primes the system with assay solutions for the day's
experiment.
Before running the Start of Day Flush and Rinse procedure, the waste carboys must be
emptied and the source fluid bottles in the system must be filled. See Preparing the Fluid-
Handling System on page 101.
To perform the Start of Day Flush and Rinse:

1. Make sure waste carboys are empty and source bottles are filled with sufficient volumes
for the number of planned experiments. The Start of Day Flush and Rinse uses
approximately:

65 mL of internal buffer

20 mL of external buffer

6 mL of cell perforation agent

2. If not on the process deck from the last usage, place a clean, undamaged PatchPlate into
the PatchPlate nest, load a CellPettor pipette, and close the instrument door.
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CAUTION: A clean PatchPlate can be reused as long as it is in good condition with no
damage to any part of the consumable. Using a delaminated, chipped, marred, or
misshapen PatchPlate could result in damage to the Electrode-Plate, or instrument
errors.

3. In the shortcut bar, click , and then click Start of Day Flush and Rinse.

4. Click Continue. The Start of Day Flush and Rinse process runs for approximately five
minutes, and includes initializing the system and priming the fluid lines.

5. Remove the PatchPlate when the process stops and the instrument door unlocks.

Preparing the Process Deck
Before starting an experiment, the necessary plates or boats must occupy the correct
stations of the process deck. Each station has a sensor that detects the presence of a plate or
boat. If the process deck is not properly prepared, the instrument responds with an error
and the experiment cannot be completed.

Loading the Tip Rack

The tip rack station holds a tray pre-loaded with 384 disposable pipettor tips. Molecular
Devices black tips [PN 5011976] or clear tips [PN 5011975] are approved for use with the
Barracuda instrument. Black tips are recommended.
To reuse the tips, you can specify a tip washing step in the Tip Washing section of the
Cleanup Protocol Editor.

Note: Tips can be unloaded from the pipettor head and reloaded approximately nine
times before you must replace the tip rack with new tips.

To load the tip rack onto the process deck:

1. Unwrap a new set of disposable pipettor tips and remove the rack lid.

2. Open the glass door to the top of the instrument cabinet and locate the Tip Rack station.

3. Push back the spring-loaded indexer at the right rear corner of the tip rack nest.

4. Slide the tip rack into the plate nest and release the indexer.

5. In the shortcut bar, click , and then click Load Tips.

Loading the PatchPlate

A clean, uncontaminated PatchPlatemust be used for each experiment. Make sure you
specify the correct PatchPlate Type in the Setup Protocol. See Selecting the PatchPlate Type
on page 57.
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CAUTION! Make sure the PatchPlate is correctly registered at the left edge and the
front edge of the plenum nest with the A1 corner fitted against the plenum. Make
sure the PatchPlate is properly seated on all sides against the plenum base. Failure to
correctly insert the PatchPlate can lead to extensive damage to the Electrode-Plate.

CAUTION! Wear gloves when handling PatchPlates. To prevent contamination or
damage, always avoid touching themembrane on the bottom of the PatchPlate.

To load the PatchPlate:

1. Make sure the plenum is dry before loading a new PatchPlate. Avoid the cable on the left
side of the plenum and gently blot the plenum with a Kimwipes®Delicate Task Wiper or a
WYPALL®Wiper. See Plenum on page 34.
Do not touch the round, ground electrodes on the surface of the plenum. Doing so could
result in a build-up of oils on the electrodes. Oil buildup on the electrodes impedes their
functionality.

2. Unwrap a new PatchPlate without touching themembrane on the bottom of the plate.

3. Position the PatchPlate on the plenum with the A1well at the front-left corner.

4. Hold back the spring-loaded indexer at the right-rear corner of the plenum nest. (Figure
arrow 1.)

5. Slide the PatchPlate into the nest with the left flange of the plate against the edge and
the A1 corner fitted against the plenum. (Figure arrow 2.)

6. Make sure the left edge of the PatchPlate is fully registered against the left edge of the
plenum.

7. Make sure the front edge (closest to you) of the PatchPlate is fully registered against the
front edge of the plenum.
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8. Make sure the PatchPlate is properly seated against the plenum base. Gently press all
edges down to ensure the PatchPlate is lying flat without any lifting on any side. (Figure
3.)

9. Release the spring-loaded indexer. A light tap on the indexer after release helps to ensure
the PatchPlate is securely fitted at the A1 corner.

Reloading the PatchPlate after an Error

If an error message appears because the PatchPlate is not correctly positioned:

1. Remove the Electrode-Plate from the plenum and move it to the wash station.

2. Remove the PatchPlate from the plenum nest.

3. Re-insert the PatchPlate using the previous procedure (Loading the PatchPlate on page
106).

4. In the shortcut bar, click , and then click Initialize.

5. When the initialization process completes, continue with your experiment.

Loading and Filling the External Buffer Boat

Load a clean, dry external buffer boat into position in the external buffer station of the
process deck, and then fill the boat with buffer solution before the start of an experiment.

Note: Theminimum fill volume for the boat is 25 mL. Themaximum volume is 125 mL.

The recommended external buffer is a balanced salts solution such as Dulbecco's Phosphate
Buffered Saline solution 1X with calcium and magnesium filtered with a 0.1 µm or 0.2 µm
filter. External solutions used in conventional patch clamp electrophysiology can also be
used on the Barracuda system, such as HEPES-buffered balanced salt solution.
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To load the external buffer boat onto the process deck:

1. Unwrap a new buffer boat, or use a clean, dry boat.

2. Push back the spring-loaded indexer at the right-rear corner of the buffer boat station
nest.

3. Slide the boat into the plate nest and release the indexer.

4. Fill the boat with 25 mL to 125 mL of external buffer.
Less than 5 mL of buffer are used for each experiment, but theremust be adequate
volume to evenly wet the entire bottom of the reservoir. Extra volume protects against
changes in osmolality as buffer evaporates over the course of several hours.

Preparing Compound Plates

The protocol specifications in the software allow up to eight compound additions.
When preparing compound plates, you must use adequate volumes of compound, and you
must have at least one plate loaded in the Compound 1 or 2 station. If you do not have a
compound plate loaded in the station you specified in the Compound Addition section of the
Channel Protocol Editor, the system produces an error and the experiment cannot continue.

Note: For 384-well compound plates there is a one-to-one correspondence between
the compound wells and the PatchPlate wells. Any replicates must be set up in the
compound plate.

To ensure proper functioning of the pipettors, the compound plate you choosemust match
one of the types available in the Plate Type list in the Compound Addition section of the
Channel Protocol Editor:

BD-Falcon 384W Flat Clear PPN

Corning 384W Round Clear PPN

Greiner 384W Flat Clear PPN

Greiner 384W Conical Clear PPN

Greiner 384W Small Volume Clear PS

Greiner 384W Flat Clear PS

Greiner 384W Conical Deep Well Clear PPN

Nunc 384W Round Natural PPN

Matrix 384W Reservoir V-Bottom PPN

Axygen Low Profile Reagent Reservoir PPN

CAUTION! Fill the boat or plate with adequate volume. Inadequate volume can cause
the pipettor head to aspirate an air and fluid mixture that can ruin an experiment by
dispensing air into the PatchPlate wells.
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Loading Compound Plates

To ensure proper functioning of the pipettes within the compound plate wells, the
compound platemust match one of the types available in the Plate Type list in the
Compound Addition section of the Channel Protocol Editor.
To load a compound plate:

1. Prepare your compound and fill the compound plate before loading the plate onto the
process deck.

CAUTION! Fill the boat or plate with adequate volume. Inadequate volume can
cause the pipettor head to aspirate an air and fluid mixture that can ruin an
experiment by dispensing air into the PatchPlate wells.

2. Push back the spring-loaded indexer at the right rear corner of the Compound 1 or
Compound 2 nest.

3. Slide the compound plate into the plate nest and release the indexer. Make sure you
correctly position the A1well in the lower-left corner of the nest.

4. If applicable, repeat the steps for a second compound addition.

5. Note the position of the compound plate on the process deck (Compound 1 or
Compound 2 position).

6. Enter the plate position in the Compound Addition section of the Channel Protocol
Editor in the Aspirate section Compound Source list (PLATE 1/PLATE 2).

7. Click the specific plate type in the Aspirate section Plate Type field.

If you are using three or more compounds in an assay, follow these additional steps:

1. In the Aspirate section of the Channel Protocol Editor, make sure you select the Change
Plate Before Aspirate check box for your remaining compounds.

2. When the instrument pauses, remove the first two compound plates from the process
deck. Load two more compounds into the Compound 1 and Compound 2 positions.

3. Adjust the Compound Source and Plate Type selections in the Channel Protocol as
applicable for each of the additional compounds.

Preparing the Cell-Handling Components
The IonWorks Barracuda System uses the CellPettor subsystem for automated cell-delivery.
See Using the CellPettor on page 112. Alternatively, you can choose to bypass the CellPettor
and manually deliver cell suspension to the cell boat. See Delivering Cells Manually on page
113.
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WARNING! Always wear protective equipment and review all applicable
laboratory site regulations when handling cell solutions and cell waste. Always
follow the appropriate procedures for the biosafety level of the substance you are
handling.

Preparing Cell Suspension

Develop and use the cell preparation techniques optimized for the cell line and the ion
channel you are investigating. The following cell dissociation and suspension method is
provided for reference.
To prepare the cell suspension:

1. Pre-warm external buffer (such as DPBS) and cell dissociation agent (such as Versene,
Accutase, EDTA, or Trypsin) to room temperature.

2. Removemedia from the cell culture flask and rinse the cells with 10 mL of DPBS without
magnesium or calcium.

3. Add 2 mL to 3 mL of cell dissociation agent to lift the cells. Limit the time the cells are
exposed to the cell dissociation agent to ensure the health of the cells.

4. Observe the cells under a microscope for rounding up. Tap the flask to dislodge the cells.

5. Add approximately 10 mL of external buffer or media containing serum and triturate
gently.

6. Remove 10 mL of cells to a 15 mL conical tube.

7. Centrifuge the cells for 3 to 5 minutes at 1000 rpm.

8. Decant the supernatant and, if using media, remove as much media as possible.

9. Resuspend the cell pellet in 5 mL of external buffer. Triturate the cells using a standard
200 µL hand-pipettor 5 to 10 times or more, as applicable. Different cell lines require
different degrees of forcefulness and lengths of time for trituration.

10. Check the cell count. Molecular Devices recommends a cell density of 0.5×106 to 2×106

cells per mL. Use the higher range of cell densities for PPC plates. Optimize for your cell
line and ion channel of interest.

Note: Higher cell densities can result in reduced potency measurements for some
compounds due to non-specific binding of compound to excess cells. Examples
include hERG inhibitors.

11. Pipette the solution to a 15 mL conical tube. Theminimum working volume of cell
suspension is 5 mL. Themaximum fill volume for the conical tube is 10 mL.

Note: The conical tube can contain no more than 10 mL of cell suspension or it will
overflowwhen the aspirating straw is lowered into the conical tube.
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Next, load the conical tube into the cell tube holder for use with the CellPettor, or dispense
manually to the cell boat.

Using the CellPettor

The automated CellPettor follows the cell-delivery procedures that you specify in the Setup
Protocol.
To use the CellPettor to deliver cell suspension to the cell boat, you must perform each of
the following steps:

1. Load a 5 mL aspirating pipette into the CellPettor.

2. Load a clean cell boat into the cell boat station.

3. Harvest cells from their culture flask using a cell dissociation solution, wash cells to
remove cell media and cell dissociation agent, and resuspend cells to the correct final
density in a 15 mL conical tube. The conical tubemust contain a minimum of 5 mL of cell
suspension. See Preparing Cell Suspension on page 111.

4. Load the conical tube into the cell tube holder.

Note: The conical tube can contain no more than 10mL of cell suspension or it will
overflowwhen the aspirating straw is lowered into the conical tube.

CAUTION! The CellPettor cell-handling subsystem requires the use ofMolecular
Devices approved cell boats [Standard cell boat: Molecular Devices PN 5005252]. Using
labware other than theMolecular Devices approved cell boats could damage the
CellPettor.

Loading the CellPettor Pipette

The CellPettor subsystem must be loaded with a clean, standard 5 mL aspirating pipette.
Make sure you remove any cotton or other obstruction from the end of the pipette before
you use it in the CellPettor.

CAUTION! Cotton plugs, or obstructions of any type, must be completely removed
from the end of the aspirating pipette before it can be used in the CellPettor. Failing to
remove obstructions could damage the equipment.

To load the aspirating pipette into the CellPettor:

1. In the shortcut bar, click , and then click Load CellPettor Pipette.
The Preparing to load CellPettor pipette dialog appears.

2. If needed, now is the best time to click Quit. Once you click Continue, the instrument
pauses.
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When the instrument pauses, the Instrument Paused dialog appears, the door unlocks
and the pipettor robot moves into loading position.

3. If you click Terminate, you must run Utilities > Calibrate CellPettor before you can run
Utilities > Prime CellPettor, or run an experiment.

4. Open the instrument front door. Holding the pipette with the tip pointed toward the
ground, thread the pipette tip down through the tip sensor. (See arrow 1 in the
diagram.)

5. Slide the end of the pipette up through the threading forks and into the CellPettor tube.
Push the pipette upward with moderate pressure until you feel resistance. (See arrow 2
in the diagram.)

6. If applicable, hold the pipettemounting tube firmly and adjust the height of the pipette
up or down.

7. Close the instrument front door and click Continue to complete the loading.
Automatically, Initialize runs, then Calibrate CellPettor runs.

After loading the CellPettor pipette, continue with normal operations.

Delivering Cells Manually

If you aremanually delivering cell suspension to the cell boat without using the CellPettor
subsystem, make sure you click Do not use CellPettor in the software.
To deliver cell suspension to the cell boat manually:

1. Prepare your cells.

2. Select theDo not use CellPettor check box in the Setup Protocol.
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3. Select an approved cell boat from the Cell boat type field.

CAUTION! Use only Molecular Devices approved cell boats as listed in the
software. Using unapproved cell boats can damage the pipettors.

4. Load a Molecular Devices approved cell boat into the cell boat station.

5. Manually pipette the cell suspension to the cell boat.

Positioning the Electrode-Plate
Despite its heavy frame, the Electrode-Plate is a delicate piece of equipment that must be
handled with care at all times.
To avoid damage to the Electrode-Plate:

Do not touch the electrode pins or the pogo pins on the underside of the Electrode-Plate.

Keep the pogo pins dry.

Never immerse the Electrode-Plate in liquid of any kind. The electrode pins, however, can be
immersed in a bleach solution for rechloriding.

Always lift the Electrode-Plate using the handles on the top.

Always set the Electrode-Plate on a flat surface resting on its four stand-offs or on the Bleach
Boat.

Figure 8-1: Electrode-Plate

Position Component

1 Handles

2 Stand-offs
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CAUTION! To avoid damage to the Electrode-Plate:

Do not touch the electrode pins or the pogo pins on the underside of the Electrode-
Plate.

Keep the pogo pins dry.

Never immerse the Electrode-Plate in liquid of any kind. The electrode pins, however,
can be immersed in a bleach solution for rechloriding.

Always lift the Electrode-Plate using the handles on the top.

Always set the Electrode-Plate on a flat surface resting on its four stand-offs or on the
Bleach Boat.

Placing the Electrode-Plate on the Wash Station

When you are preparing the deck for experiments, place the Electrode-Plate in its home
location on the wash station. The stand-offs for the Electrode-Plate are designed to prevent
incorrect placement. Locate the A1-designated corner and position the Electrode-Plate with
the A1-corner in the left-front position.
During an assay, the pipettor-head moves the Electrode-Plate to the plenum base where the
pogo pins connect to the amplifiers, and the electrode pins are submerged in the PatchPlate
wells. During wash procedures, the pipettor-head moves the Electrode-Plate back to its
resting position at the wash station.
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Chapter 9: Running an Experiment

After the instrument is prepared with fluids and labware, you can run an experiment. See
Preparing the Instrument for an Experiment Run on page 101. By default the IonWorks
Barracuda instrument starts in Manual mode.
To run an experiment in Manual mode:

1. Set the experiment name. For instructions, see Setting the Experiment Name on page
118.

2. Select Setup, Channel, and Cleanup Protocols. For instructions, see Selecting Protocols
on page 118.

3. Select the experiment mode:

Assay Development Mode: During Assay Development Mode, the selected Channel
Protocol runs and pauses. At the pause, you can adjust parameters to modify the
Channel Protocol. The assay continues to pause after each iteration of the Channel
Protocol until you have optimized for your desired result. You can then save the
optimized Channel Protocol as a new protocol, which can be run later in Multiple
Protocol mode or Single Protocol mode. SeeModifying a Channel Protocol in Assay
Development Mode on page 47. If you are running in Assay Development Mode, follow
the prompts at the pause to run through iterations of the Channel Protocol, or complete
the experiment by proceeding to the Cleanup Protocol.

Multiple Protocol Mode: In Multiple Protocol mode, you can select multiple Channel
Protocols to run without interruption, except for specified pauses in operations to add
or change compound plates or to add cells. Experiments are conducted using one Setup
Protocol, any number of Channel Protocols, and one Cleanup Protocol.

Single Protocol Mode: In Single ProtocolMode, the selected protocols run without
interruption. One Setup Protocol, one Channel Protocol, and one Cleanup Protocol run
through to completion, except for specified pauses in operations to add or change
compound plates or to add cells.

4. Click the start button. The button color varies depending on the selected
mode (Multiple Protocol Mode or Single Protocol Mode).

9
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5. Add notes about the experiment in the Edit Experiment Notes dialog, and then click
Continue. To proceed without adding notes, click Continue.

Setting the Experiment Name
When you run an experiment, the acquired trace data is saved by default to a folder under
My Documents:
C:\...\My Documents\Molecular Devices\IonWorks Barracuda\Data\2010-08-13_001
The default folder is named with the format YYYY-MM-DD_[experiment number] where 001 is
the first experiment in the series. You can append more information onto the folder and file
name by setting the experiment name.
To set the experiment name:

1. In the Experiment section of the Data Acquisition and Reviewworkspace, click Set.

2. Click Include Custom and type any additional information into the text field that you
would like to append to the date format.

3. If you are using barcoded compound plates, you can append the barcode number to the
file name by clicking Include Barcode. The location of the compound plate barcodemust
be set in your Channel Protocol. When the experiment runs, the software pauses and
notifies you when it is time to enter the barcode.
Note: If Channel Protocol > Aspirate > Barcode Position is set to NONE, when the
experiment runs, no prompt to enter a barcode appears, and appending a barcode
number is excluded.

4. Click OK.

The acquired data is saved as a binary file that is not intended for editing. To export data for
editing, see Exporting Data on page 143.

Selecting Protocols
In the Protocol section of the Data Acquisition and Reviewworkspace, for each experiment,
you must select the following from the list of saved protocols:
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A Setup Protocol

A Channel Protocol (Single or Multiple)

A Cleanup Protocol

Generally, the Setup and Cleanup Protocols are used repeatedly to handle common
operations. The Channel Protocol you select should be specific to the type of assay you are
running. You can select from a list of saved Example protocols provided by Molecular
Devices. You can also select from the list of any edited protocols you have named and saved.
See Developing New Protocols on page 45.
You can select Multiple Channel Protocols to run consecutively if you run the experiment in
Multiple Protocol Mode. For more information, see Creating Multiple Channel Protocols on
page 93.
To select protocols:

1. From the Data Acquisition and Reviewworkspace, in the Protocol section, select a
protocol from the Setup Protocol field. To see the predefined parameters for the
selected protocol, click View.

2. In the Experiment Mode section, select Assay Development Mode,Multiple Protocol
Mode, or Single Protocol Mode. Depending on your selection, either the Single
Channel Protocol field, orMultiple Channel Protocol field appears in the Protocol
section.

3. Select a protocol from the Channel Protocol field. To see the predefined parameters for
the selected protocol, click View.
Note: For instructions on setting up and saving a re-usableMultiple Channel Protocol,
see Creating Multiple Channel Protocols on page 93.

4. Select a protocol from the Cleanup Protocol field. To see the predefined parameters for
the selected protocol, click View.

Saved protocols reside by default in theMy Documents folder:
C:\Users\your user name\Documents\Molecular Devices\IonWorks Barracuda
3.0\Protocols
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Selecting Multiple Channel Protocols
When you run an experiment inMultiple Protocol Mode, you can select multiple channel
protocols to run consecutively.
To select multiple channel protocols:

1. Start an experiment inMultiple Protocol Mode. For instructions, see Running an
Experiment on page 117.

2. Select additional Channel Protocols to run in the experiment from the Available Channel
Protocols list, and then click OK. The Channel Protocol selected in the Protocol area
appears first in the Selected Channel Protocol list.

3. Click Save to finish.
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Adding and Viewing Experiment Notes
Experiment Notes are available only in the Data Acquisition and Reviewworkspace. You can
add Experiment Notes before you run an experiment, and view the added Experiment Notes
after the experiment runs.

Adding Experiment Notes

Before you run the experiment, you can type or paste text notes.
To add notes to experiments:

1. Start an experiment. For instructions, see Running an Experiment on page 117

2. In the Add Experiment Notes dialog, specify which Electrode-Plate is used, type
experiment specific comments, and then click Continue. Click Cancel to terminate the
experiment. (See Electrode-Plate, see page 36.)

Viewing Experiment Notes

After you run the experiment, you can view the notes.
To view experiment notes:

1. In the Data Acquisition and Reviewworkspace, open a saved experiment.

2. In the plate view, select the tab. The View Experiment Notes dialog appears.
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Terminating an Experiment
You can stop an experiment in progress in two ways:

For non-emergency reasons, click in the Experiment Mode area of the software.
The instrument finishes the current action, ends the experiment, runs the cleanup
protocol if needed, and returns the instrument to the Ready status.

Note: The cleanup protocol needs to run only if the stop button is clicked before
any fluids dispense.

For emergency reasons, press the emergency stop button on the front panel of the
instrument.
The instrument stops abruptly, and enters a Fault state. To return the instrument to the
Ready state, you must initialize the instrument. See Resetting the Instrument after an
Emergency Stop on page 12 and Initializing the Instrument on page 169 for more details.

The Instrument Status is listed at the bottom of themain window.
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Chapter 10: Viewing Acquired Data

While an assay is running, scan results appear in the Data Acquisition and Reviewworkspace.
When the protocol completes, the results of the first scan are displayed in the plate view.
You can also view previously completed data sets by selecting a different experiment name.

Selecting Plate View or Extracted Value View
Plate view displays the trace graphs for the selected experiment and scan. Extracted Value
view displays the calculated extracted value, either for the Resistance or the Electrode Offset
depending on the scan.

Selecting an Experiment
Themost recent experiment's data is available by default in the Data Acquisition and Review
workspace. To view the data from another experiment, select the experiment name from the
Experiment Name list.

10
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Selecting a Scan
To view results of other scans for the same experiment, click in the list of scans to select the
scan you want to view. The data displayed in the Data Acquisition and Reviewworkspace
updates to the selected scan results.

Excluding Wells from Exported Data
Wells can be excluded manually from exported results.

To exclude a well:

1. In the plate view, right-click the well.

2. Click Exclude to manually reject the well.
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Applying Leak Correction
When you are reviewing data, you can turn Leak Correction on or off at any time by clicking
Data > Apply Leak Correction.

You can also turn leak correction on or off by clicking .

Rescaling Trace Graphs
There aremany options for rescaling the trace graphs for acquired data. You can rescale each
view separately, or you can apply the settings to all trace graphs. Scale settings are
remembered when you switch from scan to scan or plate to plate.
To rescale the trace graphs:

1. Click Data > Rescale Traces, or click .

2. Select the check boxes for Plate, Fixed Well, Floating Well as needed.

Plate applies the settings you choose to the Data Acquisition and Reviewworkspace
adjusting the scale of all the well graphs in the plate.

Fixed Well applies the rescale settings to the blue and green fixed well graphs on the
right side of themain screen.

Floating Well applies the rescale settings to the zoomed well view that opens when you
double-click a well in the plate view.
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3. Select the scale values to apply to the selection:

Manual Scale lets you enter minimum and maximum values for the X and Y axis to scale
the data according to your customized settings.

Auto Scale Entire Plate sets a uniform scale value using themaximum values from all
wells in the plate. When this setting is applied, it is easy to compare the relative response
values between wells.

Auto Scale Each Well sets a unique scale value for each well in the plate based on the
maximum values for each well. When this setting is applied, the response value for each
well is easier to detect and is unrelated to the scale values of the other wells.

4. Click OK to apply your settings.

Viewing Traces in Fixed Well View
The Fixed Well View panel uses trace graphs from wells selected in the Data Acquisition and
Reviewworkspace plate view or the Data Analysis workspace Plate Details. While viewing
traces, you can change selections, zoom in, view the voltage waveform, lock the Y-axis,
rescale the graphs, and switch focus between sweeps.

Selecting Traces in Fixed Well View

Trace graphs for two selected plate wells display in the Fixed Well View panemarked with a
blue or a green border.
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To select traces in Fixed Well View:

1. In the Data Acquisition and Reviewworkspace or the Data Analysis workspace, click a
plate well trace to select it. By default you are selecting with the blue border. The
selected well trace appears in the Fixed Well View pane with the blue border.

2. To change the green border selection, hold down the Alt key and click a second plate
well trace.

Zooming in on a Trace

Zoom in on any portion of a trace in Fixed Well View to show greater detail. Zoom works on
both trace selections at the same time. To return to normal zoom (100%), right-click
anywhere in the zoomed graph and click Zoom Out.
To zoom in on a trace:

1. On a selected Fixed Well View graph, click and drag the cursor to select an area you want
to zoom. A gray highlight marks the selection in progress.

2. Release themouse button. The trace graph zooms in on the selected area. Scrollbars
appear along the Y–axis and the X–axis. If you are viewing scans with a compound
addition, a green vertical line indicates the point in timewhen the compound was
introduced.

Display Selected Sweep in the Plate View

In the Data Acquisition and Reviewworkspace, when the Fixed Well View is displaying more
than one sweep, you can display the selected Fixed Well View sweep in the plate view.
To display the selected sweep in the plate view:

When the sweep numbers are different in the Fixed Well View and plate view, click .
The plate view sweep changes to match the Fixed Well View sweep.

Note: If the button is inactive, go to Edit > Preferences and clear the Auto Refresh on
Sweep Selection check box.
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Displaying the Voltage Waveform

The Fixed Well View can display the voltage waveform in a third pane below the selected blue
and green graphs.
To display the voltage waveform:

Click to display or hide the voltage waveform.

Locking the Y–Axis between the Two Graphs

In the Data Acquisition and Reviewworkspace, you can synchronize the Y–axes between the
blue and green graphs in the Fixed Well view by locking the Y–axis.

Click to lock or unlock the Y–axis.

Note: The Y–axis can be locked only in the Data Acquisition and Reviewworkspace.

Switching Focus Between Sweeps

When the Fixed Well View is displaying more than one sweep, the blue sweep is the sweep
with focus, or the sweep that is "on top." You can navigate between the sweeps by using the
keyboard arrow keys to shift the focus to another sweep. Click the up-arrow or the down-
arrow key on the keyboard to rotate the sweep that is currently "on top" of the stack of
traces.
You can also double-click a sweep to select it for focus.

Rescale Trace Graph

Scale settings are remembered when you switch from scan to scan or plate to plate.
To rescale the trace graphs:

1. Click .

2. Select the check boxes Fixed Well.

3. Select the scale values to apply.

4. Click OK to apply your settings.

Viewing Traces in Floating Well View
The Floating Well view zooms trace graphs from a well selected from the Data Acquisition
and Reviewworkspace. Any portion of the graph in Floating Well view can be zoomed to
show greater detail. To return to normal zoom (100%), right-click anywhere in the zoomed
graph and click Zoom Out. For compound-triggered acquisitions, the green vertical line
indicates the time at compound addition.



Chapter 10: Viewing Acquired Data

5011662 M 129

Displaying and Zooming a Well in Floating Well View

To display a well in Floating Well view:

1. Double-click any well with the left mouse button to display the selected well in Floating
Well view.

2. To zoom a selection, position the cursor in the top left corner of the area you want to
zoom.

3. Click and drag the cursor down and to the right to select an area.

4. Release themouse button. The Floating Well view is zoomed to display the selected
rectangular area.

Selecting Multiple Wells in Floating Well View

You can select multiple wells to view simultaneously in Floating Well view.
To select multiple wells to view in Floating Well view:

1. While pressing the Ctrl key, click two, four, eight, or twelve wells to view.

2. Double-click the last well to open the selected wells in Floating Well View.



IonWorks Barracuda® Automated Patch Clamp System

130 5011662 M

3. Maximize the window to enlarge the graphs.

Switching Focus Between Sweeps

When the Floating Well view is displaying more than one sweep, the blue sweep is the sweep
with focus, or the sweep that is "on top." You can navigate between the sweeps by using the
keyboard arrow keys to shift the focus to another sweep. Click the up-arrow or the down-
arrow key on the keyboard to rotate the sweep that is currently "on top" of the stack of
traces to the red color.
You can also double-click a sweep to select it for focus.
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Viewing Well Statistics
Well Statistics appear only in the Data Analysis workspace. You can viewwell statistics for
each metric by selecting themetric name in the Select Metricmenu. If the entry in the Value
column is NA, the statistic is not applicable to the scan.
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Chapter 11: Analyzing Data

TheData Analysis workspace provides views that summarize responses and statistics based
on the experiment type. You can perform basic analysis of the acquired data using metrics,
filters, and summaries, and then export your results for further analysis. IonWorks
Barracuda® System Software offers several data analysis methods:

Using metrics, data can be reduced to a single value.

Using filters, data that is not useful can be eliminated from results.

Using summaries, hit criteria can be refined to narrow remaining results.

The first step when analyzing data is to select the completed experiment name from the
Experiment Name field to display the data in the Plate Details area.

Using Metrics in Data Analysis
IonWorks Barracuda® System Software provides an editor for setting up metrics for analysis
of acquired data. When metric settings are created, they are named and then saved with the
Channel Protocol. In general, one value is output per well and per sweep for themetric.
To edit a metric while viewing data:

1. Click to open themetric editor. Make changes as applicable.

2. Save themetric settings. If you do not want to overwrite the previous settings, enter a
new name before saving themetric.

To create and save a metric while developing a Channel Protocol, follow the instructions for
Creating a NewMetric on page 86.
Metric data can be automatically exported to your preferred file location upon completion of
the Channel Protocol. To configure a metric for automatic export, see Automatically
Exporting Metrics Data on page 88.
You can also import saved metric settings from other Channel Protocols for reuse. To use
saved metric settings in another protocol, follow the instructions for Importing a Metric on
page 87.

Adjusting Native Filters
In the Data Analysis workspace, you can adjust the parameters for the seal test to increase
or decrease the "No Seal" definition for your selected plate.
PatchPlate Holes: The hole test filter measures for the resistance between the Electrode-
Plate electrodes and the plenum ground electrodes for each well. Resistance that measures
less than 1 MΩ or greater than 10 MΩ is reported as "blocked." Resistance that is too high
might mean there are air bubbles in the well. The hole test thresholds are pre-defined for
PatchPlate quality control purposes and cannot be changed.
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PatchPlate Seals: The seal test filter measures that the cells are properly seated over the
holes in the PatchPlate wells. When data files are acquired, the definition for "No Seal" is
defined as resistance that is less than 50 MΩ for SH or 20 MΩ for PPC, or greater than
1500 MΩ for either SH or PPC. You can change these settings for a given data file (ranging
from 1 to 100,000 MΩ) to increase or decrease the available data from the plate.
To change the pre-defined values used for the seal test:

1. Click , and then type new values in the less than and the greater than fields.

2. Click Save.

Defining Filters to Analyze Data
Filters are used to reduce the number of wells included in exported data for the selected
experiment. Filters are generally applied after metrics to exclude bad data and reduce the
number of exported wells.

Click in the Data Analysis workspace.

To define a new filter for the protocol:

1. If you have already saved one or more filters for this protocol, click the Filter # field
buttons to increment to a new filter number.

2. Type a description of the filter in theName field.

3. Select parameters to apply to the plate data.

Select one scan and onemetric for a simple filter.

Select two scans and onemetric for a comparative filter. Select a method of comparison
for the two scans. Check that the formula displayed agrees with your intended
comparison method.

4. Select a condition from theDiscriminator field.
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5. Type a numeric Threshold Value for the results.

6. Click Save.

To apply the filter to the plate data, in the On/Off Filter Control area, click the button with
the appropriate filter number to toggle the filter on or off.

Defining Summaries to Analyze Data
Summaries are used to refine the selection of hits included in exported data for the selected
experiment. Summaries are generally applied after metrics and filters to further narrow the
criteria for exported data.

Click in the Data Analysis workspace.
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To define a new summary for the experiment data:

1. If you have already saved one or more summaries for this protocol, click the arrow
buttons to increment to a new summary number.

2. Type a description of the summary in theName field.

3. Select parameters to apply to the plate data.

Select one scan and onemetric for a simple summary.

Select two scans and onemetric for a comparative summary. Select a method of
comparison for the two scans. Check that the formula displayed agrees with your
intended comparison method.

4. Select a condition from theDiscriminator field.

5. Type a numeric Threshold Value for the results.

6. Click Save.

To see statistics for all saved summaries, click .
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Viewing Associated Protocols
While an experiment is running, you can view acquired data for each scan as it progresses. If
there is no experiment in progress, you can review the acquired data for other experiments
in the Data Acquisition and Reviewworkspace by first selecting the experiment name.
To view the protocol parameters for a plate with acquired data:

1. Select the experiment name from the Experiment Name field. The data for the selected
data set loads in the plate view.

2. Click the Associated Protocols shortcut from the buttons on the left.

3. After the summary window appears, select the tab for the Setup, Channel, or Cleanup
Protocol to display the summary details.

To print the summary, click and follow the prompts.

To copy the summary to the clipboard:

1. Click . The summary data is copied to the clipboard.

2. Paste the data into your preferred application.
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Chapter 12: Managing File Locations

The IonWorks Barracuda System produces many data files of different types including:

Raw plate data acquired during experiments

Export data after metrics or filters are applied

Export trace (curve) data collected for each well

Saved Setup, Channel, and Cleanup Protocols

Saved metric settings

Default Folder Locations
To manage this data, you can use the default folders created with the software installation,
or you can set your own. If you change the default locations, the software retains the new
location and subsequently saves your data there.

The root directory is:
C:\Users\<your user name>\Documents\Molecular Devices\IonWorks Barracuda\...

By default, files are saved in the applicable Documents location for your operating system in
one of three folders:

\Protocols:
When you initially create a protocol, before it is associated with an experiment, the file is
saved in the Protocols folder as
protocol name.protocol type.ibp.

\Data:
The data folder contains plate data acquired during assays, as well as protocols after
they are associated with an experiment. Whenever an experiment is run, a new folder is
created with the experiment name to hold all of the various experiment data files. If you
ran the protocol named Test-Protocol99 on October 31, 2012, and named the
experiment My-Experiment99, the acquired data would be saved in
...\Data\2013-01-31_001-MyExperiment99\

\Export:
The export folder holds both manually and automatically exported metric results, and
exported trace data. Metric result files and trace data files can be custom-named, or can
default to the experiment name.

Note: In the softwaremenu, click File > Set Default Folders to view the last five saved
file paths for \Protocols and \Data.

For more information about naming experiments, see Setting the Experiment Name on page
118.

12
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Organizing Data
Every type of data produced by the IonWorks Barracuda System can be saved in a unique
location by individual users. Because there aremany related data types, you might want to
establish and follow conventions for creating folders and saving files so that data, export
files, saved metric settings, and protocols are easy to locate later.

Changing the Default Protocols Folder

By default, the IonWorks Barracuda® System Software stores saved protocols in these
locations:

C:\Users\<your user name>\Documents\Molecular Devices\IonWorks Barracuda\Data
You can create folders to separate the data from different assay types, different dates, or
different users.
To create a new folder for protocols:

1. Click File > Set Default Folders.

2. In theDefault Folders dialog, click the Browse button next to the Protocols folder and
then navigate to the desired parent folder.

3. ClickMake New Folder. A folder is created named New Folder.

4. Right-click the new folder, click Rename.

5. Type a new folder name, and then press Enter.

6. Make sure the new folder is selected and click OK.

7. When you return to the Default Folders dialog, click OK again.

Changing the Default Data Folder

By default, the IonWorks Barracuda® System Software stores acquired plate data in these
locations:

C:\Users\<your user name>\Documents\Molecular Devices\IonWorks Barracuda\Data
You can create folders to separate the data from different assay types, different dates, or
different users.
To create a new folder for data files:

1. Click File > Set Default Folders.

2. In theDefault Folders dialog, click Browse and navigate to the desired parent folder.

3. ClickMake New Folder. A folder is created named New Folder.

4. Right-click the new folder, and then click Rename.

5. Type a new folder name, and then press Enter.

6. Make sure the new folder is selected and click OK.

7. When you return to theDefault Folders dialog, click OK again.
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To set the location for exported metrics, see Exporting Metrics Data on page 143.
To set the location for exported trace data, see Exporting Trace Data on page 146.

Naming Conventions for Files
Within each of the default (or custom location) folders, files are saved with naming
conventions designed to help you identify them later. The default file location for saved files
is:

C:\Users\your user name\Documents\Molecular Devices\IonWorks Barracuda\[Data,
Protocols, or Export Folder]

Note: If the default folder locations for DATA, PROTOCOLS, or EXPORT are changed,
then the files are saved to the new folder locations.

For each experiment, the generic name for files is the date (YYYY-MM-DD) followed by the
series number for the experiment (_001, _002, _003...). If you give the experiment a custom
name, then the custom name is added to the generic experiment name:

YYYY-MM-DD-001-custom-experiment-name...
You can also add a barcode number to the experiment name. For more information about
naming experiments, see Setting the Experiment Name on page 118.
The examples in the following table include a custom experiment name.

Data Folder

Whenever an experiment is started, a folder is created within the \DATA folder that is named
by the experiment name. All series data and assay development data is subsequently saved
in the experiment-name folder.
The naming conventions for files in the \DATA\EXPERIMENT-NAME folder include:

Type of Data File Extension Naming Convention for Files

Raw plate data .ibe YYYY-MM-DD-001-custom-experiment-
name.protocol-type.ibe
where 001 is the series number for the
experiment. Changes to 002 when run again.

Raw plate data for Channel
Protocols

.ibe YYYY-MM-DD_001-custom-experiment-
name.Channel.1.ibe
where .1 is the saved data from the first iteration
run during assay development mode. Changes to
.2 when the assay is run again.

Protocols .ibp YYYY-MM-DD_001-custom-experiment-
name.protocol-type.ibp

Metrics settings .iba YYYY-MM-DD_001_custom-experiment-
name.metric-name.iba
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Type of Data File Extension Naming Convention for Files

Plate information .xml YYYY-MM-DD_001_custom-experiment-
name.PlateInfo.xml
Includes the original protocol name and other
experiment details.

Protocols Folder

When a protocol is saved and named, before it is associated with an experiment, it is saved
in the \PROTOCOLS folder along with themetric settings created with the Channel Protocol.
Files found in the \PROTOCOLS folder include:

Type of Data File Extension Naming Convention for Files

Protocols .ibp protocol-name.protocol-type.ibp

Metrics settings .iba protocol-name.iba

Export Folder

Exported metric results are saved by default in the \EXPORT folder. Naming conventions for
the exported data files include:

Type of Data File Extension Naming Convention for Files

Automatically exported
metric data

.csv or .txt YYYY-MM-DD_001-experiment-name.protocol-
type.ibp

Metric export data .csv or .txt experiment-name.csv or custom-name.csv

Trace data for each well .csv
or.txt

\well#-folder\YYYY-MM-DD_001-experiment-
name.scan-type.scan#.csv

Plate information .xml YYYY-MM-DD_001_experiment-
name.PlateInfo.xml
Includes the original protocol name and other
experiment information



5011662 M 143

Chapter 13: Exporting Data

Several types of data can be exported from the IonWorks Barracuda System in various
formats. Exported metric and trace data can then be imported into other software for
further analysis.
Types of data include:

Exported Metric Data: Data that has one or moremetrics applied to reduce it to a single
numeric value.

Automatically Exported Metric Data: Data that has one or moremetrics applied and is
output at the time the Channel Protocol completes.

Trace Data: Curve points for sampled data from individual wells acquired during scans.

Formats include:

CSV: Comma-delimited data

TXT: Tab-delimited data

Each set of data is saved in a folder designated at the time of export. The default folder
location for exported files is:

C:\...\Documents\Molecular Devices\IonWorks Barracuda\Export\

Exporting Metrics Data
After a protocol completes, data can bemanually exported from the results at any time. The
exported data can first havemetrics, filters, and summaries applied to produce themost
useful output.
Metrics can also be defined and set up for automatic export as part of the Channel Protocol
development. For information on automatically exporting data when a protocol completes,
see Automatically Exporting Metrics Data on page 88.
To manually export data:

1. Select the experiment namewith the data you want to export from the Experiment list.

2. ClickMetrics Export from the list of shortcuts on the left side of screen to open the
Export Metric dialog.

13
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3. Select the data set to include in themetric export: Channel Protocol scans only or
Channel Protocol scans plus hole test and seal test results.

4. Select the Results Format:

Plate format inserts results in a spreadsheet with a separate data set for each scan in a
format that duplicates the well layout: rows A-P, and columns 1-24.

Column Sorted by Row format lays out the results for each well in a descending order by
row, A1, A2, A3... descending to P24, with scan results arranged in the columns from left
to right across the spreadsheet.

Columns Sorted by Column format lays out the results for each well in a descending
order by column, A1, B1, C1... descending to P24, with scan results arranged in columns
from left to right across the spreadsheet.

5. Select themetric you named and defined from the list ofAvailable User Metrics.

6. Click to move the selected metric to the Selected User Metrics field.

7. Check the boxes to include or exclude footer data. Footer data includes:
A key to the column names for included scans, sweeps, and metrics.
A key to non-numeric results: HB-hole blocked, NS-no seal, FO-filtered out, MR-manually
rejected.
Definitions for metric setting values and conditions.
Protocol information including:

Setup Data File Name

Channel Data File Name

Date/Time (local)

Date/Time UTC

Setup Protocol Name

Channel Protocol Name

8. Check the box to Include predefined metrics including offset, hole test, and seal test
values.

9. Select theMetrics Order Dataset by Scan-then-Metric values (S1_M1, S1_M2, S1_M3...)
or Metric-then-Scan values (M1_S1, M2_S1, M3_S1...).

10. If needed, browse to select the folder for your exported metrics data in the Export
Metric field. The default path setting is C:\Users\AdminUser\Documents\Molecular
Devices\IonWorks Barracuda\Export.

Note: If you have an invalid Export Metric path entered, such as to a USB flash
drive that has been removed, you will be prompted to change the Export Metric
path entry to an existing directory.
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11. Type a name for the exported metric data file in theMetric File Name field. The exported
metric file is saved with the name you type. If you do not type a name, then the
exported metric file is named with the experiment name.

12. Select a file format from the File Format field: CSV for comma-delimited data, or TXT for
tab-delimited data.

13. Click Export. The data exports immediately to your selected folder.

Note: The Export button is not available when you are configuring metric export
options while editing a protocol.

14. To view the exported data, click File > Open Exported Data Folder and select from the
list of exported data files in the folder.
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Exporting Trace Data
Trace data (curve data) can be exported for individual scans and individual wells. When
traces are exported, coordinates for each sample point in the scan are included in each file.
This can quickly lead to enormous amounts of very detailed data, so make sure you are
selecting your trace data carefully before exporting.
To manually export trace data:

1. Select the experiment namewith the data you want to export from the Experiment list.

2. In the File menu, click Export Traces. The Export Traces dialog appears.

3. Select the data set (scan) to include in the traces export. To select more than one, hold
down the Ctrl key and click additional scans.

4. Click to move the selected data set to the Selected Datasets field.

5. Select the Available Wells to include in the traces export. To select more than one well,
hold down the Ctrl key and click additional wells.

6. Click to move the selected wells to the Selected Wells field.

7. If needed, browse to select a folder for your exported trace data in the Export Path field.
This directory path is automatically saved until changed. The default path setting is
C:\Users\AdminUser\Documents\Molecular Devices\IonWorks Barracuda\Export.
Note: If you have an invalid Export Path entered, such as to a USB flash drive that has
been removed, you will be prompted to change the Export Path entry to an existing
directory.

8. Type a folder name for the exported trace data files in the Traces Folder Name field.
IonWorks Barracuda® System Software automatically creates numbered folders for each
well within the designated folder.

9. Click Export to export the selected trace data, or click Advanced to set additional
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options.

To set Advanced options for exporting trace data:

1. Follow the instructions for exporting trace data, then click Advanced. The Advanced
Export Trace Data dialog opens.

2. Select the Include header check box to include header data such as scan type and
parameter values.

3. Select a file format from the File Format field: CSV for comma-delimited data, or TXT for
tab-delimited data.

4. Select an option from the File Creation Option field: One well per file, or one data set
(scan) per file.
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5. Click OK to close the Advanced Export Traces dialog and return to the Export Traces
dialog.

6. Click Export to immediately export the selected trace data.

7. To view the exported data, click File > Open Exported Data Folder and select from the
list of exported data files in the folder.

Note: If you have an invalid Export Path entered, such as to a USB flash drive that
has been removed, the software automatically exports the data to the default
location C:\Users\AdminUser\Documents\Molecular Devices\IonWorks
Barracuda\Export.
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Chapter 14: Completing Instrument Cleanup

Themost important step in cleaning up for the day is to run the End of Day Flush and Rinse.
See Performing the End of Day Flush and Rinse on page 149.
The following overview describes general procedures for instrument cleanup:

1. After the experiment is completed, discard unused solutions and rinse the cell boat, and
buffer boat with a 50% Ethyl Alcohol (EtOH) solution followed by DI water.

Note: Leave the last PatchPlate in place to use for the next Start of Day Flush and
Rinse run.

2. Unload the pipettor tips. You can do this manually using instrument utilities, or you can
include this step in the Cleanup Protocol using theDiscard Tips option. Skip this step if
you are planning to re-use the tips.

Note: Tips can be unloaded from the pipettor head and reloaded approximately
nine times before you must replace the tip rack with new tips.

3. Empty all of the fluid bottles under the process deck, except the Ethyl Alcohol bottle. See
The Fluid Handling Components on page 40.

4. Run Utilities > End of Day Flush and Rinse. See Performing the End of Day Flush and
Rinse on page 149.

5. Unload the CellPettor pipette.

6. Empty the waste carboys. The waste carboys must be emptied daily, either at the end of
the day or before the next day's operations. See Emptying Waste Carboys on page 102.

7. Check the overflow reservoir (sink) in the lower section of the instrument cabinet to the
right of the source carboys. The overflow reservoir is a catch for any spills that might
occur at the PatchPlate station or on the process deck. The capacity of the reservoir is
limited, so if any fluid is present, sponge the liquid out to prevent overflow of the
reservoir. If liquid is present, but you do not recall any spills, contact Molecular Devices
Technical Support.

Performing the End of Day Flush and Rinse
Themost important step in cleaning up for the day is to run End of Day Flush and Rinse.

Note: Make sure you leave in place a CellPettor aspirating pipette and a clean,
undamaged PatchPlate while End of Day Flush and Rinse runs.

14
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To perform the End of Day Flush and Rinse:

1. Make sure the Alcohol bottle is filled with at least 100 mL of 50% Ethyl Alcohol (EtOH).

2. Empty all of the fluid bottles under the process deck, except the Ethyl Alcohol bottle. See
The Fluid Handling Components on page 40.

3. In the shortcut bar, click , and then click End of Day Flush and Rinse. The
instrument door unlocks.

4. Make sure that a clean PatchPlate is loaded at the PatchPlate station and that the
CellPettor has an aspirating pipette loaded.

CAUTION! A clean PatchPlate can be reused as long as it is in good condition with
no damage to any part of the consumable. Using a delaminated, chipped, marred,
or misshapen PatchPlate could result in damage to the Electrode-Plate, or
instrument errors.

5. Click Continue. The End of Day Flush and Rinse operation runs for approximately five
minutes and sterilizes the equipment for the next day.

6. Empty the waste carboys after End of Day Flush and Rinse completes. See Emptying
Waste Carboys on page 102.

CAUTION! To maintain the system properly, you must run End of Day Flush and
Rinsewithin six days of system usage. Otherwise, on the seventh day, the system
with stop running experiments until you run End of Day Flush and Rinse.

Unloading the CellPettor Pipette
To remove the pipette from the CellPettor:

1. In the software, click Instrument > Utilities. TheManual Instrument Control dialog
appears.

2. Click Unload CellPettor Pipette. The instrument pauses operations and unlocks the
door to the process deck.

3. While firmly holding the cylindrical mounting tube on the CellPettor, pull down to loosen
and remove the aspirating pipette.

4. Replace the pipette, as needed.
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Chapter 15: Maintaining the Instrument

The IonWorks Barracuda System requires daily maintenance of the fluid-handling system
with the Flush and Rinse procedures. The instrument surfaces should be kept clean and dry
with extra care applied to the plenum surface and the Electrode-Plate.
For instructions on the Flush and Rinse procedures, see:

Performing the Start of Day Flush and Rinse on page 105

Performing the End of Day Flush and Rinse on page 149

Using Manual Instrument Controls
IonWorks Barracuda® System Software includes utilities that can be used to manually
control some functions of the instrument.
To open theManual Instrument Control window:

From the shortcut toolbar, click . TheUtilities dialog appears.

15
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Alternatively, click Instrument > Utilities.

Themost commonly used utilities for maintaining the instrument include the Start of Day
Flush and Rinse and the End of Day Flush and Rinse.
To use these utilities, see:

Performing the Start of Day Flush and Rinse on page 105

Performing the End of Day Flush and Rinse on page 149

Other commonly used utilities include:

Loading the CellPettor Pipette on page 112 or Unloading the CellPettor Pipette on page
150

Loading the Tip Rack on page 106

Flushing the Tip Washer Lines on page 165

If the instrument enters a Fault state, you might need to use the Initialize utility. Initialize
cancels any operation in progress, drains any fluids, if applicable, and re-calibrates all
components except the CellPettor. For more information, see Initializing the Instrument on
page 169.
The remaining utilities you might need to use occasionally, include:

Drain Plenum

Start Soak Plenum or End Soak Plenum (see Soaking the PlenumManually on page 167)

Wash Plenum (seeWashing the Plenum on page 166)

Calibrate CellPettor (see Calibrating CellPettor on page 182)

Prime CellPettor

Wash Electrode-Plate (see Step 1: Specify Instrument Cleanup on page 97)

Clamp Electrode-Plate or Unclamp Electrode-Plate

The instrument generally performs several of the less needed utility operations automatically
during normal use, either during the Flush and Rinse processes, or during assays. Several of
the less needed utility operations are provided in case of power outages or unforseen
circumstances that might require manual instrument controls.
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Disinfecting the Process Deck
The surface of the process deck should be periodically disinfected by wiping with 70%
isopropyl alcohol using a lint-free cloth. Follow this step by wiping again with 50% alcohol
(EtOH) using a lint-free cloth.
The glass door can be cleaned with standard glass cleaner.

Conditioning Replaceable Ground Electrodes (REGEs)

Note: This procedure does not apply to instruments equipped with the standard
plenum. See Plenum on page 34.

The purpose of the conditioning process is to equilibrate the REGE set to the internal buffer
that you will use in your next assay.
Before installation and use, the REGE set must be conditioned in the correct internal buffer.
For ideal equipment maintenance purposes, Molecular Devices recommends also
conditioning each REGE set at the end of the usage day using fresh internal buffer overnight.
After conditioning, the REGEs go back in to the IonWorks Barracuda PatchPlate station REGE
plenum sockets to continue running assays, or should be stored dry in the original
packaging.
REGEs stay conditioned as long as they are unused, untouched by bare hands, and properly
equilibrated.

CAUTION! Never touch the top surface of the ground electrodes with your bare
hands, because it results in a build-up of oils on the electrodes that impairs the
functionality.

To condition a REGE set:

1. Fill the included deep buffer boat with the same kind of internal buffer that you will use
for your next assay.

2. Place the four REGEs upside-down in the buffer boat with the electrode heads on the
bottom of the buffer boat.

3. Add enough additional internal buffer fluid, as needed, until the electrodes are
completely submerged.
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Figure 15-1: REGE Set Soaking in Internal Buffer

4. Remove air bubbles trapped against the electrodes by gently tapping the submerged
housings.

5. Soak overnight. Molecular Devices recommends between 13 to 15 hours.

6. After soaking the electrodes overnight, wearing gloves, remove the REGEs from the
buffer boat, and rinse each briefly over a sink with distilled water.

7. Dry the REGE housing, especially the underside.

CAUTION! If not removed from the underside of the REGE housing, the salt in the
internal buffer accumulates in the REGE plenum socket, which can cause an open
circuit when the salt dries.

Figure 15-2: REGE Housing Underside Drying

8. Install the REGEs in the IonWorks Barracuda instrument plenum to continue running
assays. See Installing Replaceable Ground Electrodes (REGEs) on page 155.
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9. After conditioning, unused REGEs should be stored dry in the original packaging with the
lid closed.

CAUTION! Once your REGEs are dry, if you are going to immediately use them to
run assays, do not rinse the electrode heads with distilled water, because your
assays can experience voltage drift while the chloride concentration in the
electrodes equilibrates to the chloride in the internal buffer
When completely dry, the REGEs rapidly absorb approximately 200 µL of the liquid
that first wets them, and it takes about 90minutes for the REGEs to equilibrate to
a different buffer.

Installing Replaceable Ground Electrodes (REGEs)

Note: This procedure does not apply to instruments equipped with the standard
plenum. See Plenum on page 34.

Only install REGE sets that have been properly conditioned. See Conditioning Replaceable
Ground Electrodes (REGEs) on page 153.

CAUTION! Always wear gloves when working within the IonWorks Barracuda
instrument and handling the REGE parts. Never touch the top surface of the ground
electrodes with your bare hands, because it results in a build-up of oils on the
electrodes that impairs the functionality.

To install the REGEs in the plenum:

1. Verify that the O-ring and spring are correctly positioned, and correct as needed.
The O-ring should be seated in the designated O-ring counter-bore, and the spring
should be over the plug in the center of the socket with the narrow diameter of the
spring at the top.

Figure 15-3: Correctly Positioned O-Ring and Spring in Empty Plenum Socket

Figure 15-4: Incorrectly Positioned O-Ring and Spring in Empty Plenum Socket

2. Verify that the plenum socket is dry. Depending on the amount of liquid in the socket,
use a cotton swab or wipe cloth.
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Figure 15-5: REGE Plenum Drying

3. Wet the REGE housing screw threads with 10 µl to 20 µl distilled (DI) water for lubrication.
The amount of DI water depends on how long your REGE set has been dry.

If you are installing immediately after conditioning, when drying the housing, leave 20 µl
of the DI water rinse on the threads.

If you are installing when the REGE set is completely dry, lubricate the housing threads
with 10 µl of DI water, rotate the housing 180 degrees, and apply 10 µl of DI water to the
threads again.

Figure 15-6: REGE Housing Threads Lubrication with 20 µl Distilled Water

4. Insert the lubricated REGE loosely into an empty plenum electrode socket.

Figure 15-7: REGE Placement in a Plenum Socket
Note: Try not to dislodge the spring and O-ring inside the plenum socket. If the spring
and O-ring inside the socket become dislodged, put them back in place.

5. Using the provided REGE service tool, seat the tool prongs into the holes in the electrode
housing for installation.
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Figure 15-8: REGE Service Tool Prongs Align with Holes in the Electrode Housing

6. Turn counterclockwise a ¼ turn to align themale and female threads and reduce the risk
of cross-threading.

7. Place your index finger on one hand on themagnet on the top of the service tool and
apply downward pressure while using your other hand to turn the service tool clockwise
to keep the service tool pins in the electrode housing service tool holes.

Figure 15-9: Two Hand Usage of the REGE Service Tool

8. Turn until the electrode housing seats in the plenum socket flush with the plenum top.

9. Run a gloved finger along the seam between the REGE and plenum to confirm a flush
installation.
The two surfaces should be smooth and bump-free.

Figure 15-10: Gloved Finger Flush Installation Test
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Figure 15-11: Correct Flush REGE Installation

Figure 15-12: Incorrect Raised REGE Installation

10. Repeat steps 1-7 until all four new ground electrodes have been added to the plenum.

11. After all four REGEs are properly installed in the plenum, you can begin your assays.

CAUTION! Never touch the ground electrode top surface with your bare hands,
because it results in a build-up of oils on the electrodes that impairs the
functionality.

Removing Replaceable Ground Electrodes (REGEs)

Note: This procedure does not apply to instruments equipped with the standard
plenum. See Plenum on page 34.

Remove and condition each REGE set nightly after use. You reuse the REGEs that you
remove, so remove them carefully. Always wear gloves when working on the IonWorks
Barracuda instrument and handling the REGE parts.

CAUTION! Always wear gloves when working within the IonWorks Barracuda
instrument and handling the REGE parts. Never touch the top surface of the ground
electrodes with your bare hands, because it results in a build-up of oils on the
electrodes that impairs the functionality.

To remove the REGEs in the plenum:

1. Using the provided REGE service tool, seat the tool prongs into the holes in the sides of
the electrode housing for removal.

Figure 15-13: REGE Service Tool Prongs Align with Holes in the Electrode Housing
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2. To keep the service tool pins in the electrode housing service tool holes, place your index
finger on one hand on themagnet on the top of the service tool, and apply downward
pressure while using your other hand to turn the service tool counterclockwise until the
REGE housing unscrews and is loose in the plenum socket.

Figure 15-14: Two Hand Usage of the REGE Service Tool

3. Lift the REGE housing out of the plenum socket and carefully set it aside for conditioning

Figure 15-15: REGE Removal from a Plenum Socket

Note: Try not to dislodge the spring and O-ring inside the plenum socket. If the
spring and O-ring inside the socket become dislodged, put them back in place.

4. Dry the plenum socket.

Figure 15-16: REGE Plenum Drying

5. Repeat steps 1-4 until all four REGEs have been removed from the four plenum sockets.

6. Condition all four REGEs to continue using them in the IonWorks Barracuda system. See
Conditioning Replaceable Ground Electrodes (REGEs) on page 153

Note: Proper conditioning takes up to 15 hours.
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7. To continue using the IonWorks Barracuda system while the recently removed REGE set
conditions over night, install the provided second REGE set. See Installing Replaceable
Ground Electrodes (REGEs) on page 155, otherwise, place a written note over the plenum
that reads something like “Electrodes Have Been Removed” as a precautionary reminder
to keep the plenum dry.

Rechloriding the Electrode-Plate
As a guideline, Molecular Devices recommends rechloriding the Electrode-Plate electrode
pins when the Standard Deviation (SD) of the hole test offset consistently exceeds 4mV in
three or four successive experiment runs. A periodic spike over 4 mV does not warrant
rechloriding.
Review themedian voltage offset values for the Hole Test Pre-correction scan. Values falling
outside themedian range of ±20 mV likely indicate the need for rechloriding. Monitor your
results to determine whether your electrode pins need rechloriding.

CAUTION! To avoid damage to the Electrode-Plate:

Do not touch the electrode pins or the pogo pins on the underside of the Electrode-
Plate.

Keep the pogo pins dry.

Never immerse the Electrode-Plate in liquid of any kind. The electrode pins, however,
can be immersed in a bleach solution for rechloriding.

Always lift the Electrode-Plate using the handles on the top.

Always set the Electrode-Plate on a flat surface resting on its four stand-offs or on the
Bleach Boat.

To rechloride the Electrode-Plate electrode pins:

1. Fill the Rechloriding Bleach Boat reservoir with enough reagent-grade 50% Sodium
Hypochlorite (use Sigma Aldrich, PN 425044-1L) and 50%DI (deionized) water solution to
fill the reservoir.

CAUTION! Do not use household bleach to rechloride the Electrode-Plate.
Household bleach can damage the electrodes.

2. Lift the Electrode-Plate using the handles on the top to avoid damage.

3. Set the Electrode-Plate onto the bleach boat with the stand-offs positioned
appropriately so that the Electrode-Plate fits correctly into themolded surface. Make
sure the electrode pins are submerged in the solution.

4. Soak the electrode pins for approximately 15minutes.

CAUTION! Do not over-chloride as damage to the electrodes can occur.
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Figure 15-17: Bleach Boat and Electrode-Plate

Component Description

1 Rechloriding Bleach Boat reservoir

2 Indentations for Electrode-Plate standoffs

3 Electrode-Plate on Bleach Boat

Cleaning the Amplifier Touch Pads
Ideally, the amplifier touch pads on the sides of the plenum should never be touched, nor
should the corresponding pogo pins on the Electrode-Plate and Model Cell. Oils on the touch
pads and pogo pins can degrade the signal quality. If any degradation, such as an open
circuit, is detected, the touch pads and pogo pins can be cleaned very gently with distilled
water, isopropyl alcohol, and a lint-free cloth.

Figure 15-18: The Amplifier

Position Component

1 Plenum ground electrodes

2 Amplifier touch pads

3 Plenum O-ring (rubber gasket). The color of the O-ring might vary.
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To clean the amplifier touch pads:

1. Moisten a lint-free cloth with distilled water, and wipe off any salt deposit buildup
contaminants on the amplifier touch pads.

2. Moisten a lint-free cloth with isopropyl alcohol, and wipe off any oily buildup
contaminants on the amplifier touch pads.

CAUTION! Never pour any liquids directly on to the PCBs. Doing so can damage
the circuitry.

3. Let the cleaned amplifier touch pads dry completely before continuing.

CAUTION! Before retesting Instrument Status, to avoid damage, make sure all of
the printed circuit boards (PCBs) on the touch pads and Electrode-Plate, or Model
Cell are completely dry.

4. Run an assay. If any of the wells in the PatchPlate show errors, try cleaning the touch
pads again.
If the problem persists, the amplifier pogo pins might be dirty. See Cleaning the
Amplifier Pogo Pins on page 162.

For amplifier touch pad cleaning problems, contact Molecular Devices Technical Support.

Cleaning the Amplifier Pogo Pins
The pogo pins can be cleaned very gently with distilled water, isopropyl alcohol, and a lint-
free cloth, if any degradation, such as an open circuit, is detected. See Cleaning the Amplifier
Touch Pads on page 161.

Note: The amplifier touch pads on the sides of the plenum should never be touched,
nor should the corresponding pogo pins on the Electrode-Plate and Model Cell,
because oils on the touch pads and pogo pins can degrade the signal quality.
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Figure 15-19: Back of the Standard Electrode-Plate and Model Cell

Position Component

1 Pogo pins (connect with amplifier touch pads)

To clean the pogo pins:

1. Lift the Electrode-Plate or Model Cell off the process deck and place it on a safe surface
upside-down.

2. Moisten a lint-free cloth with distilled water, and wipe off any salt deposit buildup
contaminants on the amplifier touch pads.

CAUTION! Never pour any liquids directly on to the PCBs. Doing so can damage
the circuitry.

3. Moisten a lint-free cloth with isopropyl alcohol, and wipe off any oily buildup
contaminants on the amplifier touch pads.

CAUTION! Make sure you remove all cloth fiber debris left during your wipe.

4. Let the cleaned Electrode-Plate or Model Cell dry completely before placing it on the
process deck again.

5. Verify cleaning success in the Instrument Status dialog. See Viewing Instrument Status
on page 172.

For pogo pin cleaning problems, contact Molecular Devices Technical Support.

Cleaning the Electrode-Plate and Model Cell
When an Electrode-Plate or Model Cell is on the PatchPlate station, the capacitance sensors
determine its presence by measuring the generated capacitance of themetal tabs on the
underside of an Electrode-Plate and Model Cell being close to the sensing element in the
amplifier touch pad boards. The presence of the Electrode-Plate or Model Cell registers in the
Instrument Status dialog.

Figure 15-20: Underside of the Standard Electrode-Plate and the Model Cell
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Position Component

1 Pogo pins (connect with amplifier touch pads)

2 Capacitive metal tabs (hover above capacitance sensors)

Themetal tabs on the underside of the Electrode-Plate and Model Cell, as well as the
corresponding sensors, can be exposed to liquids and salt solutions contamination during
experiments. Contamination can cause an Electrode-Plate is tilted error message to appear
in the IonWorks Barracuda® System Software.
When the error message appears, you need to verify that the Electrode-Plate or Model Cell is
correctly placed on the PatchPlate Station, and then clean the capacitivemetal tabs on the
Electrode-Plate or Model Cell, depending on which you are using at the time of the error
message appearance. You should also clean the capacitance sensors on the amplifier touch
pad. See Cleaning the Capacitance Sensors on page 179.

CAUTION! Always wear gloves when touching parts of the process deck, including an
Electrode-Plate or Model Cell. Oils on your hands can damage the equipment and the
fluids used for the experiments are hazardous.

To clean the Electrode-Plate or Model Cell:

1. Lift the Electrode-Plate or Model Cell off the process deck and place it on a safe surface
upside-down.

2. Moisten a lint-free cloth with distilled water, and wipe off any salt deposit contaminants
that built-up on the capacitivemetal tabs.

3. Moisten a lint-free cloth with isopropyl alcohol, and wipe off any oily contaminants that
built-up on the capacitivemetal tabs.

CAUTION! Never pour any liquids directly on to the PCBs. Doing so can damage
the circuitry.

4. Let the cleaned Electrode-Plate or Model Cell dry completely before replacing it on the
process deck.
Before retesting Instrument Status, to avoid damage, make sure all of the printed circuit
boards (PCBs) on the touch pads and Electrode-Plate, or Model Cell are completely dry.

5. Verify cleaning success in the Instrument Status dialog. See Viewing Instrument Status
on page 172.
Errors reported in the Instrument Status dialog require cleaning the capacitance sensors.
See Cleaning the Capacitance Sensors on page 179.

For Electrode-Plate or Model Cell cleaning problems, contact Molecular Devices Technical
Support.
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Flushing the Tip Washer Lines
The Flush Tip Washer Lines utility is an instrument maintenance process that runs bleach
through the lines to clean out growths and debris that can develop in the tubes, which cause
blockages.

Note: Molecular Devices recommends running this process once every threemonths.

To run Flush Tip Washer Lines:

1. Replace the contents of your Wash Source bottle, A or B, with 500mL of 2% bleach, and
empty both of theWaste bottles. See The Fluid Handling Components on page 40 and
Filling Source Bottles with Wash Solutions on page 104.

2. In the shortcut bar, click , and then click Flush Tip Washer Lines. The Flush Tip
Washer Lines dialog appears.

3. In theWash Source field, select A or B according to the bottle you filled with bleach
solution in step 1.

4. Click Start to begin.
A one-time instructional message dialog appears explaining Steps 5 through 8.

5. Click Continue.
The process ends when the bleach solution runs out.

6. Rinse the used wash source bottle, A or B, with Deionized (DI) water.

7. Replace the contents of the used wash source bottle, A or B, with 500mL of DI water.

8. Click Start to flush residual bleach solution out and to prime the lines.

Note: Note: Failure to flush and prime the lines with DI water (Steps 5 through 8)
can cause your experiments to fail.

9. Before you start your experiment, run Start of Day Flush and Rinse. See Performing the
Start of Day Flush and Rinse on page 105.
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Washing the Plenum

Note: This procedure is specifically for use with instruments equipped with the
standard plenum containing built-in ground electrodes.

TheWash Plenum utility automatically runs up to five soak cycles. Each soak cycle involves
filling the plenum with internal buffer fluid, soaking the plenum as specified, draining the
internal buffer fluid at the end of the soak duration, and repeating the soak cycle as
specified.

CAUTION! Do not useWash Plenum if your instrument is equipped with the
replaceable ground electrodes (REGEs) plenum, especially if the REGEs have been
removed from the plenum for conditioning.

Wash Plenum can be run between experiments or overnight.

Note: If running overnight, Molecular Devices recommends first cleaning up the
instrument as you would at the end of the day. See Completing Instrument Cleanup
on page 149.

To run Wash Plenum:

1. Make sure there is 50mL of internal buffer fluid in the internal buffer bottle per soak
cycle, and refill the internal buffer bottle, as needed. See The Fluid Handling Components
on page 40 and Filling Buffer, Alcohol, and Cell Perforation Agent Bottles on page 103.

2. In the shortcut bar, click , and then clickWash Plenum. TheWash Plenum Settings
dialog appears.

3. In the Soak Duration field, type the soak time in minutes (maximum 1440minutes/24
hours).

4. In theNumber of cycles field, type the number of times the soak cycle repeats
(maximum 5 times).

5. Click Start to begin.
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Soaking the Plenum Manually

Note: This procedure is specifically for use with instruments equipped with the
standard plenum containing built-in ground electrodes.

The plenum can be soaked manually for an extended period of time using the Start Soak
Plenum utility. Soaking the plenum uses internal buffer fluid.
Soaking the plenum manually for an extended period of time can be done between
experiments.

CAUTION! Do not use Start Soak Plenum if your instrument is equipped with the
replaceable ground electrodes (REGEs) plenum, especially if the REGEs have been
removed from the plenum for conditioning.

To soak the plenum manually for an extended period of time:

1. Make sure there is approximately 50mL of internal buffer fluid in the internal buffer
bottle, and refill the internal buffer bottle, as needed. See The Fluid Handling
Components on page 40 and Filling Buffer, Alcohol, and Cell Perforation Agent Bottles on
page 103.

2. In the shortcut bar, click , and then click Start Soak Plenum.

3. To finish soaking the plenum, click , and then click End Soak Plenum to drain the
internal buffer fluid.

Soaking the plenum overnight should be done after the instrument cleanup. See Completing
Instrument Cleanup on page 149.
To soak the plenum overnight:

1. Run the End of Day Flush and Rinse cleanup process. See Performing the End of Day
Flush and Rinse on page 149.

2. Refill the internal buffer bottle, as needed. See The Fluid Handling Components on page
40 and Filling Buffer, Alcohol, and Cell Perforation Agent Bottles on page 103.

3. In the shortcut bar, click , and then click Start Soak Plenum.

4. To finish soaking the plenum, click , and then click End Soak Plenum to drain the
internal buffer fluid.
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Chapter 16: Troubleshooting

The Automated Patch Clamp System is designed to operate using sensors to monitor the
status of the instrument at all times. If the system displays an error, and you are not sure
how to respond, please contact Molecular Devices so that we can assist you.

Technical Assistance
There are several ways to contact Molecular Devices:

World WideWeb: http://www.moleculardevices.com

Phone: +1 (800) 635-5577

Fax: +1 (408) 747-3603

User Assistance: See theMolecular Devices Knowledge Base at
http://www.moleculardevices.com/Support.html

Initializing the Instrument
During the initialization process, the software ensures that the instrument is ready for the
next experiment by recalibrating all of its subsystems. During initialization, the software
confirms that instrument components are properly positioned, used fluids are pumped out,
new fluids are available, and sensor readings are all within acceptable levels.
As the IonWorks Barracuda System is running, it operates in any one of several instrument
"states." These states appear in the status bar at the bottom of themain software window.

Ready: All components are initialized and waiting for instructions.

Running: The instrument is performing a normal operation.

Initializing: The instrument is performing automated calibrations and fluid-handling
tasks to prepare for use.

Paused: The user has asked the system to wait until it is signaled to continue.

Idle: The instrument has received no commands for several minutes and is in power-
saving mode.

Fault: The instrument cannot continue with normal operations and must be re-
initialized.

Occasionally, an error might occur which interrupts normal operations such as an obstacle
on the process deck or an empty external buffer boat. These errors might cause a Fault state
and must be followed by initializing the instrument.

16
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To initialize:

1. In the softwaremenu, click Instrument > Utilities > Initialize. The instrument cancels
any operation in progress, drains any fluids if applicable, and re-calibrates all
components except the Cellpettor.

2. After initializing, the door unlocks so that you can clear any unusable cell suspension,
compound plates, the PatchPlate, or other used labware from the process deck.

3. Replace the necessary buffer solution and compound plates, and insert a new
PatchPlate. Close the door when this step is complete.

4. After the door locks, the instrument returns to the Ready state and you can begin a new
experiment.

Using the Model Cell to Diagnose Signal Issues
TheModel Cell mimics a whole cell patch clamp assembly using resistors, and can be used in
place of the Electrode-Plate for any protocol. By removing the variability of a fluid and cell
environment, theModel Cell can also serve as a diagnostic tool for testing the integrity of the
Patch Engine components including electrodes, pogo pins, and amplifiers.

Figure 16-1: Front and Back of the Model Cell
TheModel Cell is divided into two sides:

The left bank of resistors (A1:H24) mimics a population patch clamp (PPC) PatchPlate at
200 kΩ. Fifty nano-amps (50 nA) of current is expected for every 10 mV applied in the
protocol. Keep in mind that the currents for this bank easily reach the instrument limit
(110 nA) for protocols run in single-hole (SH)mode.

The right bank of resistors (I1:P24) mimics a single-hole (SH) PatchPlate at 10MΩ. One
nano-amp (1 nA) of current is expected for every 10 mV applied in the protocol.

When you review the data from aModel Cell assay, keep in mind that the two types of
resistors produce different results, some of which might not apply to your intended test.
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To use theModel Cell to diagnose signal issues:

1. In the Protocol area of the Data Acquisition and Reviewworkspace, select theModel Cell
protocols you want to use.

2. Place theModel Cell unit on the wash station in place of the Electrode-Plate.

3. If you want to adjust the voltage parameters, start the experiment in Assay
Development Mode.

4. To switch between SH and PPC testing, change the Setup Protocol > PatchPlate Type
selection , then run the assay again. Expect current saturation in all wells served by the
PPC resistor bank when running a SH protocol and applying voltage less than –25 mV or
greater than +25 mV.

Errors
You can encounter various instrument component sensors that cause Patch Engine errors.
The following are solutions to themost common errors.

Error Verification Solution

The Electrode-Plate is
Tilted

Testing Patch Engine Sensor Status
on page 173

Cleaning the Capacitance Sensors
on page 179 then do verification
again

The PatchPlate is Tilted Testing Patch Engine Sensor Status
on page 173

Cleaning the Amplifier Optical
Sensors on page 181 then do
verification again

Same Wells Fail Every Time Run an assay, as needed Cleaning the Amplifier Touch
Pads on page 161 then do
verification again

Amphotericin Tubing Leaks Finding an Amphotericin Pump
Tube Leak on page 182

Replacing the Amphotericin
Pump Insert Tube on page 183
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Viewing Instrument Status
The Instrument Status dialog allows you to view the current status of the various instrument
component sensors.
To view the Instrument Status dialog, click Instrument > View Instrument Status.

Figure 16-2: Instrument Menu
A list of each of the instrument components with the status of themost recent instrument
sensor test appears in the Instrument Status dialog.

Figure 16-3: Instrument Status Dialog
Status results indicate whether you need to take any corrective action. The status results
vary according to the instrument component and the associated sensor purpose, such as
Tips On Pipettor | Not Present or Electrode-Plate Location | Wash Station.

Note: If the component status Process Deck Inclination | Fail appears, and your
assay performance is negatively impacted, contact Molecular Devices for technical
support.
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To refresh the information after doing something that changes a component status, such as
placing the Electrode-Plate on the PatchPlate station, click Update to view the new status
results.
To verify that the Patch Engine sensors are functioning properly, there are five Patch Engine
sensor tests that you run while the Instrument Status dialog is open in the software.
Molecular Devices recommends running all of these tests every time you clean parts of the
Patch Engine. See Testing Patch Engine Sensor Status on page 173.

Testing Patch Engine Sensor Status
There are five Instrument Status tests you run to verify that the Patch Engine sensors are
functioning properly. These tests involve the PatchPlate station, a PatchPlate, a Model Cell,
and an Electrode-Plate on the process deck, and the Instrument Status dialog open in the
software. The status results indicate whether you need to take any corrective action.
Complete all five tests when verifying Patch Engine sensor status.

If all of the tests indicate correct sensor statuses, the sensors are all functioning properly.

If any of these status verification tests indicate corrective action, after completing the
specified corrective action, run all four verification tests again to confirm the success of
the corrective action.

The following is the order that verification testing should be done:

1. Test with nothing on the PatchPlate station. See Patch Engine Sensor Test 1 on page 174.

2. Test with only the PatchPlate in the PatchPlate station. See Patch Engine Sensor Test 2
on page 175.

3. Test with the PatchPlate in the PatchPlate station and with theModel Cell over the
PatchPlate on the PatchPlate station. See Patch Engine Sensor Test 3 on page 176.

4. Test with the PatchPlate in the PatchPlate station and with the Electrode-Plate over the
PatchPlate on the PatchPlate station. See Patch Engine Sensor Test 4 on page 177.

5. Repeat Patch Engine Sensor Test 1 on page 174 to verify that the capacitance sensors are
still responding correctly after completing Patch Engine Sensor Test 1 through Patch
Engine Sensor Test 4 activities.
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Patch Engine Sensor Test 1

Do Patch Engine Sensor Test 1 with nothing on the process deck.
To do Patch Engine Sensor Test 1:

1. Check the sensor status in Instrument > View Instrument Status without a PatchPlate,
and without an Electrode-Plate or Model Cell on the process deck.

Figure 16-4: Empty PatchPlate Station

2. Click Update.

3. Check the sensor status in Instrument > View Instrument Status for PatchPlate and for
the Electrode-Plate. See Viewing Instrument Status.
The Electrode-Plate Location status should showNot Present, and the PatchPlate
status should showNot Present. See Viewing Instrument Status on page 172.

4. If the Instrument Status dialog shows Electrode-Plate Location|Tilted or PatchPlate,
clean the capacitance sensors. See Cleaning the Capacitance Sensors on page 179.

5. If the Instrument Status dialog shows Electrode-Plate Location|Wash Station, contact
Molecular Devices Technical Support.

6. If the Instrument Status dialog shows PatchPlate|Present or Tilted, clean the optical
sensors. See Cleaning the Amplifier Optical Sensors on page 181.

7. Continue to the next Patch Engine sensor test. See Patch Engine Sensor Test 2 on page
175.

Note: If you have already cleaned the capacitance sensor, and cleaned the optical
sensors, and this test continues to fail, contact Molecular Devices Technical Support.
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Patch Engine Sensor Test 2

Do Patch Engine Sensor Test 2 with a PatchPlate on the PatchPlate station and nothing else
on the process deck.
To do Patch Engine Sensor Test 2:

1. Place a PatchPlate on the PatchPlate station.

Figure 16-5: PatchPlate on the PatchPlate Station Only

2. Click Update.

3. Check the sensor status in Instrument > View Instrument Status for PatchPlate and for
the Electrode-Plate. See Viewing Instrument Status on page 172.
The Electrode-Plate Location status should showNot Present, and the PatchPlate
status should show Present.

4. If the Instrument Status dialog shows PatchPlate| Tilted, check that the PatchPlate is
properly seated in the PatchPlate station, and click Instrument Status >Update.

5. If the Instrument Status dialog shows PatchPlate| Not Present, clean the optical
sensors. Cleaning the Amplifier Optical Sensors on page 181.

6. Continue to the next Patch Engine sensor test. See Patch Engine Sensor Test 3 on page
176.

Note: If you have already cleaned the optical sensors, and this test continues to fail,
contact Molecular Devices Technical Support.
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Patch Engine Sensor Test 3

Do Patch Engine Sensor Test 3 with a PatchPlate in the PatchPlate station and with the
Model Cell also on the PatchPlate station.
To do Patch Engine Sensor Test 3:

1. Place a PatchPlate on the PatchPlate station, and a Model Cell over the PatchPlate on
the PatchPlate station.

Figure 16-6: Model Cell Clamped Over a PatchPlate on the PatchPlate Station

2. Click Update.

3. Check the sensor status in Instrument > View Instrument Status for the Electrode-Plate
and PatchPlate. See Viewing Instrument Status on page 172.
The Electrode-Plate Location status should show PatchPlate, and the PatchPlate status
should show Present.

4. If the Instrument Status dialog shows either Electrode-Plate Location| Tilted or
PatchPlate| Tilted, check that the PatchPlate and Model Cell are properly seated in the
PatchPlate station, and click Instrument Status >Update.

5. If the Instrument Status dialog shows any other status for the Electrode-Plate Location
and PatchPlate, clean the capacitance sensors. See Cleaning the Capacitance Sensors on
page 179.

6. Continue to the next Patch Engine sensor test. See Patch Engine Sensor Test 4 on page
177.

Note: If you have already cleaned the capacitance sensors, and this test continues to
fail, contact Molecular Devices Technical Support.
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Patch Engine Sensor Test 4

Conduct Patch Engine Sensor Test 4 with a PatchPlate in the PatchPlate station and with the
Electrode-Plate also on the PatchPlate station.
To conduct Patch Engine Sensor Test 4:

1. Place a PatchPlate on the PatchPlate station, and an Electrode-Plate over the PatchPlate
on the PatchPlate station.

Figure 16-7: Standard Electrode-Plate Clamped Over a PatchPlate on the PatchPlate
Station

2. Click Update.

3. Check the sensor status in Instrument > View Instrument Status for the Electrode-Plate
and PatchPlate. See Viewing Instrument Status on page 172.
The Electrode-Plate Location status should show PatchPlate, and the PatchPlate status
should show Present.

4. If the Instrument Status dialog shows either Electrode-Plate Location| Tilted or
PatchPlate| Tilted, check that the PatchPlate and Electrode-Plate are properly seated in
the PatchPlate station, and click Instrument Status >Update.

5. If the Instrument Status dialog shows any other status for the Electrode-Plate Location
and PatchPlate, clean the capacitance sensors. See Cleaning the Capacitance Sensors on
page 179.

6. Continue to the next Patch Engine sensor test. See Patch Engine Sensor Test 5 on page
178.

Note: If you have already cleaned the capacitance sensors, and this test continues to
fail, contact Molecular Devices Technical Support.
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Patch Engine Sensor Test 5

Do Patch Engine Sensor Test 5 with nothing on the process deck.
To do Patch Engine Sensor Test 5:

1. Repeat Patch Engine Sensor Test 1 on page 174 to verify that the capacitance sensors are
still responding correctly after completing Patch Engine Sensor Test 1 through Patch
Engine Sensor Test 4 activities.

2. When all of the Instrument Status dialog results are correct, then all of the Patch Engine
sensors are functioning properly. Continue running your experiments.

Note: If Patch Engine Sensor Test 1 on page 174 continues to fail after you have
cleaned the capacitance sensor, cleaned the optical sensors, cleaned the pogo pins,
and cleaned the Electrode-Plate and Model Cell, contact Molecular Devices Technical
Support.

Testing the Wash Station Sensor
TheWash station sensor test checks that theWash station sensor is functioning properly.
This test requires that the Electrode-Plate be on theWash station on the process deck, and
the Instrument Status dialog is open in the software.
To test theWash station sensor:

1. Place an Electrode-Plate on theWash station.

Figure 16-8: PatchPlate on the PatchPlate Station and Electrode-Plate on the Wash
Station

2. Click Instrument Status >Update.
The Electrode-Plate Location status should showWash Station.

3. If the Instrument Status dialog shows any other status, contact Molecular Devices
Technical Support.
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Cleaning the Capacitance Sensors
The capacitance sensors determine if an Electrode-Plate or Model Cell is on the PatchPlate
station. The sensors work by measuring the generated capacitance when a metal tab on the
underside of an Electrode-Plate or Model Cell is close to the sensing element in the amplifier
touch pad boards. The sensors and themetal tabs on the underside of the Electrode-Plate or
Model Cell are exposed to liquids and salt solutions contamination.

Figure 16-9: Underside of the Standard Electrode-Plate and the Model Cell

Position Component

1 Pogo pins (connect with amplifier touch pads)

2 Capacitive metal tabs (hover above capacitance sensors)

Figure 16-10: The PatchPlate Station Amplifier

Position Component

1 Standard built-in plenum ground electrodes.

2 Amplifier pogo pin touch pads.

3 Capacitance sensors embedded in the touch pad printed circuit board (PCB)
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A contaminated capacitance sensor generally gives erroneously high readings. This
capacitance is proportional to the distance between the sensor and the above hovering
metal tab. A threshold value, calculated during calibration, determines whether an
Electrode-Plate or Model Cell is on the PatchPlate station. A contaminated capacitance
sensor can also cause The Electrode-Plate is tilted error message to appear in the IonWorks
Barracuda® System Software.
When the error messages appear, you may need to clean the capacitance sensors and the
capacitivemetal tabs on the Electrode-Plate or Model Cell, depending on which you are
using at the time of the error message appearance. See Cleaning the Electrode-Plate and
Model Cell on page 163.

CAUTION! Always wear gloves when touching parts of the process deck, including an
Electrode-Plate or Model Cell. Oils on your hands can damage the equipment and the
fluids used for the experiments are hazardous.

To clean the capacitance sensors:

1. Moisten a lint-free cloth with distilled water, and wipe off any salt deposit contaminants
that built-up on the capacitance sensors.

2. Moisten a lint-free cloth with isopropyl alcohol, and wipe off any oily contaminants that
built-up on the capacitance sensors.

CAUTION! Do not pour any liquids directly on to the PCBs. Doing so can damage
the circuitry.

3. Let the cleaned amplifier capacitance sensors dry completely before continuing.

CAUTION! Before retesting Instrument Status, to avoid damage, make sure all of
the printed circuit boards (PCBs) on the touch pads and Electrode-Plate, or Model
Cell are completely dry.

4. Verify that the capacitance sensors are clean using the Patch Engine sensor tests. See
Testing Patch Engine Sensor Status on page 173.

For capacitance sensor cleaning problems, contact Molecular Devices Technical Support.
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Cleaning the Amplifier Optical Sensors
There are two sets of PatchPlate station optical sensors, upper optical sensors and lower
optical sensors. Dirty or contaminated upper optical sensors can cause The PatchPlate is
tilted error message to appear in the IonWorks Barracuda® System Software. Dirty or
contaminated lower optical sensors will not cause an error message to appear.

Figure 16-11: The PatchPlate Optical Sensors

Figure 16-12: The Right Side PatchPlate Optical Sensors

Position Component

1 Upper optical sensors

2 Lower optical sensors

To clean the optical sensors:

1. Moisten a lint-free cloth or cotton swab with distilled water, and wipe off any salt deposit
contaminants that built-up on the lower optical sensors walls.

CAUTION! Do not press on any sensor. Avoid dislodging the sensors, or causing
sensors to become uncalibrated. If a cotton swab is used, make sure no swab
cotton is left behind in the sensor holes after wiping. If you dislodge or uncalibrate
a sensor, contact Molecular Devices Technical Support.

2. Moisten a lint-free cloth or cotton swab with isopropyl alcohol, and wipe off any oily
contaminants that built-up on the lower optical sensors walls.

CAUTION! Before retesting Instrument Status, to avoid damage, make sure all of
the printed circuit boards (PCBs) on the touch pads and Electrode-Plate, or Model
Cell are completely dry.
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3. Verify that the optical sensors are clean using the Patch Engine sensor tests. See Testing
Patch Engine Sensor Status on page 173.

For optical sensors cleaning problems, contact Molecular Devices Technical Support.

Calibrating CellPettor
Calibrate CellPettor is a Utilities button used for manually running the CellPettor calibration
process.
There are situations when the CellPettor calibration sensor prompts you to calibrate the
CellPettor. One such situation is clicking Load CellPettor Pipette > Terminate.

CAUTION! CAUTION: Always make sure the CellPettor pipette is dry before running
calibration. Awet pipette tip can cause inaccurate calibration, or a calibration failure.

To calibrate the CellPettor:

1. In the shortcut bar, click , and then click Calibrate CellPettor.

2. Verify that the CellPettor pipette is dry.

3. Click Continue.

The calibration process is finished when the CellPettor stops in the ready position.

Finding an Amphotericin Pump Tube Leak
You might need to check to see whether the amphotericin peristaltic pump tubing is leaking
due to a possible split tube.
To find an amphotericin pump tube leak:

1. Open instrument lower compartment door.

Figure 16-13: The Open Instrument Lower Compartment Door

2. Locate the amphotericin peristaltic pump in themiddle of the fluidics-handling system.

Figure 16-14: The Amphotericin Peristaltic Pump Within the Lower Compartment
Fluid-Handling System



Chapter 16: Troubleshooting

5011662 M 183

3. Open the amphotericin peristaltic pump tubing cover.

Figure 16-15: The Open Peristaltic Pump Tubing Cover

4. Inspect the tubing.
If the tubing is worn out and leaking, it looks like Figure 16-16 and needs replacing.

Figure 16-16: Visible Drips of Amphotericin on the Peristaltic Pump Tubing

5. Only replace the amphotericin pump insert tube if you see a visible leak from the tubing.
If needed, see Replacing the Amphotericin Pump Insert Tube on page 183.

Replacing the Amphotericin Pump Insert Tube

There is an amphotericin peristaltic pump within the fluid-handling system under the
PatchPlate station that is accessible from the lower cabinet of the IonWorks Barracuda
System.

Figure 16-17: The Amphotericin Peristaltic Pump Within the Lower Compartment Fluid-
Handling System
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To replace the amphotericin pump insert tube:

1. Open instrument lower compartment door.

Figure 16-18: The Open Instrument Lower Compartment Door

2. Locate the amphotericin peristaltic pump in themiddle of the fluidics-handling system.

Figure 16-19: The Amphotericin Peristaltic Pump Within the Lower Compartment
Fluid-Handling System

3. Open the amphotericin peristaltic pump tubing cover.

Figure 16-20: The Open Peristaltic Pump Tubing Cover

4. Remove the Tube Insert from the pump by gently stripping it off the rotor wheel.

Figure 16-21: Stripping Tube Insert off of the Rotor Wheel

Figure 16-22: Tube Insert Removed from the Rotor Wheel
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5. Disengage the tube insert from the 1/8” outside diameter (OD) silicon tubing.

Figure 16-23: Separated Bad Tube Insert from 1/8" OD Tubing

Figure 16-24: Removed Bad Tube Insert

CAUTION! CAUTION: Do not re-install used tubing after it has been removed,
even if it is not leaking. Re-installed used tubing fails prematurely because of
irregular wearing. Only install new tubing for optimum usage.

6. Attach the replacement tube insert to the 1/8” OD tubing, and verify that there are no
gaps.

Figure 16-25: Attaching Replacement Insert Tube

Figure 16-26: Completed Replacement Insert Tube Attachment

7. Loop the replacement tube insert over the rotor wheel and press it into position near the
center of the wheel.

Figure 16-27: Looping Replacement Insert Tube Over The Rotor Wheel
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Figure 16-28: Pressing Replacement Insert Tube into Position

8. Pull each end of the replacement tube insert in a downward direction to position the
clear 7/32” OD tubing sections below the black pump box.

Figure 16-29: Pull Down Replacement Insert Tube to Position Clear 7/32” OD Tubing

Figure 16-30: Verify Correct Clear 7/32” OD Tubing Position

9. Close the amphotericin peristaltic pump tubing cover.

Figure 16-31: Closing Amphotericin Peristaltic Pump Door

Figure 16-32: Amphotericin Peristaltic Pump Tube Replacement Complete

10. Close the instrument lower compartment door.

For amphotericin peristaltic pump tube replacement problems, contact Molecular Devices
Technical Support.
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Appendix A: List of Approved Fluids

Use only approved fluids with the Automated Patch Clamp System.

CAUTION! Do not use bleach on the surfaces of the instrument, or in the fluid bottles
or lines unless specified by a Molecular Devices procedure. Bleach can cause
discoloration of bottles, lines, and surfaces, and can cause damage that leads to
equipment failure.

Source bottles must be filled prior to the start of an experiment run. This section describes
fluids used to fill source bottles, as well as fluids allowed for manual cleaning and rinsing.
Generally, the software controls fluid delivery to themicroplates and the wash station from
the source bottles below the process deck. You can pour fluids directly into the wash station.
Make sure you are using only Molecular Devices approved fluids.
Internal Buffer Bottle

Buffer solutions

Deionized (DI) water

Amphotericin B (Sigma-Aldrich, Cat. A4888)

Alcohol for cleanup or rinse (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to
50%maximum concentration

Cell Perforation Agent Bottle

Buffer solutions

Deionized (DI) water

Amphotericin B (Sigma-Aldrich, Cat. A4888)

Dimethyl Sulfoxide (DMSO) solution at 10%maximum concentration

Alcohol for cleanup or rinse (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to
50%maximum concentration

External Buffer Bottle

Buffer solutions

Deionized (DI) water

Alcohol for cleanup or rinse (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to
50%maximum concentration

CellPettor

Buffer solutions

Deionized (DI) water

A
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Alcohol for cleanup or rinse (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to
50%maximum concentration

Source A and Source B Bottles

Buffer solutions

Deionized (DI) water

Dimethyl sulfoxide (DMSO) solution at 50%maximum concentration

Alcohol (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to 50%maximum
concentration

WARNING! Do not enable ultrasonic cleaning while using any flammable
liquid such as alcohol (EtOH) in the Source A or Source B bottles. Sonication
can cause flammable liquids to evaporate into the enclosure, posing a
potential risk of fire or explosion.

Alcohol Bottle

Alcohol (Reagent-grade Alcohol Sigma-Aldrich, Cat. R8382) diluted to 50%maximum
concentration

Electrode-Plate Rechloriding Boat

Sodium hypochlorite (Reagent-grade Sodium Hypochlorite Sigma-Aldrich, Cat. 425044)
diluted to 50%maximum concentration with 50%DI (deionized) water solution

Suggested Manufacturers and Part Numbers
Follow instructions for maximum concentrations of fluids used in the instrument to avoid
damaging the instrument components. The following suggested manufacturers supply
suitable fluids:

Source Fluid Suggested Manufacturer Catalog Number

Amphotericin B Sigma-Aldrich A4888

Reagent-grade Alcohol (EtOH) diluted to
50% maximum concentration

Sigma-Aldrich R8382

Reagent-grade Sodium Hypochlorite
(NaCIO) diluted to 50% maximum
concentration

Sigma-Aldrich 425044
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Appendix B: Accessories

This appendix describes replacement parts and consumable labware used with the IonWorks
Barracuda® Automated Patch Clamp System.

Description Suggested Manufacturer Part Number

Standard Electrode-Plate Kit
(includes Rechloriding Bleach Boat)

Molecular Devices 5012131

RA1 Electrode-Plate Kit
(includes Rechloriding Bleach Boat)

Molecular Devices 5027525

Replaceable Ground Electrode
(REGE) Kit

Molecular Devices 5031299

Model Cell Kit
(includes Rechloriding Bleach Boat)

Molecular Devices 5012133

PatchPlate: Single-Hole (SH) Molecular Devices 5008679

PatchPlate: Population Patch Clamp
(PPC)

Molecular Devices 5008680

External Buffer Boat Molecular Devices 5029645

Standard Cell Boat Molecular Devices 5005252

CellPettor Pipette, 5 mL
(case of 200)

Molecular Devices 5012605

Conical Tube, 15 mL BD Falcon 352096

384-Pipettor Tip Disposable Tip Rack
(50 racks per case)

Molecular Devices

Note: Do not use FLIPR system
black tips [PN 9000-0764] or
clear tips [PN 9000-0763] The
IonWorks Barracuda system tips
have a reinforced rack.

Black tips 5011976
(recommended)

Clear tips 5011975

CellPettor Pipette
The CellPettor is a robotic pipetting unit positioned above the process deck and near the cell
boat station. The robot requires a standard 5 mL aspirating pipette with the cotton plug
removed from the end, and a standard cell boat [Molecular Devices PN 500525] to operate.
The dimensions for the aspirating pipette should be:

8 mm diameter x 350 mm length

B
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Conical Cell Tube
Standard 15 mL conical tubes can be used with the CellPettor subsystem to hold cell
suspension.

The dimensions for the cell tube should be:

17 mm diameter x 120 mm height

Compound Plates
To ensure proper functioning of the pipettors, the compound platemust match one of the
types listed in the IonWorks Barracuda® System Software:

BD-Falcon 384W Flat Clear PPN

Corning 384W Round Clear PPN

Greiner 384W Flat Clear PPN

Greiner 384W Conical Clear PPN

Greiner 384W Small Volume Clear PS

Greiner 384W Flat Clear PS

Greiner 384W Conical Deep Well Clear PPN

Nunc 384W Round Natural PPN

Matrix 384W Reservoir V-Bottom PPN

Axygen Low Profile Reagent Reservoir PPN

Seahorse Low Profile Reservoir PPN
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Appendix C: Instrument Specifications

This section lists electrical requirements, instrument dimensions, and space requirements for
the Automated Patch Clamp System.

Operational and Environmental Specifications

Specification Measurement

Weight 499 kg [1100 lbs]

Dimensions
(H x W x D)

1829 mm high x 1219 mm wide x 838 mm deep
[72 inches high x 48 inches wide x 33 inches deep]
(with access door closed)

Mains Power Input 100 to 240 VAC, 50/60 Hz, 12 A maximum

Mains Voltage Fluctuations Not to exceed ±10% of nominal supply voltage

Equipment Class 1

Pollution Degree 2

Installation Category 2

Operating Environment Indoor Use Only

Altitude Not to exceed 2000 m

Operating Temperature: 17°C to 27°C

Humidity 35% to 50% non-condensing relative humidity

Ingress Protection: IP20

Note: Note: System power supply is configured when manufactured.

Space Requirements
The recommended installation foot print of the IonWorks Barracuda System is 2.334 m wide
and 1.1 m deep [92 inches wide and 43 inches deep].

Aminimum clearance of 0.3m [12 inches] is required to the left side and at the back of
the instrument for ventilation and service access.

Aminimum clearance of 0.9m [36 inches] is required to the right to allow room for the
monitor and keyboard bracket.

C
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Appendix D: Safety Guide

This section provides information on the use of user-attention words in this User Guide,
precautions to follow before operating the Automated Patch Clamp System, the location of
safety labels on the instrument, and a key to understanding safety label icons.

WARNING! If the IonWorks Barracuda System is used in a manner not specified
by Molecular Devices, the protection provided by the equipment might be
impaired.

WARNING! The IonWorks Barracuda System is an Equipment Class 1 product
that relies on protective earth grounding for safe operation. Any interruption of
the protective earth ground conductor, inside or outside the instrument, or
disconnection of the protective earth ground terminal might result in personal
injury.

WARNING! Do not position the equipment so that it is difficult to operate the
mains power shut-off switch.

Before Operating the Instrument
Ensure that everyone involved with the operation of the instrument has:

Received instruction in general safety practices for laboratories.

Received instruction in specific safety practices for the instrument.

Read and understood all related Material Safety Data Sheets (MSDS).

Document User-Attention Words
Three user-attention words appear in the text of all Molecular Devices user documentation.
Each word implies a particular level of observation or action as described:

Note: Calls attention to useful information.

CAUTION! Cautions the user that a potentially hazardous situation could occur,
causing injury to the user or damage to the instrument, if this information is ignored.

WARNING! Warns the user that serious physical injury to the user or other
persons could result if these precautions are not followed.

D
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Instrument Safety Labels
Safety labels are located on the instrument. Each Safety label consists of a:

SignalWord panel, which implies a particular level of observation or action (for example,
CAUTION orWARNING). If a safety label encompasses multiple hazards, the SignalWord
corresponding to the greatest hazard is used.

Message panel, which explains the hazard and any user action required.

Safety Alert symbol, which indicates the type of potential personal safety hazard.

Symbol Indication

Indicates potential pinch hazard location

Indicates that product documentation needs to be consulted

Indicates power on

Indicates power off

Indicates the location of the Protective Earth Ground Terminal

Indicates that you must not discard this electrical/electronic product or its
components in domestic household waste
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Appendix E: Electromagnetic Compatibility

REGULATORY INFORMATION FOR CANADA (ICES/NMB-001:2006)
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM EQUIPMENT CLASSIFICATION (Group 1, Class A)
This equipment is designated as scientific equipment for laboratory use that intentionally
generate and/or use conductively coupled radio-frequency energy for internal functioning,
and are suitable for use in all establishments, other than domestic and those directly
connected to a low voltage power supply network which supply buildings used for domestic
purposes.

INFORMATION TO THE USER (FCC NOTICE)
This equipment has been tested and found to comply with the limits for non-consumer ISM
equipment, pursuant to part 18 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a non-residential installation. This
equipment generates, uses, and can radiate radio frequency energy and if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this
equipment. Operation with non-approved equipment or unshielded cables is likely to result
in interference to radio and TV reception. The user is cautioned that changes and
modifications made to the equipment without the approval of themanufacturer could void
the user's authority to operate this equipment.

E
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Glossary

Amphotericin B
The recommended cell perforation agent for use in the IonWorks Barracuda™ System (Sigma-Aldrich
P/N A4888). General guidelines are 100 µg of cell perforation agent for each milliliter of internal buffer
solution.

assay development mode
An experiment mode in which the selected Channel protocol runs and pauses. At the pause, you can
adjust parameters. The assay continues to pause after each iteration of the Channel Protocol until
you have optimized for your desired result. You can then save the optimized channel protocol as a
new protocol. The new optimized channel protocol can then be used in screening mode.

Bleach Boat
A container used to rechloride the electrodes of the Electrode-Plate. Themolded surface of the
Bleach Boat has a reservoir in the center for bleach and indentations that fit the four Electrode-Plate
standoffs. This makes it possible to submerge the electrodes in a bleach solution without
submerging the other components of the Electrode-Plate.

buffer boat
An SBS compatible plate with a single trough to hold the external buffer solution. The trough allows
dispensing and aspiration of fluids from the 384-well pipettor.

cell boat
An SBS compatible plate with a single trough that contains the cells being used in the assay. The
trough allows dispensing and aspiration of fluids from the 384-well pipettor.

CellPettor
An automated cell-handling unit. The CellPettor delivers cell suspension to the cell boat during
experiments.

compound plate
An SBS compatible 384-well plate that contains the screening compound. One or more compound
plates can be used in the assay.

data aquisition engine
The system that collects signals during assays. Each of the 384 electrodes on the Electrode-Plate
connects to a single amplifier and digitizer to simultaneously convert the 384-channel recordings
into usable data. This connection is made through the 384 pogo pins on the Electrode-Plate.
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electrode array
384 individual electrodes that match the layout of a 384-well plate. The electrode array enables
simultaneous compound addition and channel recording.

experiment mode
Themode in which an experiment is run. There are two experiment modes: screening mode and
assay development mode.

external buffer
A solution that is dispensed into the PatchPlate by the pipettor. Used as a buffer.

hole test
A test during which the Electrode-Plate records the electrical current after the wells are filled with
external buffer, but before cells have been added. Awell is defined as "Blocked" when themeasured
resistance is less than 1MΩ or greater than 10MΩ. Wells that do not pass the hole test are excluded
when data is analyzed.

internal buffer
A solution that is pumped into the plenum. Used as a buffer.

manual mode
An operating mode in which plates are loaded and unloaded manually.

Model Cell
A component that simulates a whole cell circuit using resistors built into the frame housing. The
Model Cell can be used in place of the Electrode-Plate to test basic output and resistance of a
voltage application before tesing the protocol on actual cells. Also used to validate new protocols.

offline mode
An operating mode in which the software is not connected to the instrument. Also referred to as
simulation mode.

overflow reservoir
A low-capacity overflow sink, or open reservoir, located behind the plenum/cell waste carboy. This
reservoir captures any spill or overflow that might occur on the process deck.

PatchPlate
A consumable planar patch microplate that consists of a 384-well, SBS-standard footprint, with a
polyimidemembrane at the bottom. Also called pPlate. Versions of the PatchPlate include:
MegaSeal single hole (SH), and population patch clamp (PPC).
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pipette tray
A tray with 384 disposable pipette tips. For each session, the pipettor picks up the pipette tips from
this tray and discards them into the tray after the session is complete.

plenum
The fixed foundation of the PatchPlate station. The plenum enables delivery, from below, of internal
buffer solution and cell perforation agent solution. The top surface of the plenum contains four
ground electrodes.

rechloride
A process that replaces the silver chloride coating on the electrodes of the Electrode-Plate to prevent
electrode drift during experiments. The electrodes must be rechlorided when the Standard
Deviation of the hole test offset consistently exceeds a threshold amount.

screening mode
An experiment mode in which you select saved or read-only protocols to run without interruption.
One Setup Protocol, one Channel Protocol, and one Cleanup Protocol run through to completion
except for pre-programmed pauses in operations to add or change compound plates or to add cells.

seal test
A test that determines whether the cell is properly positioned over the hole and sealed in the well. If
the cell is not properly sealed as designated by the native filter settings, then the values for that well
are excluded from analysis.

system computer
A computer that resides inside the instrument cabinet on the lower-left side. The system computer
runs the pre-installed IonWorks Barracuda™ Software that controls automated instrument
operations.

wash solutions
Solutions required to wash the electrodes and pipette tips. They typically consist of DI water, saline
solution, 10%DMSO, or 50% Ethanol. The wash solutions are kept in bulk bottles.

waste carboys
Two six-liter waste bottles, housed in the fluidics drawer in the front of the system cabinet (Waste A
and Waste B). A third six-liter bottle for (Plenum/Cell Waste) holds cell-contaminated fluids collected
from the cell handling system and the plenum including cell suspension, internal buffer, and
perforation agent.
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Index

A
acquired trace data 118

add internal buffer 64

add perforation agent 64

air bubbles 65

Extra Aspirate option 74

Alcohol (EtOH)

source bottle 41

alpha7 nACh protocol 46

Amphotericin B 103

amplifiers 30

apply metrics to sweep 87

approved fluids 187

aspirate options 71

aspirate speed 74

assay development mode 9, 47, 117

Assay Development Mode

developing new protocols 47, 91

avoiding air bubbles

Extra Aspirate option 74

B
barcode number

include in experiment name 44

barcode reader 43

USB port 43

baseline scans 68

bleach, do not use 187

blocked wells 58

threshold 65

buffer boat 189

minimum and maximum volume 103

buffer solutions 187

C
cable connection port 26

calibrating the CellPettor 152, 182

carboys

location on rack 40

cardiac sodium channel 46

cell access 64

cell boat 189

dimensions 60

part number 30, 60

Cell perforation agent

source bottle 41

cell tube 190

dimensions 40, 190

CellPettor 110

disabling 60, 113

pipette 150, 189

pipette dimensions 39, 189

CellPettor washing 97

change plate before aspirate 72

changing the default folders 140

channel protocol 45, 67

check resistance 64

clamping the Electrode-Plate 152

cleanup protocol 46, 97

column sorted by column 89

column sorted by row 89

combined reduction 87

comma-delimited 90

command voltage family 81, 83



IonWorks Barracuda® Automated Patch Clamp System

202 5011662 M

command voltage repetitions 82

compound

mixing before dispensing 74

compound-triggered acquisition 70

compound concentration ratio 74

compound fluid levels 74

compound incubation time 71

compound plate position 72

compound plates 72

dimensions 28

list of approved 190

positioning 110

setting up replicates 109

compound reduction 87

compound volume 28

computer 43

conditioning replaceable ground electrodes,
conditioning REGEs 153

conditioning train 77

conditioning train intervals 77

conditioning train repetitions 79

contact Molecular Devices 169

continuous display 84

copying protocol summaries 51, 137

coulomb meter 54

D
daily maintenance 105

daily operation 7

data acquisition 80

default folder 118

default protocols folder 140

delay between scans 68, 71

desktop icons 21

discard tips 98

disconnecting fluid lines 104

dispense speed 60

do not use CellPettor 60

draining the plenum 152

E
electrical requirements 191

Electrode-Plate 36, 189

handling 37

voltages 37

Electrode-Plate washing 97, 152

emergency-stop button 12, 25, 122

emptying liquid waste 102

End of Day Flush and Rinse 149, 152

error

invalid values 57

Ethernet connection port 26

excluding wells from exported data 124

experiment name 118

include barcode 44

exported data

directory or path 90

file formats 90

footer data 90

viewing 90

exported trace data 146

exporting data 88

external buffer

filling 103

recommended 104

volume used per experiment 109

external buffer boat

minimum volume 108
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External buffer solution

source bottle 41

extra compound 74

extracted value 123

F
fault state 122, 152, 169

file extensions 141-142

file format 90

file types 141-142

filling bottles

approved fluids 187

run rates 103

filling buffer boat

minimum and maximum 103

filter

hole test 65

seal test 65

fluid lines 103

fluids

locations on instrument 40

footer data 90

G
ground electrodes 30

ground electrodes,replaceable ground
electrodes,REGE 34

H
hERG protocol 46

holding level 68

hole test 58

hole test filter 65

I
idle state 169

install replaceable ground electrodes, install
REGEs 155

installing the software 22

instrument cleanup 149

instrument clearances 191

instrument components 23

Instrument Dimensions 191

instrument state 169

instrument status 169

internal buffer

adding 64

Internal buffer solution

source bottle 41

interval

step by duration 83

step by voltage 83

interval duration 82

interval sequence 81

invalid value 57

invalid values 57

iPad monitoring 14

K
key

non-numeric results 90, 144

L
leak correction 75

ligand-gated assay

record data simultaneously 69

liquid junction potential 69

M
maintaining fluid levels 74

manually adding cells 60

manually excluding wells 124
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metric

deleting 91

saving 87

scan type 86

metric-then-scan 90

metric order dataset 90

metric preview graph 85

metrics

importing 88

micropipettors 38

microplate footprint 27

minimum working volume 101

mix cycle 60

model cell 189

model cell resistors 49, 170

Molecular Devices website 169

monitor software 14, 18

multiple compound additions

positioning plates 110

N
naming experiments 118

native filters 65

no fluid additions 69

non-numeric results key 90, 144

null operation 64

O
osmolality 109

P
part numbers 189

patch engine 30

PatchPlate 189

hole size 32

packaging 33

positioning 107

SH or PPC 32

pause to add compound 72

perforation agent

adding 64

pipettor tips

loading 106

unloading 10, 149

pipettors 38

plate format 89

plate type list for compounds 109

plenum 34

gasket 34, 161

O-ring 34, 161

vacuum pressure 34, 161

vacuum seal 34, 161

plenum pressure 34

pogo-pins 36

Post-Trigger Duration 70

post conditioning train level 78

potassium channel 46

power

120-volt AC 26

24-volt DC 26

power-switch 11-12

power supply panel 26

pre-signal duration 75

Pre-Trigger Duration 70

pre-wet tips 74

preconditioning the cell 76

preferences 18

preparing for an experiment 101
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presignal voltage 75

priming the CellPettor 152

printing protocol summaries 51, 137

process deck 27

protocol file location 119

Protocol settings file 141-142

protocols

selecting 119

R
read-only protocol 50

ready state 169

recommended external buffer 104

recommended wash solution 104

record data simultaneously 70

remotemonitoring 14

remove replaceable ground electrodes,
remove REGEs 158

removing the CellPettor pipette 150

renaming a read-only protocol 50

replaceable ground electrodes, REGE 189

replaceable ground electrodes, REGEs 35

replacement parts 189

rescaling graphs 125

rescaling trace graphs

auto-scale each well 126

auto-scale entire plate 126

manual scale 126

results format 88

Resuspend cells 60

S
safety labels 193-194

Sample Period 71, 81

sample protocols 45

saving a read-only protocol 50

scan-then-metric 90

screening mode 9, 47, 117

Seal Test 62

seal test duration 63

seal test filter 65

setting the sample period 81

Setup Protocol 45, 55

shortcut bar 14

software

installing 22

space requirements 191

start-to-start interval 79, 82, 84

Start of Day Flush and Rinse 105, 152

starting the soak plenum 152

sticky compounds 74

stopping an experiment 122

Sweep Display 84

system requirements 22

T
tab-delimited 90

technical support 169

terminating an experiment 122

time range 86

tip height 74-75

tip rack

number of uses allowed 28

tip rack station 27

tips

discarding 98

tips washing 97

TIPS/COMPOUND 3 28

trace data 142
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turning off the CellPettor 60

U
ultrasonic cleaning 98

unclamping the Electrode-Plate 152

user defined metrics 88

V
vertical marker 85

viewing exported data 90, 148

voltage during addition 70

voltage ramps 79, 81

voltage steps 79-80, 83

W
wash cycle dwell time 99

wash solution

recommended 104

source bottles 41

wash source A or B 98

washing the plenum 152

waste bottles 102

waste carboys 7

web monitoring 14

well configurations 33

working offline 21

reconnecting 21

workspaces 13

Z
zoomed well view 125
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